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Health & Safety Notice 

FOR YOUR OWN SAFETY AND FOR THE PROTECTION OF OTHERS  

PLEASE OBSERVE THE FOLLOWING HEALTH AND SAFETY INSTRUCTIONS 

 

• READ THESE INSTRUCTIONS AND KEEP THEM HANDY 

• HEED ALL SAFETY WARNINGS 

• DO NOT USE NEAR WATER 

• CLEAN ONLY WITH A DRY CLOTH 

• DO NOT INSTALL NEAR HEAT SOURCES 

• DO NOT BLOCK VENTILATION OPENINGS 

• PROTECT THE POWER CORD 

• USE ONLY ACCESSORIES SPECIFIED BY THE MANUFACTURER 

• UNPLUG WHEN UNUSED FOR LONG PERIODS OF TIME 

• MODULES OR CARDS SHOULD NOT BE INSERTED OR REMOVED WITH THE  

POWER ON 

• REFER ALL SERVICING TO QUALIFIED PERSONNEL ONLY 

• NO USER SERVICEABLE PARTS INSIDE 

• PLEASE OBSERVE THE RECOMMENDED 'POWER UP' & 'POWER DOWN'  

PROCEDURES 

FAILURE TO OBSERVE THESE PROCEDURES AND RECOMMENDATIONS  

WILL INVALIDATE THE MANUFACTURER’S WARRANTY 
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Avertissements de Santé & Sécurité 

POUR VOTRE SECURITE ET CELLE DES AUTRES MERCI DE RESPECTER LES 

INSTRUCTIONS DE SANTE ET SECURITE SUIVANTES 

 

 

 

• LISEZ CES INSTRUCTIONS ET GARDEZ-LES À PORTÉE DE MAIN 

• TENEZ COMPTE DE TOUS LES AVERTISSEMENTS DE SÉCURITÉ 

• NE PAS UTILISER PRÈS D’UNE SOURCE D’EAU 

• NETTOYER UNIQUEMENT AVEC UN CHIFFON SEC 

• NE PAS INSTALLER PRÈS D’UNE SOURCE DE CHALEUR 

• NE PAS BLOQUER LES BOUCHES D’AÉRATION 

• PROTÉGER LE CORDON D’ALIMENTATION 

• N’UTILISER QUE LES ACCESSOIRES SPÉCIFIÉS PAR LE FABRICANT 

• DÉBRANCHER PENDANT DE LONGUES PÉRIODES D’INACTIVITÉ 

• NE PAS INSÉRER OU RETIRER D’EVENTUELLES CARTES OPTIONNELLES ALORS QUE 

L’APPAREIL EST SOUS TENSION 

• CONFIER TOUTES LES OPÉRATIONS DE MAINTENANCE À DU PERSONNEL QUALIFIÉ 

UNIQUEMENT 

• AUCUNE PIÈCE INTERNE N’EST RÉPARABLE PAR L'UTILISATEUR 

• MERCI DE RESPECTER LES PROCEDURES DE MISES HORS ET SOUS TENSION. 

 

LE NON-RESPECT DE CES PROCÉDURES ET RECOMMANDATIONS INVALIDERA LA 

GARANTIE DU FABRICANT 
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Important Safety Instructions 

 Read these instructions 

 Keep these instructions  

 Heed all warnings  

 Follow all instructions  

 Do not use this apparatus near water  

 Clean only with a dry cloth  

 Do not block any ventilation openings. 

 Install in accordance with the manufacturer's 

instructions. 

 Do not install near any heat sources such as radiators, 

heat registers, stoves or other apparatus (including 

amplifiers) that produce heat. 

 Do not defeat the safety purpose of the polarized or 

grounding-type plug. 

A polarized plug has two blades and a third grounding 

prong. 
The wide blade or the third prong are provided for your 

safety. 

If the provided plug does not fit into your outlet, consult an 

electrician for replacement of the obsolete outlet. 

As this apparatus is constructed to Class I, it shall be 

connected to a MAINS socket outlet with protective 

earthing connection. 

 Protect the power cord from being walked on or 

pinched particularly at plugs, convenience receptacles, and 

the point where they exit the apparatus. 

Where the MAINS plug or an appliance coupler is used as 

the disconnect device, the disconnect device shall remain 

readily operable. 

 Only use attachments / accessories specified by the 

manufacturer. 

 CAUTION Use only with the optional 8424 cart/stand 

specified by AMS Neve, or sold with the apparatus. When a 

cart is used, use caution when moving the cart / apparatus 

combination to avoid injury from tip-over. Use with other 

equipment may result in instability causing injury.  

 Unplug this apparatus during lightning storms or when 

unused for long periods of time.  
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Refer all servicing to qualified service personnel. 

Servicing is required when the apparatus has been 

damaged in any way, such as power-supply cord or plug is 

damaged, liquid has been spilled, or objects have fallen into 

the apparatus, the apparatus has been exposed to rain or 

moisture, does not operate normally or has been dropped. 

WARNING: 

TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, DO NOT EXPOSE THIS 

APPARATUS TO RAIN OR MOISTURE. 

WARNING: 

THIS APPARATUS HAS CLASS I CONSTRUCTION AND SHALL BE CONNECTED TO A 

MAINS SOCKET OUTLET WITH A PROTECTIVE EARYTHING CONNECTION. 

WARNING: 

WHERE THE MAINS PLUG OR AN APPLIANCE COUPLER IS USED AS THE DISCONNECT 

DEVICE, THE DISCONNECT DEVICE SHALL REMAIN READILY OPERABLE. 
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Instructions Importantes de Sécurité 

 Lisez ces instructions 

Gardez ces instructions  

Tenez compte des avertissements  

Suivez toutes les instructions 

N’utilisez pas cet appareil près d’une source d’eau  

 
Nettoyer uniquement avec un ciffon sec 

Ne pas bloquer les bouches d’aération 

 Installez conformément aux instructions du fabricant. 

 Ne pas installer à proximité d’une source de chaleur telle 

qu’un radiateur, une bouche d’air chaud, des plaques de 

cuisson (ou cuisinière), ou n’importe quel autre appareil 

producteur de chaleur (y compris un amplificateur)  

 Ne pas contourner l'objectif de sécurité de la fiche 

polarisée ou de mise à la terre. 

Une fiche polarisée a deux lames et une troisième broche de 

mise à la terre. 

La lame large ou la troisième broche sont prévues pour votre 

sécurité. 

Si la fiche fournie n’entre pas dans votre bloc d'alimentation 

externe, consultez un électricien pour remplacer la prise 

obsolète. 

Cet appareil étant de classe I, il doit être connecté à la prise 

de courant externe secteur avec une connexion de mise à la 

terre de protection. 

Protégez le cordon d’alimentation afin d’éviter les 

piétinements et pincements, et plus particulièrement à 

proximité des prises de courant ou tout autre élément de 

branchement, ainsi qu’au point de sortie de l’appareil  

 Lorsque la fiche secteur ou un coupleur d'appareil est utilisé 

comme dispositif de débranchement, celui-ci doit rester 

facilement accessible 

 

 N’utiliser que les accessoires spécifiés par le fabricant 

 

 ATTENTION Utilisez uniquement le support optionnel du 

8424 spécifié par AMS Neve, ou celui vendu avec l’appareil. 

Quand un support est utilisé, déplacez l’ensemble 

appareil/support avec précaution, afin d’éviter les blessures 

occasionnées par un éventuel basculement. Utiliser un autre 

support que celui prévu à l’origine peut causer une dangereuse 

instabilité. 
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  Débranchez cet appareil pendant les orages ou de 

longues périodes d’inactivité.  

 Confiez toutes les opérations de maintenance à un 

technicien qualifié. Un entretien est nécessaire lorsque 

l'appareil a été endommagé de quelque manière que ce soit, 

comme par exemple si le cordon d'alimentation ou la fiche 

sont endommagés, du liquide a été renversé ou des objets 

sont tombés dans l'appareil, si l'appareil a été exposé à la 

pluie ou à l'humidité, s’il ne fonctionne pas correctement ou a 

subi une chute de hauteur. 

ATTENTION: 

AFIN DE RÉDUIRE LES RISQUES D'INCENDIE OU DE CHOC ÉLECTRIQUE, N'EXPOSEZ PAS CET 

APPAREIL À LA PLUIE OU À L'HUMIDITÉ  

 

ATTENTION: 

CET APPAREIL CORRESPOND A UNE CONSTRUCTION DE CLASSE I ET DOIT ÊTRE RACCORDÉ 

À UNE PRISE SECTEUR DOTÉE D'UNE PROTECTION PAR MISE À LA TERRE. 

 

ATTENTION: 

LORSQU'UNE PRISE SECTEUR OU UN PROLONGATEUR EST UTILISÉ COMME DISPOSITIF DE 

DÉBRANCHEMENT, CELUI-CI DOIT RESTER FACILEMENT ACCESSIBLE. 
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Warning Symbols  

 

  No user serviceable parts inside 

Environmental considerations
 

 Temperature   Operating 5°C to 30°C 

(41°F to 86°F) 

   Non-operating -20°C to 50°C 

(-2°F to 122°F) 

   Max Gradient 15°C/Hour 

(59°F/Hour) 

 Relative Humidity  Operating 20% to 80% 

   Non-operating 5% to 90% 

   Max wet bulb 28°C non-condensing 

(or 57°F non-condensing) 

Altitude  Operating     0 to 2,000m                                 

.Non-operating     0 to 12,000m 

      Cooling  

Care must be taken not to place any accessories that could 

block the ventilation above or below the heat sinks at the 

rear of the console. 

All PSU's will operate over an ambient temperature range 

of -10°C to +30°C (14°F to 86°F). 

The console must not be powered up or operated with the 

dust cover still in place. 

Please refer to the manual before operating 

Danger of electric shock 
Disconnect from the MAINS before opening cover 



                                                                                                                                           9 
 

 

Symboles d'avertissement 

 

 Aucune pièce interne n’est réparable par l'utilisateur 

Considérations Environnementales
 

 Température   En fonctionnement 5°C à 30°C 

(41°F à 86°F) 

   Hors fonctionnement -20°C à 50°C 

(-2°F à 122°F) 

   Augmentation 

 Graduelle max 15°C/Heure 

(59°F/Heure) 

 Humidité relative  En fonctionnement 20% à 80% 

 Hors fonctionnement 5% à 90% 

   Humidité 

 d’ampoule max 28°C sans condensation 

(ou 57°F sans condensation) 

Altitude  En fonctionnement     0 à 2,000m                               

F Hors fonctionnement 0 à 12,000m 

Refroidissement 

Des précautions doivent être prises pour ne pas placer 

d'accessoires qui pourraient bloquer la ventilation au-

dessus ou en dessous du bloc d'alimentation externe de 

l'unité ou du système de ventilation de cette dernière.  

Tous les blocs d'alimentation fonctionnent sur une plage de 

température ambiante de -10°C à +30°C (14°F à 86°F). 

La console ne doit pas être mise sous tension ou être 

utilisée tant que la protection plastique n’a pas été retirée. 

Veuillez vous référer au manuel avant utilisation 

Risque de choc électrique 
Débranchez du réseau avant d'ouvrir le couvercle 
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Important Safety Instructions  

  READ THESE INSTRUCTIONS AND KEEP THEM HANDY   

    HEED ALL SAFETY WARNINGS  

    THE CONSOLE MUST BE EARTHED WHEN OPERATED  

    DO NOT USE NEAR WATER  

    CLEAN ONLY WITH A DRY CLOTH  

    DO NOT INSTALL NEAR HEAT SOURCES  

    DO NOT BLOCK VENTILATION OPENINGS 

  THE AMBIENT ROOM TEMPERATURE SHOULD BE NO    

GREATER THAN 30°C / 86°F  

   PROTECT THE POWER CORDS 

   USE ONLY ACCESSORIES SPECIFIED BY THE 

MANUFACTURER 

   UNPLUG WHEN UNUSED FOR LONG PERIODS OF TIME OR 

DURING LIGHTNING STORMS 

   MODULES AND CARDS SHOULD NOT BE INSERTED OR 

REMOVED WITH THE POWER ON  

   REFER ALL SERVICING TO QUALIFIED PERSONNEL ONLY 

   THE CONSOLE MUST ONLY BE MOVED BY AT LEAST TWO 

PEOPLE 

   NO USER SERVICEABLE PARTS INSIDE 

 

 

 

 

 

 



                                                                                                                                           11 
 

 

     IMPORTANT POWER NOTICE 

THE 8424 CONSOLE IS SUPPLIED WITH A 3-CORE AC POWER CABLE 

APPLICABLE TO THE REGION IT IS TO BE OPERATED IN, AND MUST 

BE CONNECTED TO A 3-PIN EARTHED SUPPLY. 

IF A REPLACEMENT CABLE IS USED, THEN THE EARTH FROM THE 

MAINS    SOCKET OR TECHNICAL EARTH TO THE CONSOLE MUST BE 

MAINTAINED. 

IF ONLY A 2-PIN (NO EARTH) SUPPLY IS AVAILABLE, THEN THE  

8424 CONSOLE MUST BE INSTALLED BY A QUALIFIED ELECTRICIAN 

TO ENSURE THAT THE CONSOLE METALWORK IS PERMANENTLY 

EARTHED. 

THE CONSOLE SHOULD ONLY BE POWERED FROM A SINGLE-PHASE 

SUPPLY WITH THE NEUTRAL CONDUCTOR AT EARTH POTENTIAL. 

     FAILURE TO FOLLOW THESE PROCEDURES AND RECOMMENDATIONS       
COULD INVALIDATE THE MANUFACTURER'S WARRANTY 
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    AVERTISSEMENT IMPORTANT SUR L’ALIMENTATION    

LA CONSOLE 8424 EST FOURNIE AVEC UN CÂBLE D'ALIMENTATION À 

3 BROCHES APPLICABLE À LA RÉGION DANS LAQUELLE ELLE DOIT 

ÊTRE UTILISÉE ET DOIT ÊTRE CONNECTÉE À UNE ALIMENTATION À LA 

TERRE À 3 BROCHES. 

SI UN CÂBLE DE REMPLACEMENT EST UTILISÉ, ALORS LA TERRE DE 

LA PRISE PRINCIPALE OU LA TERRE TECHNIQUE RELIÉE À LA 

CONSOLE DOIT ÊTRE MAINTENUE. 

SI SEULE UNE ALIMENTATION À 2 BROCHES (PAS DE TERRE) EST 

DISPONIBLE, L'ALIMENTATION EXTERNE DOIT ÊTRE INSTALLÉE 

PAR UN ÉLECTRICIEN QUALIFIÉ POUR S'ASSURER QUE LA PARTIE 

MÉTALLIQUE DES UNITÉS EST MISE À LA TERRE EN PERMANENCE. 

LA CONSOLE NE DOIT ÊTRE ALIMENTÉE QUE PAR UNE 

ALIMENTATION MONOPHASE AVEC LE CONDUCTEUR NEUTRE AU 

POTENTIEL DE TERRE. 

LE NON-RESPECT DE CES PROCÉDURES ET RECOMMANDATIONS INVALIDERA LA 

GARANTIE DU FABRICANT 
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Introduction                                                                                                       1 

For almost 60 years, the designers and engineers at Neve have worked uncompromisingly to produce the world's 

premier audio recording and mixing equipment.  As a result, our products have long exceeded the most stringent 

requirements for sound quality and musicality – from countless classic albums to the vast   majority of each year's 

blockbuster films. This technical expertise and industry-led design is taken forward into every new Neve console, 

combining with modern enhancements to meet the needs of today’s studios.  Introducing the 8424 Console….. 

Legendary 80-series Neve sound, 4 groups, 24 channel faders  

The 8424 console is designed to fit the needs of the modern hybrid studio where the speed of in-the-box workflow is 

enhanced with the ultimate sound quality of analogue outboard gear. The 8424 provides a centralised platform with 

unparalleled connectivity, facilitating an ergonomic link between the linear analogue processing world of outboard 

gear, analogue synths, and instruments, to the digital world of DAW workflow, software plugins and session recall.   

The 8424’s Marinair® transformer-coupled Stereo Mix bus delivers legendary Neve® sound, derived from the iconic 

80-series consoles. 24 channels, 4 groups and 48-mix capability give this small footprint console huge routing and 

summing potential. Dual on board 1073® preamps, Instrument DI’s and headphone amplifiers provide a 

comprehensive recording platform, with a fast, efficient workflow that keeps the creativity flowing in the studio. 

The 8424 has an on-board Recall system with computer remote app control which further integrates the console into 

the modern hybrid studio workflow. This unique feature enables this pure analogue console to save, load, and recall 

all settings, faders and pot positions from the DAW computer on a session-by-session basis. With this unrestricted 

workflow, engineers can take advantage of all analogue features without the added worry of losing console settings 

and wasting valuable studio time.  

The 8424 can be configured with manual or automatic, motorized faders, enabling complete control over multiple 

DAWs simultaneously. This modern system is designed to function with the latest and greatest DAWs, providing 

transport control and accurate fader positioning with flexible VPOT control over DAW sends, pans and plugin 

parameters. In addition to the powerful DAW control, the Active Fader mode allows for automation of real analogue 

fader levels for true post-processing automation, all controlled from a single DAW session.  

As with all Neve products, the 8424 offers sound and build quality beyond reproach. All the audio connections on 

the 8424 are balanced and +4dBu with the exception of the iMon input and engineers’ headphones. 

The 8424 is designed to be straightforward and accessible to all. this versatile and powerful desk provides a central, 

creative hub where analogue outboard gear, synthesisers and a host of instruments combine with the digital world of 

DAW workflow, software plugins, and session recall. Every piece of studio magic can now be connected through the 

ultimate creative platform – The 8424 console. 

                              AMS Neve Ltd 

  AMS Technology Park 

Billington Road 

Burnley 

Lancashire 

England 

BB11 5UB 

Phone: +44 (0) 1282 417 011 

Fax: +44 (0) 1282 417 282 

Email: info@ams-neve.com 
Web: www.ams-neve.com 

© ® 2005 - 2022 AMS Neve Ltd own the copyright of all information and figures contained in this manual which are not to be copied or reproduced by any 
means or disclosed in part or whole to any third party without written permission. As part of our policy of continual product improvement, we reserve the right 
to alter specifications without notice but with due regard to all current legislation.  
Disclaimer: The information in this manual has been carefully checked and is believed to be accurate at the time of publication. However, no responsibility is 
taken by AMS Neve Ltd for inaccuracies, errors or omissions nor any liability assumed for any loss or damage resulting either directly or indirectly from use of the 
information contained within. 
Trademarks: Neve®, 1073® and Marinair® are registered trademarks. AMS Neve Limited pursues a policy of continual improvement therefore all specifications 
are subject to change without notice. All trademarks are property of their respective owners E & O E ©2020 AMS Neve Ltd. 
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 Console Overview                                                                                            9 

 
8424 Console Features 

• 24 Mono channels with source selections and 100mm faders 

• 24 Channel Direct Outputs 

• 4 Groups with 100mm faders 

• 3 Mono Auxiliary sends 

• 1 Stereo Cue send 

• 2 Stereo Reverb Returns 

• Marinair® Transformer coupled Stereo Mix bus  

• 2 1073® Microphone Pre-amplifiers  

• 2 Hi-z DI inputs 

• 2 500 Series Slots 

• 4 Mono, 1 Stereo 2-band shelving EQ 

• 1 Stereo Width control 

• 2 stereo External inputs 

• 3 Loudspeaker Outputs 

• 2 engineers headphone outputs 

• 30 Balanced Inserts on Channels, Groups & Stereo mix 

• 48 Input Capability 

• 8 Stage LED Channel Input Meters  

• Assignable Backlit VU meters 

• Global channel A/B input switch 

• Oscillator 

• Smart routing 

• Comprehensive connectivity on console rear 

• Internal Power Supply 

Channels 1 – 16 

 

Master Section Channels 17-24 
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 Channel Strip Overview                                                                                  9 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A/B Input select 

 
Input Trim 

Channel Meter

 

Stereo Cue Send 

 

Aux Sends 1-3 

Channel Insert 

 

Channel Pan 

Channel Routing 

Channel solo/cut 

Stereo Cue Pan 

 

GRP Pan 

 Insert to Input C 

Direct Out Pre  

Channel Fader 
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Stereo VU Meters

 

Aux/Cue masters 

Group/Stereo 

Mix Routing 

Routing 

Group Faders Stereo Mix fader 

Group Pan 

 Master Section Overview                                                                               1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

1073 Preamps  

Services Screen 

 

Headphone 2 

Group/Mix EQ  

Control Room 

Monitor Section 

Talkback 

Controls 

Stereo Width  

Instrument DI’s  

500 Series Slots 

 

Reverb Returns 

 

Global Controls 

Group Solo/Cut Stereo Mix Cut 
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 About this manual                                                                                           1 
This manual consists of: 

• A section-by-section operational overview of all parts of the console surface 

• Technical & physical specifications including power consumption, 

dimensions, weight and other relevant information 

• Schematics and reference drawings of D-Type pinouts  

There is a Heading Index at the start. 

There is also a table explaining the Acronyms and Abbreviations of the most 

commonly used buttons and functions on page 58 of this document. 

Many rotary controls on the 8424 have a push-activation ON/OFF function. 

Simply push the pot to switch the control ON or OFF. 

Where relevant, the ON/OFF state of the control is displayed by an adjacent LED.  
 
 

 

Conventions used                                                                                                                                                             1 

 

All button names / rotary controls are shown in BOLD CAPITALS. 

 

Additional Global controls and notes for set parameters are shown 

in bold grey italics. 

Click Blue Hyperlinks to jump to sections of the User Manual   

 

Important warnings are shown in Bold text with - Caution:  

 

An arrow-shaped bullet-point indicates you should do this action. 

 

 

 

 

 

Console surface colour coding                                                                                                                                       1 

 

The knobs and buttons on the Channel Strip and master sections of the 

console are colour-coded for ease of operation. 

 

Type Control Colour 

 

 

 

Rotary 

 

Level Control Dark Grey 

Pan Dark Blue 

Gain/Trim Dark Red 

High Shelf EQ Light Blue 

 Low Shelf EQ Black 

 Monitor level Bright Red 

TIP: 

Quick shortcuts & workflow improvements will appear in 

a black box with white text.  
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 Power Procedure                                                                                             1  

Safety Notice  

Before plugging the 8424 into the mains supply, please make sure of the following safety precautions: 

The amplifier connected to the speakers is turned off and the volume controls are turned fully down (or if 

using active speakers, ensure they are turned down and turned off). 

Ensure the 8424 Control Room Monitor level is fully turned down.  

All faders (including the Main Output faders) are at the bottom of their run at the CUT (∞) position. 

 

Power-up procedure 

Turn on the power to 8424 using the power switch on the rear of the console.  

Switch the amplifier on (or the speakers if you are using active speakers). 

Turn the amp (or speakers) to the desired level. 

On the 8424, ensure that the Control Room level is turned down and un-cut the monitoring (as a safety feature, 

the monitoring system will always be CUT when first switching the system on). 

Move the Channel faders to the desired levels and put the Main mix fader up to 0dB. 

Turn the Control Room Monitoring level up. 

 

In this state, the console is ready to start recording from the A or B inputs with the Direct Outputs feeding the DAW 

(or tape Machine) 

Power Down Procedure                                                                     1 

Ensure your work is saved to the relevant medium. 

Turn the Control Room Monitoring down as far as it will go and press the master CUT button for the speakers. 

Turn the output level on the speaker's amplifier down to CUT, then turn the power off (if using active speakers, 

turn each speaker down before removing the power). 

Safely remove the power to 8424. 

Failure to follow this procedure correctly could 

invalidate the manufacturer warranty 
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 Quick Start                                                                                                        1 

Cabling Requirements                                                                                               1 

• DAW Interface Outputs (Input A) - 25-Pin D-Sub > D-Sub loom x3  

• Line Inputs (Input B) - ¼’’ TRS Jack 1-24 

• Direct outputs - 25-Pin D-Sub > D-Sub Loom x 3 

• Insert send/Return - ¼’’ TRS Jack 1-24 

• Group insert Send/Return – ¼’’ TRS Jack 1-4  

• Mix/Aux/Cue/Group output – XLR x9 

• loudspeaker Outputs – XLR x6 

• Reverb returns/EXT/500 series/1073 inputs – XLR x10 

Boot Mode                                                                                                                   1 

Upon start-up, the 8424 is configured with all channel inputs on Input B. 

This can be changed by switching the inputs individually on each channel, or 

by pressing the global A/B CH IP switch in the master select section of the 

console. Green LED’s indicate Input A state, Yellow indicate Input B.  

To protect the system from feedback, the direct outputs from the channels 

are fed from Input B by default. This can be changed in the services screen 

by selecting MAST> IPA>DIR [Y] 

The console will always boot up in safe mode. This state ensures that no 

damage incurs to loudspeakers or additional studio equipment on start-up. 

In safe mode all feeds to speakers will be CUT (speaker outs will illuminate 

RED to indicate CUT state). The control room monitor level should also be 

turned fully down automatically to further protect studio equipment.  

Connecting the console                                                                                            1 

 Connect DAW interface outputs into the 8424 channel Inputs A via 

the three D-sub connectors 1>8 9>16 17>24. 

 Connect line level instruments or external preamps into the 8424 

channel inputs B where required. 1>24 ¼’’ Jack.  

 Connect channel Direct Outputs 1-24 to DAW interface inputs via 

the D-sub connector 1>8 9>16 17>24. 

 Connect MIX O/P L and MIX O/P R into your DAW interface to 

record your Stereo Mix back into the DAW.  

 Connect group 1-4 outputs GRP1 OUTPUT 1-4 into your DAW 

interface if required.  

 Connect Aux outputs AUX O/P 1-3 to external FX units. 

 Connect external FX returns to Reverb Returns REV1 and REV2 L+R. 

 Connect Headphones to EHP1 and EHP2 

 Connect headphone amplifiers to CUE O/P L+R if required. 

 Connect studio speakers to A LS O/P Left and Right XLR.  

 Connect additional studio Speakers to M1 LS O/P Left and Right XLR. 

 Connect any analogue hardware inserts to each channel or group 

using the ¼’’ jack connectors at the rear of the console. 

 Connect analogue hardware inserts to the master channels using 

the XLR connectors at the rear of the console MIX INS SEND and 

MIX INS RETURN. 

 

 



                                                                                                                                           25 
 

 

Audio Interface 

 Studio Setup                                                                                                     1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Line Input B 
1-16 

1073 & DI 
inputs 

 

Line Input B 
17-24 

Insert  
Sends 

 

Aux  
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Reverb 
Returns 

EHP 2 

DAW Returns 
Input A 

1-24 

Monitor 
Outputs  

Line Level  
Instruments 

Loudspeakers 
A, M1, M2 

Microphones 

DI Instruments 

Artist  
Headphones 

External Preamps 

Outboard Rack Gear  External FX Units  Engineer 
Headphones 

DAW 
Computer 

EHP 1 

Insert  
Returns 

Channel 1-24 Direct 
Outputs 

Group 1-4 Direct 
Outputs 

Stereo Mix Outputs 
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 Channel Strip                                                                                                    1   
Overview                                                                                                                      1                                                                                                                  

One of the core design concepts of the 8424 is that each channel can select 

its input from two alternative line input sources. This enables the 8424 to be 

used for Mixing, Recording and Overdubbing. The A/B CH IP switch on every 

channel will select either channel Input A (DAW Interface Outputs) or 

channel Input B for line level instruments or external preamps. Each channel 

trim pot will function independently for both Input A and Input B. The Input 

trim LEDs will indicate the trim level for each input A or B. When switching 

between inputs, the TRIM level will swap between Input A and Input B 

levels. The I/P LED will indicate the current selected input - Green for Input 

A trim or Yellow for Input B trim. Each trim level is separate, this allows for 

precise and independent trim control of both channel input levels. 

A/B Channel Input                                                                                                     1 

This function selects the input source for each channel and will light Green 
for Input A or Yellow for Input B. 
Input A is fed by a 25-way D-Type connector on the rear of each fader bank 
in sets of 8.  
Input A should be used to connect your DAW interface outputs to the 
console.  

To protect the system from feedback, the direct outputs from the channels 

are fed from Input B by default. This can be changed in the services screen 

by selecting MAST> IPA>DIR [Y] 

Input B is fed by ¼’’ TRS connectors to the rear of each individual channel. 
Input B can be used for any line level input such as external pre-amp 
outputs or line level instruments to be directly tracked through the console.  

The Global A/B CH I/P switch can be found in the centre of the console.  

Direct Pre                                                                                                                     1   

The DIR PRE button will route the channel direct output as pre-fader. This 

can be used to create DAW stem tracks un-affected by the current control 

room fader levels. When DIR PRE is inactive, the direct outputs are post-

fader, any channel fader motions will affect the direct out signal. This can be 

used to record audio adjustments directly onto the DAW stem tracks, 

creating manual level changes on certain mix elements. Pre or Post fader 

Direct Outs are sent post-channel insert, allowing for outboard hardware 

processing to be added into the signal chain and recorded into the DAW. 

The Global DIR PRE switch is activated from the services screen in 

MAST>DIR PRE  

Direct Output Signal Path                                                                                         1 

  

 

 

 

 

 

Direct outputs are post fader in their default state. 

 

DIR PRE selected  DIR PRE not selected 

Channel Input A/B Channel Input A/B 

Input Trim Input Trim 

Insert Insert 

Direct Output Trim CUT  

Direct output D-Sub Fader 

CUT  Direct Output Trim 

Fader Direct Output D-Sub 
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Trim Encoder                                                                                                               1 

Each channel features a digitally controlled stepped Trim Encoder. This 

encoder can be set to control Input A and Input B trim levels, Set the Direct 

Output levels from each channel, and set as a remote rotary controller for 

external equipment.   

The Trim encoder has a red LED display which gives an at-a-glance indication 

of the currently selected trim level position for Input A, Input B, Direct 

Output and FNC Remote 1073OPX gain levels.  

 

The input trim encoder and can be pressed to toggle between three states 

of action-  

• I/P sets the encoder to act as a +/- 20dB trim pot for all incoming 

line levels. I/P Trim functions for both Input A and Input B with each 

independent trim level stored digitally within the console’s internal 

memory. When selecting channel inputs via the A/B CH IP button, 

the I/P LED will toggle between both inputs displaying Green for 

Input A and Yellow for Input B.  

The Global A/B CH I/P switch can be found in the centre of the console.  

 

• DIR sets the level of the direct output as pre/post fade/cut for the 

selected channel; the channel direct out has +10dB gain in hand to 

boost signals into your DAW interface if necessary. 

- Direct Outs are set to 0dB by default, turn the stepped Trim 

Encoder clockwise to increase the Direct Out level. 0dB is at the 

2-o clock position, each following step increases the Direct Out 

level 1dB up to the maximum +10dB at the 4-o clock position. 

- Direct outputs send from Input B by default. Input A can be sent 

to the Direct Output via the services screen in the centre of the 

console by selecting MASTER>IPA>DIR [Y] 

 

• FNC (function) mode allows the Trim encoder to function as a 

remote gain control for connected 1073OPX preamps or for VPOT 

control of DAW parameters. When in FNC mode, the trim encoder is 

no longer controlling internal 8424 signal levels, but purely working 

as a remote control for external hardware/software.  

For Further Information see FNC Gain Control  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

0dB 

+10dB 

-inf 
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Services Screen Trim Display                                                                                   1      

When making adjustments to any of the consoles 24 trim encoders, the 

Services Screen will display the exact Trim Encoder increments as they are 

being adjusted. This ensures total accuracy for all Trim Encoder settings for 

selected Input A/B trim levels, Direct Out levels, and FNC remote 1073OPX 

Gain levels.  

 

The channel number is displayed on the left of the screen in brackets - (16) 

The parameter name is displayed the middle of the screen - TRIM A  

The parameter increments are displayed on the right of the screen - 0.00dB.  

 

• When I/P mode is selected and the Trim Encoder is adjusted, the 

services screen will indicate the trim level for the selected A or B 

channel input. When switching between A/B CH IP the screen will 

change to indicate TRIM A or TRIM B. 

• When DIR mode is selected and the Trim Encoder is adjusted, Direct 

Output levels are displayed on the Services Screen.   

• When FNC mode is selected and the Trim Encoder is adjusted, 

1073OPX gain levels will be displayed, along with OPX channel 

number and selected input type (Line/Mic/DI)  

 

To interrogate the current Trim encoder setting without adjusting the level-  

 Press and hold the ST CUE PAN pot and press the Trim encoder 

together  

 

Following shutdown and restart of the console all channel trim settings are 

reset to the default setting of 0dB. To save and load the trim settings for 

your session, use the services screen in the centre of the console and choose 

the SYSTEM SAVE or LOAD. 

More information on SAVE/LOAD can be found at  Recall Store System                                                                                          

 

Caution: Loading a saved state will overwrite all Trim A/B/Direct out 

levels. 

 

Global Input Trim Reset                                                                                            1 

Channel Input A and B Trim levels can both be globally reset to zero from 

the console services screen. To globally reset Input B trim levels from the 

services screen, select MAST>ZERO IP B  To globally reset DAW returns 

Input A select MAST>ZERO IP A  

Channel Meter                                                                                                            1 

Each Channel on the 8424 has its own 8 stage PPM input level meter which 

displays input signal levels from -30dB through to +24dB. Levels below 0dB 

illuminate green and levels above 0dB will illuminate yellow. The Red LED 

will indicate clipping at +24dB. 

+ 
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Stereo Cue                                                                                                                   1 

Each Channel on the 8424 has a stereo cue send which can send audio from 

channel input A or B (depending which input is selected on the top of the 

channel strip) to performers in the live/control room.  The CUE send can also 

be used as a stereo FX send. The ST CUE also has a third input option - Input 

C. This input allows for an additional 24 inputs into the 8424 from the DAW. 

The CUE rotary send runs from -inf to 0dB and has push activation. Pressing 

the Rotary level control will activate the cue send. The ON light will 

illuminate green to indicate that the CUE is active. Each cue has its own L/R 

Pan control which can be activated by pressing the ST CUE PAN control.  

The CUE can be set Pre or Post fader via simple button combinations listed 

below. The CUE sends signal from the channels selected input A or B but can 

also be fed from Input A independently when using ILM/Parallel Processing 

mode or can be fed from an additional Input C when using 48 Mix Mode. 

Further information at In-Line Mode / Parallel Processing /  48 Mix Mode                                                                                                      
To toggle between PRE/POST fader-  

 Press and hold the CUE PAN and then press the CUE level controller. 

The PRE LED will indicate the sends pre-fader state. 

 To select Input C as the Stereo cue source- 

 Press and hold the CUE PAN and then press the CUE controller 

twice. I/P C I/P A LED will illuminate Yellow to indicate that Input C 

is the CUE source.  

To toggle between I/P C or I/P A Cue send source- 

 When the I/P C, I/P A LED is illuminated, press and hold A/B CH IP at 

the top of the channel strip then press the CUE level control, The I/P 

A I/P C LED will illuminate Green to show that Input A is the signal 

stereo cue source or will illuminate Yellow to indicate that Input C is 

the signal source for the stereo cue send.  

To Globally select Input C for all CUE inputs- 

 Press 48 MIX in the Master section of the console. 

48 mix is explained in greater detail at  48 Mix Mode                                                                                                       

To Globally select Input A for all CUE inputs- 

 Press 48 MIX in the Master section of the console  

 From the services screen press MASTER then select ILM [Y] 

ILM is explained in greater detail at In-Line Mode  

The CUE pre-fade send works differently channel input A/B is selected. This 

is to ensure that when recording, the channel cut does not cut the cue send. 

Similarly, when mixing, the channel cut will cut the cue send.  

Recording - If channel Input B is selected – cue sends are pre-fade pre-cut 

Mixing - If channel Input A is selected – cue sends are pre-fade post-cut 

Overdubbing – The pre fader send can be changed so that Input A and Input 

B sends are both pre-cut, this is ideal when overdubbing.    

Further information at AU/CU PC [Y] 

Global Stereo cue sends pre/post state can controlled by interlocking the 

Aux On/Pre button and ST CUE master knob in the centre of the console.   

Further information at Global Aux Controls 
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AUX Sends 1-3                                                                                                             1 

There are three mono aux sends per channel. Each rotary control sends level 

from -inf to 0dB and has push activation. The ON light will illuminate Green 

once the send is active. Each Aux send 1-3 is set to Post-Fade by default.   

To switch to PRE-Fade- 

 Press and hold the AUX pot for 2 seconds.  

 The PRE light will illuminate Yellow to indicate pre-fader state.  

 To return to Post, press and hold the AUX pot again for 2 seconds.  

AUX 2 and AUX 3 can also be used as a second stereo cue. AUX 2 becomes 

the right signal and AUX 3 becomes the left signal of the second stereo cue 

mix.  

Further information on additional stereo cue mixes can be found at AUX 

2&3 as CUE Mix 2 

The aux send pre-fade option will function differently depending on which 

channel input A/B is selected. This is to ensure that when recording or 

overdubbing, the channel cut does not affect the aux send. Similarly, when 

mixing, the channel cut will also cut the aux send appropriately. 

If channel Input B is selected – AUX sends are pre-fade pre-cut. 

If channel Input A is selected – AUX sends are pre-fade post-cut. 

Global Aux On/Pre fade state can be set by interlocking the Aux On/Pre 

button and Aux master knobs in the centre of the console.                        

Further information at Global Aux Controls 

Insert/Input C                                                                                                              1 

Just below the aux sends on the channel are the Insert IN and Insert to 

Input (I/P C) switches. When illuminated, the insert IN switch will activate 

the channels insert signal path from the Insert send and Insert return ¼’’ TRS 

connector at the rear of the console. When I/P C is selected and illuminated, 

the channel insert will be assigned to the signal path for the third channel 

input (Input C) DAW interface outputs 25-48 and fed to the ST CUE input. 

Further information about inputs 25-48 can be found at 48 Mix Mode                                                                                                     

Global INSERT IN and INSERT I/P C can be activated from the services 

screen in MAST>INS IN and MAST>INS I/P C  

Note: Channel insert sends are always active, if not using the channel 

inserts, they can be used as a second pre-fade direct out from each channel 

Pan                                                                                                                                1 

The 8424 pan-pot runs from 0dBu hard left, - 4.5dBu centre to 0dBu hard 

right positions. The channel Pan-Pot functions for both Input A or Input B 

depending on the selected channel input.  

The Pan-Pot has push-activation and is switched on when the IN light is 

illuminated.  

All channel pans can be activated globally from the services screen in 

MAST>MIX PAN  

GRP PAN                                                                                                                       1 

GRP Pan or ‘channel pan to group’ assigns the channel pan position to the 
group routing. When selected, the position of the Pan control is reflected in 
the channels group assignments. I.E when the channel is routed to groups 1 
and 2, panning hard left will send the channel signal to group 1 only, 
panning hard right will send the signal to group 2 only and centre panning 
will send the signal in equal amounts to both groups 1 & 2.  

Global GRP PAN can be activated from the services screen in MAST>GRP 
PAN  
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Channel Routing                                                                                                         1 

Channels can be routed using the buttons below the pan. Channel signal can 
be sent either to the Stereo Mix via the MIX button or to groups 1-4 via the 
GRP 1-4 buttons. Any combination of channel routing is possible by pressing 
multiple routing buttons. Each routing path is active when the button is lit. 
 Global channel routing is accessed from the services screen in MAST>MIX, 

GRP 1  GRP 2  GRP 3 GRP 4  
In addition to the channel routing, the cue bus can also be routed to groups 

3 & 4, this feature is useful when using the 8424’s In-Line monitoring mode. 

Any DAW output sent to the channel cue I/P A or I/P C can rerouted from 

the master CUE bus to groups 3 and 4 which will now act as the master 

faders for cue channels routed to the groups, taking advantage Group 

processing. The CUE LED indicator displays group to cue routing status.  

To route the Cue bus into groups 3 & 4 

 Press and hold CUE PAN then press GRP 3 or GRP 4 routing buttons 

 The GRP 3 and GRP 4 button will now illuminate RED to indicate Cue 

to Group routing. 

Global Cue to Group 3+4 routing is accessed from the services screen in 
MAST>CUE GRP  

Channel Solo                                                                                                               1 

The channel SOLO button will isolate the selected channel into the stereo 

master bus. The channel solo is destructive by default (SIP) but can be set to 

non-destructive modes - Pre-fader (PFL) or After-fader (AFL). AFL is the 

default setting when activating SOLO SAFE button in the Master Section of 

the console. This can be switched to PFL in the control room monitor section 

of the console by pressing the AFL/PFL level control. 

Further information on solo modes can be found at Solo Modes 

Solo is latching by default but can be switched to Momentary via the 
Services Screen under MAST>SOLO: [LATCH]/[MOM]–  

Channel Isolate                                                                                                           1 

ISO Isolates the channel path from the default SIP (solo-in-place) system and 

activates the channels non-destructive solo AFL/PFL bus. The isolated 

channels are also SOLO SAFE. When any other channel solo is active, a CUT 

will not be applied to any channel/group that has been isolated.   

Any channel that is isolated can now be soloed without activating the CUT 

on all other channels/groups. The channel solo bus is now routed either pre-

fader (PFL) or after-fader (AFL) and routed to the engineer headphones and 

control room monitor path via the PFL/AFL bus. 

To isolate a Channel-  

 Press and hold the CUT button on the selected channel, then press 

the SOLO button on the selected channel at the same time. 

 The ISO light will illuminate to indicate that the channel is now 

protected from destructive solo.  

Channel Cut                                                                                                                 1 

CUT will remove the selected channels audio from the mix bus audio path, 

the channels audio is muted when the CUT light is illuminated. CUT will also 

mute the channels AUX or CUE Post-fade bus sends, Input A pre-fade bus 

send, and will cut the assigned group routing.  

Channel Fader                                                                                                             1 

Each channel has a 100mm fader for precise level control from -inf to +10dB. 
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 Groups 1-4                                                                                                         1 

Overview                                                                                                                      1 

The 8424 features 4 mono Groups with 100mm Faders located in the centre 

of the console. These groups can be used for a variety of functions such as 

sub-mixing instrument groups, using group processing on selected 

instruments, balancing large amounts of instruments or as separate masters 

for the cue mix bus when using the consoles in-line mixing mode.  

Further information on ILM mode can be found at  In-Line Mode  

Group EQ                                                                                                                      1                                                                                                                       

Each mono group has its own analogue 2-band shelving EQ that can be used 

to treat groups of instruments or individual instruments depending on which 

channels are assigned the group. The high shelf centre frequency of 10kHz 

can both be boosted or cut by + or – 15dB.  and low shelf centre frequency 

of 220Hz can both be boosted or cut by + or – 12dB. The low shelf knob has 

push-activation. When pressed, the Group EQ is active and the EQ IN LED 

will illuminate. 

Pan                                                                                                                                1                                                                                                                         

Each mono group has its own pan control which has push-activation. This 

allows the mono groups to be accurately positioned in the Stereo Mix, with 

individual channels being assigned to either the left or right depending on 

the stereo image.  

Group Routing                                                                                                            1 

The Group routing buttons above the fader can be used to send the group 

output to the Stereo Mix bus by pressing MIX L or MIX R (or both). The 500-

1 & 500-2 buttons will activate the 500 series slots as group inserts. The 

routing buttons will illuminate to indicate the current routing setup.  

Beneath the routing buttons, the INS IN switch activates the groups insert 

post EQ/Pre-Fade. 

Note: Group insert sends are always active. This can be used as a second 

pre-fade direct out from each Group. 

PRE- sets the Group hardware insertion point to pre fader (see table below). 

Group Output Signal Path                                                                                        1  

 

Group 1-4 Direct Output Pre                                                                                    1 

Each mono group has its own direct output on the rear of the console which 

can be used to feed into the DAW or external recorder. Direct outs are Post-

Fade by default, the service screen option MAST>GRP 1 PRE [Y], GRP 2 PRE 

[Y], GRP 3 PRE [Y]GRP 4 PRE [Y] will set individual group direct outputs to 

Pre-Fade. 

 

 

If PRE selected  If PRE not selected 

500 series units (when activated) 500 series units (when activated) 

2 band EQ 2 band EQ 

Hardware insert Group Cut 

Group Cut Group Fader 

Group Fader Hardware insert 

Mix or Direct out routing Mix or Direct Out routing 
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Group Solo                                                                                                                   1  

The SOLO button will isolate the selected Group channel into the Stereo Mix 

bus and group outputs. The Group solo is destructive by default (SIP) but 

can be set to non-destructive modes; Pre-fader PFL or After-fader AFL which 

is set in the control room monitor section of the console by pressing the 

AFL/PFL level control or by Isolating on a channel-by-channel basis. 

More information on solo modes can be found at Solo Modes 

Group Isolate                                                                                                              1 

ISO Removes the selected Group channel from the default SIP (solo-in-

place) system and activates the groups non-destructive solo AFL/PFL bus. 

The isolated groups are SOLO SAFE. When any other solo is active on the 

console A CUT will not be applied to any group that has been isolated.  

Similarly, any group that is isolated can now be soloed without activating the 

CUT on all other channels/groups. The group solo bus is now routed either 

pre-fader (PFL) or after-fader (AFL) to the engineer headphones and monitor 

path via the PFL/AFL bus. 

PFL or AFL is selected in the control room monitor section of the console by 

pressing the AFL/PFL level knob. 

To isolate a Group-  

 Press and hold the CUT button on the selected group, then press the 

SOLO button. 

 The ISO light will illuminate Green to indicate that the group is now 

protected from destructive solo. And will not cut any channels that 

are in destructive solo (SIP) mode.  

Group Cut                                                                                                                     1 

CUT will remove the selected groups audio from the Stereo Mix bus and 

group output audio paths. The groups audio is muted when the CUT light is 

illuminated.  

Group Fader                                                                                                             1 

Each Group has a 100mm precision fader for precise level control which runs 

from -inf to +10dB. 
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 Stereo Mix Processing                                                                                    1 

Overview                                                                                                                      1 

The 8424 Stereo Mix bus features two Neve classic Marinair® transformers 

for high-headroom, voltage mixing. Two XLR outputs labelled MIX O/P on 

the rear of the console allow for recording the consoles final Stereo Mix by 

patching into the DAW, tape Machine or external recording device.  

E.Q                                                                                                                                 1 

The Stereo Mix fader has its own 2 band shelving EQ. The high shelf centre 

frequency of 10kHz and low shelf centre frequency of 220Hz can both be 

boosted or cut by + or – 12dB. The low shelf push-activation knob can be 

pressed to activate the EQ circuitry onto the Stereo Mix bus. EQ IN will 

illuminate when the EQ is active. 

 

Stereo Width                                                                                                               1 

The 8424 console features Neve’s proprietary stereo width control function 

on the Stereo Mix bus. This function uses phase to widen the stereo image. 

This push-activation pot can be pressed to activate the stereo width function 

and the IN light will illuminate to indicate if the circuitry is active.  

The pot will select between a narrow mono image when turned fully 

counter-clockwise (N), stereo at the 12 o-clock position and a wide, 

enhanced stereo image when turned fully clockwise (W). This feature is very 

useful to enhance and add width to minimal, acoustic mixes with limited 

signal sources. 
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 Stereo Mix Routing                                                                                          1 

Overview                                                                                                                      1                                                                                                           

The Stereo Mix routing buttons activate insert points and routing paths for 

the Stereo Mix bus.  

M BUS INJ L/R                                                                                                             1 

Allows an external signal to be independently blended into the master Left 

and right bus via XLR connectors on the rear of the console.  

500 1/2                                                                                                                         1  

This function routes the 500 series modules as pre-fade, pre-processing 

inserts into the Stereo Mix Bus.   

CUE BUS                                                                                                                       1  

Routes the cue bus into the Stereo Mix bus. This function allows for 48 

inputs to be mixed simultaneously into the Stereo Mix output. (1-24 channel 

Inputs A/B and 24-48 Input C to ST Cue bus). This button is automatically 

activated when 48 MIX is pressed.  

Further information can be found at  48 Mix Mode                                                                                                      

INS IN                                                                                                                            1 

Activates the Stereo Mix insert circuit, the stereo insert is routed via two XLR 

sockets on the rear of the console labelled MIX INS SEND and MIS INS RET.  

Note – The Mix insert send is always active, this can be used as a second 

pre-fade (if PRE is selected) or post-fade (is PRE is not selected) Stereo Mix 

output from the 8424.  

PRE- sets the Master mix hardware insertion point to pre fader (see table 

below) 

Stereo Mix Output Signal Path                                                                               1 

 

 

 

 

 

Master Fader                                                                                                               1 

The 8424 Stereo Mix fader is a 100mm precision stereo fader that controls 

both the Left and Right outputs of the console.  

The master CUT will mute the master mix bus from the control room 

monitor audio path. 

Bypass LED (Motorized faders only)                                                                      1 

For customers using the Motorized fader upgrade, you will notice a yellow 

‘Bypass’ LED above the stereo master fader, this is used to indicate that the 

MDAC is bypassed when the fader is set at Zero and audio is running only 

through the analogue circuitry. This MDAC Technology will be utilized in 

future firmware updates.  

 

If PRE is selected  If PRE not selected 

500 series units 500 series units 

Hardware insert 2 band EQ 

2 band stereo EQ Stereo Width Control 

Stereo width control Master Cut 

Master Cut  Master Fader 

Master Fader Hardware insert 

Mix O/P L/R XLR  Mix O/P L/R XLR 
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 1073 Preamps                                                                                                   1 

Overview                                                                                                                      1 

The 8424 console has two Neve 1073® preamps which are produced to 

the exact specifications of the original modules and feature Marinair® input 

and output stage transformers. Considerable resources have been devoted 

to the acquisition of the original components to ensure the sound remains 

true to that of the classic units. The 8424 1073’s have Smart Routing, 

enabling them to be routed to console channels 17 & 18 at the push of a 

button with no patching required. By default, the preamps are routed to the 

XLR outputs at the rear of the console. This XLR output is active even if the 

1073 is routed to 500 series slots or to channels 17/18, splitting the signal to 

record two outputs from the same source. The 1073 preamps can be hard-

patched to any channel Input B by using an XLR> ¼’’ TRS cable from the two 

1073 XLR outputs and into any channel Input B at the rear of the console.  

Gain Control                                                                                                                1 

The two 1073s on the master section of the console feature the same classic 

stepped attenuator which cycles through the dual amplifier gain settings for 

either Microphone +20dB to +80dB or Line levels -10dB to +20dB in 5dB 

steps. The SIG light at the top of each 1073 preamp illuminates Green at   -

30dB to show level coming into the preamp. The SIG light will illuminate Red

at +26dB to indicate overload.   

Trim Control                                                                                                                1 

Beneath the stepped gain control is the rotary gain trim pot which can 

adjust the preamp gain from -20dB to +5dB. The trim pot is especially useful 

for precise preamp gain control and allows signals to benefit from 1073 

harmonic distortion by dialling in high gain levels on the main gain control 

then trimming back the final preamp output with the trim pot. The trim pot 

smart routing push-function can be pressed to assign the output of each 

preamp to channels 17 and 18 Input B respectively. TO CH 17/18 light will 

illuminate Green to indicate that the 1073 outputs are routed to channel 17 

and 18. 

1073 Trim is not included in the Save/Load Recall feature. 

Preamp controls                                                                                                          - 

Ø = 180° Phase flip  

Lo Z = Impedance switch changes signal impedance from 1.2kΩ (HI-Z) to 

300Ω (Lo-Z). Useful for ribbon microphones with lower impedance 

requirements.  

+48v = phantom power for condenser microphones. Phantom power can 

only be selected and activated when the 1073 preamp is set to mic gain.  

500 series routing                                                                                                     1 

Each of the two 1073 preamps can use the 500 series slots 1 or 2 as inserts 

before the TO CH routing. The 500-1 500-2 switches at the bottom of the 

1073 section activate the 500 slots as inserts.  

Note: the 1073 output XLR at the rear of the console will not be affected by 

the 500 series insert. 
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 Instrument DI Inputs                                                                                       1 

Overview                                                                                                                      1 

In addition to the two 1073 microphone preamp inputs, the 8424 has two 

760 kΩ Instrument DI channels that can be routed to various points on the 

console. The Instrument DI inputs are ¼’’ Jack connectors (balanced or 

unbalanced) that are located conveniently underneath the front of the 

console. This allows for instrument tracking directly from the studio control 

room.  The 8424 Instrument DI’s have Smart Routing, enabling them to 

be routed to console channels 19 & 20 at the push of a button with no 

patching required. 

 

Instrument D.I Controls                                                                                            1 

Each Instrument D.I channel has a level control which runs from -20dB to 

+5dB. The SIG light at the top of each level control illuminates Green at 

-30dB and will illuminate Red at +17dB to indicate Overload.  

The instrument D.I channels have no default routing, this must be assigned 

using the 500 series slots or the smart routing TO CH switches. 

The level pot has smart routing, this push-function pot can be pressed to 

assign the output of each preamp to channels 19 and 20 Input B 

respectively. TO CH 19/20 light will illuminate Green to indicate that the DI 

outputs are routed to channel 19 and 20. 

-25 pad reduces the incoming signal by 25dB  

500 series routing                                                                                                     1 

Each of the two Instrument DI inputs can use the 500 series slots 1 or 2 as 

inserts before the TO CH routing. The 500-1 500-2 switches at the bottom of 

the Instrument DI section activate the 500 slots inserts.  

Each of the two instrument D.I preamps can be routed to the 500 series 

slots 1 or 2 by using the 500-1 500-2 routing switches at the bottom of the 

instrument DI section. 

Instrument DI Level is not included in the Save/Load Recall feature. 
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 500 series slots                                                                                                 1  

Overview                                                                                                                      1 

500-series is a module size that AMS-Neve and many other pro audio 

companies manufacture modules for. All 500 series modules that are VPR 

Alliance approved will work perfectly in the 8424 500 series slots. The 8424 

console has 2 empty slot that can be filled with any 500 series outboard 

units and used on a variety of console signals.  

500 Series Routing                                                                                                     1 

The two 500 series units can be routed as inserts to any of the following- 

• 4 mono sub-group Inserts (pre-processing) 

 Press the 500-1 or 500-2 button above the selected group 

fader to use the 500 series module as a group insert.  

• Stereo Master Inserts (pre-processing) 

 Press the 500-1/2 button above the stereo master fader to 

use both of the 500 series modules as a stereo Master 

Insert.  

• 2 built in 1073 microphone/line preamp inserts. (Post gain & trim) 

 Press the 500-1 or 500-2 button at the bottom of the 1073 

preamp section to use as an insert for the selected preamp 

channel (before smart routing to channels 17/18) 

• 2 built in Instrument D.I inputs. (Post-level control) 

 Press the 500-1 or 500-2 button at the bottom of the 

Instrument DI section to use as an insert for the selected 

Instrument D.I. (before smart routing to channels 19/20) 

Direct Input/Output                                                                                                  1 

In addition to the group, mix, preamp and DI routing options, the 8424 500 

series units can be used as standalone hardware units by using the XLR 

in/out connections on the rear of the console. This allows the 500 series 

slots to function as a separate hardware rack, independent of the console. 

The outputs of the standalone 500 series units can also be routed to any 

channel on the console by using a physical XLR>¼’’ TRS Line connection.  

Caution: if additional 500 series preamplifiers are housed in the 8424 500 

series slots, do not activate group, Stereo Mix, 1073 or Instrument DI 500 

1/2 buttons. 
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 Reverb Returns                                                                                                 1 

Overview                                                                                                                      1 

The 8424 console features two dedicated stereo reverb returns which are fed 

by the XLR inputs on the rear of the console. The reverb returns can be used 

to return stereo effect unit outputs into the console or as additional stereo 

line level inputs should you require more line inputs. Signals using the reverb 

return channels can be routed to the 500 series slots via the group 1-4 routing 

buttons.  

Reverb Return Controls                                                                                                   1  

Each reverb return has a push-activation level trim pot that runs from Inf to 

0dB and can be pressed to activate the reverb return. When activated the 

ON light will illuminate Green.  

To isolate the reverb from the solo and cue solo path- 

 Press and hold the Rev return LEVEL Pot.  

 the ISO light will illuminate Green to indicate the reverb return 

isolation status. 

Each reverb return has an independent TO CUE level pot which runs from inf 

to 0dB. This pot is push-activation and sends the reverb return signal to the 

Cue bus, when activated the ON light will illuminate Green.  

The reverb returns also have a balance pot which will balance the left and 

right levels by + or -6dB. The balance pot has push-activation and can be 

pressed to activate the balance control. the IN light will illuminate Green to 

indicate that the balance function is active. 

Reverb Return Routing                                                                                             1 

Reverb return signals can be routed to the Stereo Mix bus by pressing the 

MIX button, group 1 and 2 by pressing the GRP 1/2 button or Group 3 and 4 

by using the GRP 3/4 button. Any combination or routing is also possible by 

selecting multiple routing buttons. Each button will illuminate to indicate 

the reverb return routing.  

The reverb returns can also be soloed by pressing the AFL button which 

illuminates when active.  
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 Aux & Cue Masters                                                                                          1  

Overview                                                                                                                      1 

The Three mono AUX master and stereo CUE master controls are located 

above the control room monitor section of the console. Each pot runs from 

inf to 0dB and has push-activation. When pressed, the AUX/CUE master bus 

is active and the ON light will illuminate Green.  

Each aux master and cue master can be soloed by pressing the AFL button 

which illuminates Yellow when active.  

Global Aux Controls                                                                                                   1 

The AUX and CUE masters have several global functions that are accessed by 

pressing the AUX ON/PRE button and then pressing the AUX/CUE master 

pot.  

To switch all associated channel AUX/CUE sends ON/OFF- 

 Press the master AUX/CUE ON/PRE button once, this will now 

illuminate Green.  

 Press the master AUX/CUE pot. The associated channel 1-24 

AUX/CUE sends will now toggle between ON/OFF status. 

To switch all associated channel AUX/CUE sends to PRE/POST fade 

 Press the AUX/CUE ON/PRE button twice, this will now illuminate 

Yellow  

 Press the master Aux pot. The associated channel 1-24 AUX/CUE 

sends will now toggle between PRE/POST status. 

AUX 2&3 as CUE Mix 2                                                                                              1 

An additional cue mix can be created by using AUX2 and AUX3 bus sends. In 

this mode, AUX 2 becomes the Right stereo cue mix signal, and AUX 3 

becomes the Left stereo signal. 

The cabling into the second artist foldback system must reflect the          

AUX 3-Left and AUX 2-Right signal path.   

To monitor the second foldback mix through the solo bus- 

 Press AUX 2 Master AFL  

 Press AUX 3 Master AFL 

 

By default, Aux busses will monitor in MONO unless both AUX 2 and AUX 3 

AFL are illuminated.  

To display the second foldback mix on the VU meters- 

 Press the AUX 1/2 meter select button 

 Press the AUX 3 meter select button 

Talkback must be activated to AUX2/3 via the Services screen TB>TB AUX2 

[Y] & TB AUX3 [Y] 

VU Meters will display AUX busses in MONO unless both AUX 1/2 and AUX 

3 meter select buttons are illuminated, the second Cue mix right signal will 

appear on the left VU, the second cue mix left signal will appear on the 

Right VU. 
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 Engineer Headphones                                                                                     1 

Overview                                                                                                                      1                                                                                             

The 8424 engineer's headphone system (EHP) has been designed to help & 

enhance the modern recording session for the engineer, the producer and 

the artist. Artist and engineer can track in the control room with their own 

stereo headphones, featuring independent level controls and source 

selections. There are 2 engineers stereo headphone output jack sockets 

located just under the front console armrest. EHP 1 and EHP 2 are both 

stereo quarter inch jacks. 

EHP 1                                                                                                                             1 

Engineer Headphone mix 1 takes its signal from the main monitor source 

selector in the control room monitor section of the console. If any console 

source AFL or PFL solo is selected, such as the stereo cue mix, the 

headphones will follow this selection.  EHP 1’s level is controlled by the main 

monitor volume control in the centre of the console.  

EHP 2                                                                                                                             1 

Engineer headphone mix 2 has a five-way source selector switch located in 

the centre of the console labelled HEADPHONE 2. Engineer Headphone mix 

2 has its own independent level control and source selection 

EHP 2 Source selection                                                                                              1 

MIX – listens to the console main mix bus post-fader. 

EXT – listens to any wired external source. 

MON – listens to the control room monitor source selection. 

CUE – listens to the CUE mix bus post-master level. 

AUX 2/3 – Listens to AUX 2 or AUX 3 post AUX Master level controls. 
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 Talkback                                                                                                          11 
Overview                                                                                                                      1 

The talkback function on the 8424 enables three-way communication 

between the engineer, producer and the performers. The 8424-talkback 

microphone and talkback master level control are located at the top of the 

console, in between the two VU meters. When talkback is engaged, the 

monitors in the control room are dimmed to allow for clear communication. 

The DIM level is set by the TB DIM control above the Control Room Monitor 

Level controller.  

Talkback controls                                                                                                       1 

The talkback buttons are located beneath the control room monitor section 

of the console. The CUE TB and SLATE TB switches are momentary and must 

be held to enable talkback. RTB is latching and must be switched on or off.  

Talkback dim is controlled by the TB DIM trim pot in-between the AFL/PFL 

and DIM pots. This trim pot runs from 0 to -35dB and will affect the CUE bus 

level when talkback is engaged, similarly it will affect the AUX 2 and AUX 3 

bus if talkback to AUX 2 and AUX 3 is engaged via the services screen.  

Talkback Trim Pots                                                                                                     1 

Talkback level to all destinations can be adjusted by using the TB trim level 

pots with a small flat-head screwdriver. The top left hole labelled TB adjusts 

the external talkback feed to the XLR at the rear of the console. This 

connection can be used to feed external talkback systems, if signal into the 

external system is too hot, the TB trim can reduce talkback output 

accordingly. The next hole adjusts the talkback level to the cue bus followed 

by the slate talkback level trim. The final hole to the far right-hand side is 

used to trim the return talkback signal. The trim pots are the final level 

attenuators for talkback to the associated destination Post TB LEVEL master.  

CUE Talkback                                                                                                               1 

The CUE TB Routes the talkback microphone signal into the cue mix bus. 

When engaged, the ST CUE mix level will be dimmed by -21db to enable 

clear communication between the engineer and the performers. This 

Talkback dim level can be adjusted by using the TB DIM trim pot next to the 

master DIM pot. The DIM button will flash to indicate TB DIM active. The 

cue talkback level can be adjusted with the trim level control to the top right 

of the CUE TB button and the talkback master control.  

Slate Talkback                                                                                                             1 

SLATE TB can route the talkback microphone signal to channel Direct 

Outputs, Group 1-4 Direct outs and Stereo Mix bus outputs depending on 

which services screen option is selected. This function can be used to 

identify takes by recording the engineers voice directly to tape/DAW. The 

slate talkback level can be adjusted with the trim level control to the top 

right of the SLATE TB button and the talkback master control.  

Slate to Direct outputs, Group outputs and Mix outputs must be activated 

independently from the services screen in TB>SL DIR OP [Y], SL GRP OP [Y], 

& SL MIX OP [Y] 
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Return Talkback                                                                                                          1 

The RTB switch activates the signal path of the studio live room return 

talkback microphone. RTB is latching and can remain on throughout the 

session. This function enables two-way communication between the 

engineer and instrumentalists who may not have a vocal microphone in the 

studio live room. Return talkback is connected via an XLR connector on the 

rear of the console. The return talkback level to both M2 LS outputs and the 

RTB O/P XLR can be adjusted with the trim level control to the top right of 

the RTB button.  

Further information on Return Talkback Options can be found at Return 

Talkback Options 

In order for the RTB button to function, Return Talkback must be activated 

from the services screen under TB>RTB ENABLE [Y] 

 

Talkback Footswitch                                                                                                  1 

The 8424 Console also has a talkback on/off footswitch control that is 

accessed via the DC REMOTES D-sub connection on the back of the console 

(Pin 4). Once connected the footswitch will run parallel to the CUE TB on the 

console surface. CUE TB and DIM will flash to indicate engineer external 

talkback active.  

Further information on DC Remote pin outs can be found at DC remote Pin 

Out Functions 
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 Solo Modes                                                                                                       1 

The 8424 console has three solo modes, each solo system offers 

professional signal isolation derived from Neves large-format studio 

consoles. Each solo mode works differently, while allowing users to listen to 

console signal sources in isolation.  

SIP Solo-in-Place                                                                                                         1 

Solo in place is the 8424’s default solo mode. SIP is destructive, any channel 

solo will mute all other console channels. SIP sends the soloed channel 

signal through the stereo mix bus. All 24 channels 4 mono groups can be 

soloed-in-place as well as console inputs 25-48 when in 48-Mix mode. Solo 

in place is useful when mixing, as it allows engineers to hear exactly how a 

signal sounds in-place within the stereo field, including channel processing, 

Pan, Fader Level, Aux, Cue sends and Routing assignments. Since Solo in 

place is routed through the Stereo Mix bus, all stereo mix processing is 

active and retained while soloing.    

AFL After Fader Listen                                                                                               1 

After fader listen is activated by pressing SOLO SAFE in the global console 

controls section of the 8424 or on a channel-by-channel basis by activating 

ISO. AFL is Non-destructive, meaning that any soloed signal does not mute 

other console signals. AFL uses its own stereo bus, separate from the stereo 

mix bus, the AFL bus also uses voltage mixing through Marinair® 

transformers allowing for accurate soloing. The master AFL Level control 

located in the control room monitor section of the console and sets the 

master AFL level to be fed to the headphones and Control Room Monitor 

path. AFL is useful when recording, as any AFL soloed signal does not mute 

other channel signals, therefore not affecting the recording Direct Outputs 

or AUX/CUE sends. AFL signals are routed to the AFL bus after the channel 

fader and pan, allowing for accurate stereo imaging and level when soloing.  

PFL Pre Fader Listen                                                                                                   1 

Pre fader listen is Activated by pressing SOLO SAFE in the global console 

controls section of the 8424 and then pressing the ALF/PFL level pot. (or on 

a channel by channel basis by activating ISO). PFL is Non-destructive, 

meaning that any soloed signal does not mute other console signals. PFL 

signals are routed thorough the AFL bus in the same way as AFL solos but 

with the key difference of not including fader level and pan position. Any PFL 

signal will be heard in Mono and at the incoming channel signal level set by 

the Trim Pot. Since PFL listens to the consoles incoming signal before it is 

processed by any channel inserts and attenuated by the channel faders it is 

very useful for preparing to record by auditioning incoming signal levels, 

adjusting channel strip trim levels and preamp/DI gain levels. PFL is also very 

useful for quickly identifying problem signals within a mix session such as 

feedback or distortion.  
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Solo Switching Behaviour                                                                                         1 

All three solo modes can be switched between Latching or Momentary 

modes globally from the console Services Screen.  

 

Latch Mode                                                                                                                  1  

Selected from the services screen MAST>SOLO [MOM]  

Affects SIP/AFL/PFL and is the 8424-default solo switch setting. This setting 

allows for multiple console signals to be pressed and soloed at the same 

time. Solos will remain on until the engineer deselects the solo switch on 

each soloed channel or by pressing the RESET button in the global console 

controls section of the 8424.  

Momentary Mode                                                                                                      1  

Selected from the services screen MAST>SOLO [LATCH]  

Momentary mode affects SIP/AFL/PFL. In Momentary mode, when a solo is 

pressed, it must be held to remain soloed, when the operator lets go of the 

solo button, the solo is automatically cancelled. 
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 Master Controls                                                                                               1 

The 8424 Master controls enable global switching of channel, solo and 

channel/cue input settings.      

SOLO SAFE                                                                                                                   1 

Globally switches all channels and groups from SIP (Solo-In-Place) to non-

destructive AFL/PFL (After-fader Listen or Pre-fader listen) mode. When solo 

safe is Illuminated, any solo button on the channels and groups becomes 

non-destructive AFL/PFL. 

RESET                                                                                                                            1  

Wipes any active console solo, resetting the console to a non-solo state. 

Does not affect channels that are isolated (ISO).  

48 MIX                                                                                                                          1 

A unique 8424 function that enables 48 individual inputs to be mixed 

through the console simultaneously.  Pressing 48 MIX changes several 

routing options on the console.  

• All channel CUE inputs are set to I/P C  

• All CUE sends are switched ON 

• The SIP Solo system is linked to the CUE along with the channel 

faders.  

• CUE BUS is selected, routing all channel CUES to the Stereo Mix bus.  

The console is now set to receive and mix up to 48 DAW interface outputs 

through its Stereo Mix bus with inputs 1-24 appearing on the channel faders 

and pan controls and inputs 25-48 appearing on the CUE level and pan 

controls.  

Further information can be found at  48 Mix Mode                                                                                                      

AUX ON/PRE                                                                                                              1  

When illuminated Green, pressing each AUX master knob now globally 

toggles all channel AUX’s 1, 2, 3 or ST CUE on or off. When illuminated 

yellow, pressing each AUX master knob now globally toggles the selected 

channel AUX’s 1, 2, 3 or ST CUE between Post-fader and Pre-fader state.       

IPC MTR                                                                                                                        1  

This function allows for accurate metering of all Input C (DAW inputs 25-48). 

IPC MTR Globally switches the 8424 channels 8-stage LED Meters to display 

Input C DAW Interface Outputs 25-48 incoming levels.  

A/B CH IP                                                                                                                      1 

This function globally selects the channel inputs from either Input A (DAW 

interface outputs 1-24 or Input B channel Line inputs. Global switching 

functions in the same way as local A/B switching. 
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Control Room Monitor                                                                                   1 

Overview                                                                                                                      1 

The Control Room Monitor section of the 8424 gives total control of the 

Stereo Mix monitoring outputs and is the loudspeaker output attenuation 

control for the 8424 console. The monitor section of the console is 

positioned in the centre to allow easy access to the essential controls.  

Monitor source selection buttons can be found at the top of the control 

room source section. AFL/PFL solo level control, DIM level and monitor level 

knobs are also located here along with monitor output selectors, CUT, DIM 

and MONO buttons.  

There are three possible stereo loudspeaker outputs from the console; A, 

M1 and M2. The M1 and M2 monitor output levels can be independently 

calibrated to match the A LS output level by using the trim screw points next 

to M1 and M2 speaker selection buttons.  

Control Room Source                                                                                                1 

MIX selects the main Stereo Mix bus, post-master fader as the control room 

audio source. 

EXT selects the external stereo input as the control room audio source, used 

for listening to reference tracks or monitoring any external audio sources. 

i-MON selects the 3.5mm Jack input as the control room audio source. The 

minijack can be found underneath the console armrest, next to DI I/P 1.  

Monitor Level Controls                                                                                             1 

MONITOR LEVEL - A precision rotary controller to attenuate the console 

loudspeaker outputs. Perfectly tracks the stereo image at any listening level.  

AFL/PFL - Uses Marinair® Transformers to give accurate AFL voltage soloing 

and can be boosted by 10dB.  ALF/PFL sets the level for the non-destructive 

solo bus of the console. Both AFL and PFL solo modes are activated either on 

a channel-by-channel basis by Isolating selected channels or by pressing the 

SOLO SAFE global function. Once pressed, any channel solo button will now 

be AFL, unless the AFL/PFL pot is pressed and the PFL light is lit.  Reverb 

returns and AUX masters are AFL by default.  

TB DIM - Sets the amount that the CUE bus and optional AUX 2 & 3 busses 

are reduced by when CUE TB or producer return talkback is active.  

DIM POT - Sets the amount the Control Room Monitor level is reduced by 

when the DIM button is pressed. 

CUT -Mutes the console LS outputs.  

DIM - Reduces the loudspeaker output of the console by the amount set by 

the DIM POT, displays as a solid light when dim is pressed, flashes if CUE TB, 

Producer RTB or the talkback footswitch is pressed.  

MONO - Sums the left and right loudspeaker outputs of the console into a 

mono signal which is then fed to both the Left and Right speaker outputs 

equally. 
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A - Routes the control room monitor audio path to the speaker output A LS 

O/P XLRs on the rear of the console.  

M1 - routes the control room monitor audio path to the speaker output M1 

LS O/P XLRs on the rear of the console. 

M2/RTB - routes the control room monitor audio path to the M2 LS O/P 

speaker output XLRs on the rear of the console. M2 has the added feature of 

having Return Talkback capability, the RTB signal from the live room can be 

routed through the console into the M2 XLR outputs. When RTB is engaged, 

the signal is fed directly into M2 monitors, this allows for quick 

communication between the live and control room.  

TB DIM - Trim calibration point allows for setting attenuation of the cue 

mixes when talkback is engaged. It runs from 0 to - 35dB. If DIM is also 

engaged, the attenuation levels are multiplied together. 
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 VU Meters                                                                                                         1 

 

Overview                                                                                                                      1 

The 8424 console features 2 large backlit VU meters which display level in 

Volume Units. The VU meters can be used to monitor a number of different 

console signal sources.  

Meter Select                                                                                                                1 

MIX - Selects the Stereo Mix output as the VU meter signal. 

G1/2 - Selects Group 1 (Left) and 2 output (Right) as the VU meter signal. 

G3/4 - Selects Group 3 (Left) and 4 output (Right) as the VU meter signal. 

AUX 1/2 - Selects AUX 1 (Left) and Aux 2 (right) bus as the VU meter signal. 

AUX 3 - Selects AUX 3 (Left) mix bus as the VU meter signal 

Aux 1/2 and AUX 3 - together shows the Left (AUX 3) and right (AUX 2) Cue 

Mix 2 signal. 

MON - Selects the control room monitor Left and Right output as the VU 

Meter signal.  

CUE - Selects the Left and Right cue Mix bus output as the VU Meter signal.  

REV 1 - Selects stereo reverb return 1 as the VU Meter signal.  

REV 2 - Selects stereo reverb return 2 as the VU Meter signal. 
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 Services                                                                                                              1 

The 8424 Services screen allows users to globally select master controls, 

engage Talkback and reverse talkback options controls and access and assign 

the oscillator functions.  

The services screen is a 16-character digital display that shows the top menu 

titles MAST, TALK, OSC, SYSTEM. The buttons either side of the screen are 

for service screen navigation.   

- Returns to the top title menu.  

 - Scrolls forwards through menu options one at a time. 

 - Scrolls backwards through menu options one at a time. 

- Enters the four main menu tabs and activates selected 

parameters.                                                                                                                                                                                                                           

CTRL - Enables secondary functions. Pressing CTRL +    will jump to 

the beginning or end of the selected menu options.  

Master Options                                                                                                           1 

MIX – Globally routes channels to the stereo mix bus.  

MIX PAN – Globally activates channel PANS. 

GRP 1 – Globally routes channels to group 1.  

GRP 2 – Globally routes channels to group 2.   

GRP 3 – Globally routes channels to group 3.  

GRP 4 – Globally routes channels to group 4.  

ZERO IP A – Globally resets all channel Input A DAW Interface outputs to 

unity gain. 

ZERO IP B - Globally resets all channel Input B Line Inputs to unity gain. 

SOLO: [LATCH]/[MOM]– Switches the console solo system from latch to 

momentary. Console default is LATCH  

ILM: [Y]/[N] – IN Line Mode – Globally selects Input A to return on console 

Input C via the ST CUE controls.  

More information can be found at In-Line Mode  

INS IN – Globally activates channel inserts.  

INS I/P C – Globally assigns channel inserts to Input C.   

CUE PAN – Globally activates channel ST Cue Pans. 

GRP PAN – Globally activates channel Pan to Groups.  

DIR PRE – Globally routes channel Direct Outputs as pre-fader.  

CUE GRP – Globally routes channel Cue stereo outputs to group 3&4. 

GRP 1 PRE [Y]/[N] – Routes Group 1 Direct Output as pre-fader.  

GRP 2 PRE [Y]/[N] – Routes Group 2 Direct Output as pre-fader.  

GRP 3 PRE [Y]/[N] – Routes Group 3 Direct Output as pre-fader.  
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GRP 4 PRE [Y]/[N] – Routes Group 4 Direct Output as pre-fader.  

IPA>DIR [Y]/[N] – Routes channel 1-24 Direct Output from the Input A DAW 

Interface outputs. This is useful for printing stem tracks back into the DAW. 

The default channel Direct Output is Input B. 

AU/CU PC [Y]/[N] – Aux Cue Pre-Cut.  Globally alters the behaviour of the 

AUX and CUE sends when Input A is selected. When the Y option is selected, 

AUX and CUE sends are routed as pre-cut, matching the behaviour of AUX 

and CUE send when input B is selected.  

This option is designed for optimum behaviour when overdubbing 

SET ZERO –Sets the zero point for the ZERO FADERS option. Manually move 

faders 1-24 to their 0 location, then press CTRL + Enter on the SET ZERO 

setting. This zero-fader position is now the location that faders will jump to 

when ZERO FADERS is pressed.  

See Set Zero for further information. 

ZERO FADERS – Pressing Enter on this setting will reset channels 1-24 faders 

to zero, the zero point can be calibrated using the following SET ZERO 

option.  

See Zero Faders for further information. 

By default, this setting is calibrated in the Neve factory, however, the SET 

ZERO function can be used if you wish to set zero manually. 

DIS BYPASS [Y]/[N] – Disables the default MDAC Bypass behaviour of the 

stereo mix fader for motorized fader consoles. When [Y] is selected, the 

MDAC will be in-circuit at all fader positions, removing the automatic bypass 

switching when the fader is moved to the zero position.  

See BYPASS for further information 

Talkback Options                                                                                                        1 

TB AUX2 [Y]/[N] – Routes Talkback into AUX 2 buss.   

TB AUX3 [Y]/[N] – Routes Talkback into AUX 3 buss.   

RTB COMP [Y]/[N] – Activates the Return Talkback Compressor.  

RTB +48 [Y]/[N] – Activates the Return Talkback Phantom power.  

RTB ENABLE [Y]/[N] - Activates Return Talkback.  

SL DIR OP [Y]/[N] – Routes Slate to all Channel Direct Outputs.  

SL GRP OP [Y]/[N] – Routes Slate to all Group Direct Outputs.  

SL MIX OP [Y]/[N] – Routes Slate to the Stereo Mix Output.  

Oscillator Functions                                                                                                   1 

OSC DIR [Y]/[N] – Routes the Oscillator to the Channel Direct Outputs.  

OSC GP [Y]/[N] – Routes the Oscillator to the Group Outputs.  

OSC MIX [Y]/[N] – Routes the Oscillator to the Stereo Mix Output.  

OSC SL TB [Y]/[N] – Routes the Oscillator to the Slate TB Output.  

TIP:  

To quickly access ZERO 

FADERS  

Enter the MAST submenu on 

the Services Screen 

Press CTRL +     to jump to 

ZERO FADERS at the end of 

the menu 
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System                                                                                                                          1 

SAVE –Saves current console state to the 8424 internal memory. See Save 

LOAD – Loads a console store from the 8424 internal memory. See Load 

NETWORK – Opens the networking submenu. Options shown below  

DHCP: [Y/N] – For use with the 8424 and Neve Updater Apps. 

Selecting [Y] will allow a connected network DHCP server to assign 

an automatic IP address to the 8424 console.   

SET IP: for use with the 8424 and Neve Updater Apps. First, select 

DHCP [N] to enter a manual IP address.   

Manual addresses are entered using the      ,     , ENTER and CTRL buttons. 

Addresses are entered 3 digits at a time.   

ENTER toggles through plus 1 digit at a time  

ENTER + CTRL toggles through minus 1 digit at a time 

CTRL+       toggles through plus 10 digits at a time 

CTRL +      toggles through minus 10 digits at a time 

Once the entire address has been entered, select YES to enter the Manual IP 

address.  

F3 DAW – Selects between [CUBASE/NU] / [ABLETON] / [STUDIO ONE] / 

[LUNA] as the default daw for the F3 key.  

Cubase/Nuendo information - Cubase/Nuendo DAW Controller Operation 

Ableton information - Ableton  

Studio One information - PreSonus Studio One 

UA LUNA information- Universal Audio LUNA  

RESET DESK CONFIRM [OK] – This software reset option resets the console 

back to its factory default start up setting, wiping any solo, routing and input 

trim setting. This option gives a five second countdown before reset is 

enacted. Pressing any key during this countdown will cancel the reset 

procedure.  
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 Recall Store System                                                                                         1 

Overview                                                                                                                      1 

One of the main drawbacks of analogue console workflow is the long and 

arduous process of recalling console settings, fader positions and pot 

positions. On larger consoles, this process can take a very long time and can 

slow down the creative process. The 8424’s internal Recall feature allows 

operators to save and load console switch settings, fader positions and hard 

pots within the 8424 internal memory. 8424 settings can be saved and 

recalled on a session-by-session basis enabling a fast, analogue console 

workflow that takes advantage of all features while remaining creative, 

efficient and productive.  

Save                                                                                                                               1   

The console save option scans all console settings and stores them in the 

8424’s internal memory. There are 99 available console stores that can be 

used to save console settings for different projects. Each store is numbered 

[1] to [99].  

 

To save a Recall Store –  

 Enter SYSTEM menu and select [SAVE] 

 

The following window will appear –

 

 Choose a Console store [1] to [99] clicking ENTER or to toggle 10 at 

a time press CTRL + ENTER.  

 Use the navigation arrows to select [OK] 

 

 

 

 

 

TIP:  

The 8424 Save and Backup 

feature is available for 

console firmware versions 5.0 

and above.  

This feature is available via 

the 8424 App (version 2.0 and 

above) and enables saving of 

console stores directly to the 

DAW computer. 

See  The 8424 App – Snapshot 

Backup for more information. 
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Once pressed, a 5 second countdown will begin while the console panels 

are preparing to save settings.  

 

 

 If you do not wish to save over the selected store, either press the 

HOME button or select CANCEL  

 

Once the save process is complete, switch settings, channel trims, pot 

positions, and fader levels are now stored, along with the master section 

switch settings, pot positions and fader levels.  

8424 settings exempt from the console store –  

• Talkback Level 

• Solo Settings 

• Control room Monitor CUT  

• 1073 1 Trim 

• 1073 2 Trim 

• Instrument DI 1 Level  

• Instrument DI 2 Level   

• Master menu settings (except IPA> DIR, ILM, SOLO 

[LATCH/MOMN], GRP 1 PRE, GRP 2 PRE, GRP 3 PRE, GRP 4 PRE) 

• TB menu options 

• OCS Menu Options  

Once saved, the services screen will revert to the top title menu. 

Load                                                                                                                              1   

The load option allows users to select any of the 99 Recall Stores to recall. 

Loading a Recall store will overwrite the current console switch settings 

automatically, the user can then choose to recall the hard pots and fader 

settings or to leave them in their current state. Stores can only be loaded 

from an active recall save file, if there is no data stored on the selected store 

number, the load process will not begin.  

For consoles with motorized faders, the faders will automatically move to 

their correct recall positions. Only the hard pots will need to be recalled.  

As a safety feature, the MONITOR CUT will always activate after loading a 

console snapshot. 

 

 

 

TIP: 

The 8424 Load and Restore 

feature is available for 

console firmware versions 5.0 

and above.  

This feature is available via 

the 8424 App (version 2.0 and 

above) and enables saving of 

console stores directly to the 

DAW computer. 

See The 8424 App – Snapshot 

Backup for more information. 
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To load a Recall Store – 

 Enter SYSTEM menu and select [LOAD] 

 

The following window will appear –  

 Choose a Recall Store from [1] to [99], toggle through stores by 

pressing ENTER, or to toggle 10 at a time press CTRL + ENTER.  

 

 Once the selected store is found, use the navigation arrows to 

select [OK]   

 

Once pressed, a 5 second countdown will begin while the console panels 

are preparing to load settings.  

 

 If you do not wish to save over the selected store, either press the 

HOME button or select CANCEL  

 

Once the countdown is complete, the console snapshot will be automatically 

loaded, this includes all console soft-switch settings such as mutes, routing, 

aux on/off pre/post state and input trim settings. 
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 Turn clockwise to 

match saved position 

Once the Snapshot loads (following a 2 second delay), the Recall store load 

process will prompt the user to begin the recall procedure.  

 Select [OK] to begin the recall procedure. If hard pot/fader recall is 

not required, select [CANCEL] 

 

Auto Scan                                                                                                                     1 

The Recall auto scan starts once OK has been pressed. This procedure 

automatically scans all console pots and faders from channel 1 to 24. 

Settings are read from the top of each channel strip downwards, scanning 

from ST CUE PAN down to the channel FADER.  

Each channel strip SOLO will light up as the channel strip settings are 

automatically scanned.  

 

This process is repeated for all 24 channels and then the master section is 

scanned. All four group SOLOS will illuminate as the master section is being 

automatically scanned.  

The auto scan procedure scans the entire console 3 times, this ensures total 

accuracy and compensates for any manual pot/fader motions entered by 

the operator during the auto scan process. 

Pot Recall                                                                                                                     1 

When the auto scan process finds a pot that is out of position from the 

Recall Store saved position, the service window will display the channel 

number (1) first, followed by the parameter name (in this example – PAN) 

on the left side of the screen. The right side of the screen will display a 

horizontal line with two attached vertical lines. L and R represent the Left 

and Right pan pot directions.  

The Top vertical line represents the current pot position.  

The bottom vertical line represents the Console Store Saved pot position  

                                Current Pot Position  

                                           

             

                                 Saved Pot Position  

In the above example, Channel 1 PAN needs to be turned clockwise (Right) 

in order to match the saved pot position. As the pot is turned, the top 

vertical line will sweep across until it matches the saved pan pot position.  
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 Move fader up 

to match saved 

position 

Once the pot is in the correct position <MATCHED> will momentarily appear 

on the screen.  

 

The pot position now matches the console store. The auto scan process will 

continue until it discovers another pot or fader position out of place from 

the saved Recall store.  

 

Fader Recall                                                                                                                 1 

The example below shows a that auto scan has found a fader out of position 

on channel (1). - and + represent fader level down or fader level up.  

 

                              Current fader position 

 

                              Saved fader position 

In the above example channel 1 fader must be moved upwards in order to 

match the saved fader position. As the fader is moved upwards, the top 

vertical line will sweep across until it matches the saved fader position. 

For users with the motorized fader upgrade, faders will automatically 

move to their saved recall positions. 

Once the fader is in the correct position <MATCHED> will momentarily 

appear on the screen. 

  

The fader position now matches the Recall store. The auto scan process will 

continue until it discovers another pot or fader position out of place from 

the saved console store.  

Please take extra care when adjusting fader positions, due to the high 

resolution of logarithmic-scale faders, fast motions can cause the auto 

scan to skip this fader setting until the next auto scan cycle. 

Press HOME at any time to stop the auto scan and exit recall. 
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Manual Recall                                                                                                             1 

At any point during the auto scan process users can enter manual recall 

mode. This mode of operation allows users to manually recall individual 

channel settings or master section settings without having to auto scan and 

recall the entire console.  

To manually recall a selected channel, simply press the channel SOLO button 

during the auto scan process. When pressed, the auto scan is stopped, and 

the recall program is focused only on the selected channel.  

The display will now show and remain focused on the topmost channel 

setting (ST CUE PAN)  

Use the       and       to toggle through settings in the following order –  

ST Cue Pan> ST Cue Level> AUX 3 > AUX 2 > AUX 1 > PAN > Fader 

If settings match, the saved setting from the console store <MATCHED> will 

show on the display. 

 

if the setting does not match, the horizontal line will appear until the 

pot/fader has been reset.  

 

In Manual mode, the operator must toggle through each selected channel 

strip setting manually by pressing the       and       keys.   

To select adjacent channels in manual mode press and hold CTRL and press 

the       and       or press the adjacent channel solo button.  

To manually recall a master section setting, press any of the 4 group solo 

buttons.  

The display will now show and remain focused on the topmost master 

section setting (REV RETURN 1 LEVEL). 

Use the       and       to toggle through master section settings and adjust as 

required.  Settings will appear as <MATCHED> or the horizontal line will 

appear if settings do not match the Console Store.   

To exit manual mode, press the selected channel SOLO button again. This 

will return the recall procedure to auto scan mode.  

 Press HOME at any time to stop the auto scan and exit recall. 
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 Return Talkback Options                                                                                1 

Overview                                                                                                                      1 

The 8424 includes a Return Talkback feature that can be used in three 

different ways depending on your studio requirements.  

The Return Talkback system has its own microphone controls, Gain, 

Phantom power and Compressor circuit. The Mic Gain level is controlled 

from the RTB GAIN trim controller at the rear of the console. At the factory 

this level is set to 40dB but can be adjusted with a small flat head 

screwdriver counter clockwise to reduce gain, or clockwise to increase the 

Return Talkback Mic Gain.  

The Return Talkback system has +48v Phantom power which can be 

activated via the services screen option TALK>RTB +48 [Y]  

The return talkback system has its own compressor circuit which is activated 

from the Services screen under TALK>RTB COMP [Y] The Threshold of the 

compressor can be adjusted with a small flat head screwdriver via the RTB 

THR controller at the rear of the console. From the factory, the threshold is 

set to 0dB and can be adjusted counter clockwise to reduce the threshold, 

or clockwise to raise the threshold.  

Once the RTB GAIN and RTB THR are set, adjust the RTB TRIM pot at the 

right of the RTB button on the console surface to set the final return 

talkback microphone gain levels.  

Live room Return Talkback                                                                                      1 

Live room return talkback enables seamless two-way communication 

between the studio live room and the studio control room. This function is 

particularly useful when not every performer in the live room has a 

microphone. With live room return talkback every performer can 

communicate effectively with the producer and studio engineer.  

The live room Return Talkback microphone must be connected via the RTB 

XLR on the rear of the console. 

This default Return Talkback mode routes the RTB signal into the M2 

Loudspeaker outputs. When the RTB button is pressed and illuminated, the 

return talkback signal can be monitored through any loudspeaker system 

connected to the M2 LS O/P XLR LEFT & RIGHT outputs at the rear of the 

console.  

M2 speakers are used to listen to the studio live room independently of the 

control room mix on outputs A or M1. If the control room monitor signal is 

sent to the M2 speaker set, RTB will be cancelled. RTB can only be activated 

if A or M1 is selected as the control room monitor loudspeakers.   

RTB must be enabled by switching the RTB system on in the services screen 

via TALK>RTB ENABLE [Y]  

The RTB switch will only function once this step is completed. 

 

 

 

 

 

 

 

RTB Activation, 

Compression Threshold, 

Gain level and Phantom 

Power are accessed from 

the services screen 
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Producers Sofa Mic                                                                                                    1 

As an alternative, the 8424 return talkback can be used to create a second 

talkback feed from the control room into the live room. In this mode, the 

RTB signal is not sent to M2, (as is the case for the Live Room Return 

Talkback mode) but instead is sent to the CUE bus. This allows a producer at 

the back of the room to talk to performers by using a switchable producer 

microphone connected to the RTB MIC input along with a remote switching 

device connected to the DC REMOTES 15-Pin connection at the rear of the 

console. Producer Talkback mic gain and compressor settings are adjusted at 

the rear of the console, Phantom power is set in the services screen at 

TB>RTB +48V: [Y] 

Producer talkback is unaffected by RTB TB trim. 

When the Producer Mic is in use, the CUE TB button will flash to indicate 

that the producer RTB is active. The engineer can override the RTB producer 

mic by pressing and holding the CUE TB button. Producer talkback is 

automatically patched to the same aux and cue busses as the 8424’s internal 

CUE TB, no additional patching is required. The Producer talkback will also 

activate the TB DIM in the same way as the engineer talkback system. CUE 

TB and DIM will flash indicating Producer return talkback active. 

Engineer talkback is always the Master Talkback system. 

Additional Recording Input                                                                                      1 

The Return Talkback system also has the ability of becoming an additional 

recording input from the live room. The Return Talkback mic in the live room 

is connected to the console RTB MIC XLR input connector on the rear of the 

console. This signal passes through the adjustable internal RTB microphone 

preamp and compressor circuit within the console and is routed out of the 

RTB O/P XLR connector at the rear of the console. This can then be patched 

manually with an XLR>¼’’TRS cable back into any console channel Input B 

and mixed along with the other console channel inputs, alternatively this 

can be patched directly into the audio interface and recorded into the DAW.  

In this mode the RTB circuit does not need to be activated either from the 

services screen or from the RTB button on the console surface. The mic 

simply needs to be patched to wherever it is required, with the phantom 

power, gain, compressor and RTB TRIM settings set appropriately.  
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 Service Outputs (DC Remotes)                                                                      1 

The 8424 console has a 15-Pin, 5 Channel D-Type connector on the rear of 

the console, Labelled as DC Remotes. These service outputs allow for 

several external control options and can be controlled by a number of 

custom-built remote switches or connected footswitches.   

Pin 1 provides the on/off switch for producer RTB. 

Pin 2 provides an external control for remotely activating the Monitor DIM.  

Pin 3 provides an external control for remotely activating the monitor CUT.  

Pin 4 provides an external control for remotely activating Engineer Talkback. 

Pin 5 provides an external control for remotely activating Return Talkback. 

Pin 6 provides a 5v supply for the producer talkback switch. 

Pin 8 ground pin (Digital). 

Pin 7, 9, 10, 11, 12, 13, 14, 15 not in use.  

Service Pin outs are available at DC remote Pin Out Functions 
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 2T VU MTR OSC & TB                                                                                      1 

The 8424 15-pin connector labelled as 2T VU MTR OSC & TB output provides 

console outputs external devices such as VU meters, external talkback 

systems as well as providing an external Oscillator output for use when 

calibrating connected audio equipment. 

Channels 1 and 2 are for External VU meter outputs, these can be 

connected to any external Large VU or Linear phase VU meter. The VU trim 

pot located at the rear of the console allows for calibration of this external 

send.  

Channel 3 is not in use. 

Channel 4 is used as an external Talkback send, this is always active and post 

talkback master level control. This can be used to feed any external talkback 

system. 

Channel 5 is used as an external Oscillator send and is set at +4dBu.  

2T VU outs are available at 2T VU MTR Pin Out Functions 
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 Example Application - Mixing                                                                       1 

The primary input for mixing is Input A. This is fed via D-type connections directly into the console from the DAW 

Audio Interface. When 24 DAW outputs are connected via the consoles three Input A D-type connectors, 24 

separate channels of audio can be mixed through the consoles Stereo Mix Bus, through the 4 Mono Group busses 

through the Group direct outputs or bounced as individual stems back into the DAW by using the channel Direct 

Outputs. The 8424 has Marinair® Transformers on its Stereo Mix bus for true Voltage mixing. The processing on the 

master section of the console (Group/Stereo Mix EQ’s, Stereo width control, Channel, Group or master hardware 

inserts, 500 series inserts) allow for versatile tone shaping of Group signals and the main Stereo Mix signal. If your 

session requires more than 24 mix channels, there is no need to sum multiple DAW channels into console stereo 

pairs. The consoles 48 MIX mode gives the capability of mixing 48 separate channels simultaneously through the 

console. DAW interface Outputs 25-48 can be fed from the Audio Interface into the Input C D-Type connectors on 

the rear of the console.  

Further information at  48 Mix Mode                                                                                                      
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Performer Microphones 
 

 Example Application – Recording                                                                 1 

When recording through the 8424 console, Input B allows individual line-level signals to be patched directly into the 

channel inputs via the ¼’’ balanced jack connections at the rear of the console. Any external Preamp line outputs can 

also be patched into the console via Input B, allowing multiple microphone sources to be recorded through the 

console surface. Up to 24 channel signals are then fed through the Direct Output trim control (either pre or post-

fader), through the D-Type connector on the rear of the console and back into the DAW interface inputs. 

Instruments in the control room can be patched directly into the consoles two Instrument D.I inputs under the front 

armrest, through any optional 500 series processing and into channels 19-20 via smart routing which can then be 

sent via the Direct Output Trim control (pre or post-fader), through the D-Type connector on the rear of the console 

and patched into the DAW interface inputs. Microphone sources can be connected to the two 1073 preamps and fed 

to channels 17 & 18 via smart routing which can then be sent through the Direct Output Trim control (pre or post-

fader), through the D-Type connector on the rear of the console and patched into the DAW interface inputs.  
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 Example Application – Overdubbing                                                           1 

The channel IPA/IPB button enables fast input selection for individual channels, allowing for overdubs to be quickly 

performed and recorded alongside DAW return channels.  Globally select Input A to return your previously recorded 

DAW tracks back through the 8424’s 24 channels. Overdubs can be recorded on any chosen channel 1 to 24 by 

selecting Input B as its channel input source. The selected channel will be setup to feed the channel Direct output 

into the DAW ready to record an overdub track. DAW return and live overdub tracks can be monitored in the control 

room at the same time through the Stereo mix bus and can both be sent to the ST CUE output to feed performer 

headphones. The recorded track can be monitored In-line on the same channel strip by activating ILM mode or 

manually applying IP/A to the selected channels ST CUE bus. This allows you to check your overdub in the mix 

without sacrificing channels or switching from your recording Input B. In-Line mode also allows you to record with 

DAW plugins active, simply deselect MIX on the selected overdub channel and monitor the recorded signal coming 

back from the DAW through the ST CUE Input A.  

Further information at In-Line Mode  
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 48 Mix Mode                                                                                                     1 

This mode of operation doubles the channel count of the 8424 console and 

enables 48 separate mono DAW inputs to be mixed simultaneously. This 

mode splits the console into two layers - The channel faders (I/P A) will 

input DAW interface outputs 1-24 and the ST CUE bus uses Input (I/P C) to 

input DAW interface outputs 25-48. Additional DAW outputs can be patched 

from your audio interface and into Input C D-Type connectors at the rear of 

the console.  

To enter 48 MIX mode simply press the 48 MIX button in the console master 

controls section. Pressing 48 MIX activates several routing options: 

• All previous ST CUE ON switches, PRE/POST state and Input 

selection (I/P C, I/P A) are overridden. 

• All channel ST CUE inputs are set to I/P C.  

• All ST CUE channel sends are switched ON. 

• The SIP Solo system is linked to the ST CUE along with the channel 

faders.  

• CUE BUS is selected, routing the ST CUES to the Stereo Mix fader.  

In 48 MIX mode, the Cue Master bus now becomes the master fader for all 

I/P C DAW Interface Outputs 25-48. The Cue Master bus must be switched 

ON by pressing the CUE master pot in the master section of the console.  

Channels 1-24 ST CUE now become level and pan controls for DAW returns 

25-48 (I/P C).  These inputs run in-line alongside the DAW monitor returns 1-

24 (I/P A) which are controlled by the channel fader and pan at the bottom 

of the channel strip.  

The insert on the channel strip can be assigned to either A or C input by 

selecting or deselecting the INSERT I/P C button.   

To solo DAW returns 25-48, press the CUE level pot, this function now no 

longer acts as an ON switch. In 48 MIX mode pressing the Cue level pot will 

SOLO the signal and the ON LED will flash to indicate solo active.  

Channels can be removed from 48 MIX mode on an individual basis one at a 

time by pressing and holding the ST CUE PAN then pressing the ST CUE level 

control simultaneously. When removed, the ST CUE will once again function 

as a traditional Cue send.  

Pressing 48 MIX a second time exits 48 MIX mode and the channel ST CUE 

sends are switched off and Input C is de-selected. Any channel ST CUEs that 

were individually removed from 48 MIX mode will remain on and function 

as Cue sends.   

As an alternative to the Cue Master bus, the cue outputs can be sent to 

Group masters 3&4. This option gives a second pair of master faders for 

DAW Interface outputs 25-48 which can be processed independently of 

inputs 1-24.  To send 25-48 to Groups 3 & 4 globally select MAST>CUE GRP 

from the services screen.  
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 In-Line Mode (ILM)                                                                                          1 

The 8424 is capable of functioning as an In-line studio console, with the ST 

CUE level control becoming the monitor return ‘Small Fader’. This allows for 

simultaneous mixing of both recording line inputs (I/P B) on the channel 

faders and monitor return inputs (I/P A) on the ST CUE controls. These in-

line monitor returns can either be routed to the mix via the cue bus, or to 

groups 3+4 which then become the master fader for any selected monitor 

returns.  

ILM works in a similar way to 48 MIX mode, each channel ST CUE can select 

either Input A for DAW returns 1-24 (In Line mode) or Input C for DAW 

returns 24-48 (48-Mix mode) 

To select Input A as the Stereo cue source- 

 Press and hold the CUE PAN and then press the ST CUE controller 

twice. I/P C I/P A LED will illuminate Green to indicate that Input A 

is the ST CUE source.  

To toggle between I/P C or I/P A Cue send source- 

 When the I/P C, I/P A LED is illuminated, press and hold A/B CH IP at 

the top of the channel strip then press the ST CUE controller, The I/P 

A I/P C LED will illuminate Green to show that Input A is the signal 

stereo cue source or will illuminate Yellow to indicate that Input C is 

the signal source for the stereo cue send.  

To globally set ILM mode 

 Press 48 MIX 

 In the services menu go to MASTER>ILM: [Y]  

 This will globally select Input A as channel 1-24 ST CUE input source.  

When using the console in this mode, Input A is routed into the channel ST 

CUE Via Input C. Inserts can be assigned to recording channel path (Input B) 

or to the Monitor return input path (Input A) via the IP C and INS buttons.  

The channel ST CUE Level and PANs now control the DAW Monitor Returns, 

and the channel faders and pan pots will control the recording inputs.   

The monitor returns and recording inputs can be monitored through the 

Stereo Mix bus at the same time by pressing the CUS BUS button above the 

Master Fader. The CUE Master pot will now be the main level control for the 

monitor returns and must be pressed and switched ON. 

If separate control or processing is required for the Recording or Monitor 

Return inputs; the monitor returns (Input A) can be routed through Group 

3+4 by pressing and holding each ST CUE pan pot, then pressing the channel 

GRP 3 or GRP 4 routing button. The CUE LED in-between group 3 and 4 

routing buttons will illuminate RED to indicate that the channel ST CUE is 

routed to the group rather than the channel. The GRP 3 + GRP 4 routing 

buttons themselves will also illuminate RED when pressed in this mode. 

Recording inputs (Input B) can then be routed to groups 1+2 by pressing the 

GRP 1 + GRP 2 buttons or into the Stereo Mix. Pressing GRP PAN will allow 

the channel and ST CUE pan pots to assign to the group routing. 

Global Cue to group routing can be activated from the services screen by 

selecting MAST>CUE GRP  
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 Parallel Processing                                                                                           1 

The 8424 has the capability of sending Input A (DAW interface Outputs 1-24) 

to two locations on the same channel strip. Both into the main channel input 

and into each channel CUE Input. This is the same function that enables In-

Line Mode (ILM).  

Since this function splits the DAW signal into each channel and sends it to 

both the Channel fader and to the CUE controls, this allows for parallel 

processing of mix signals by adding a hardware insert onto one of the signal 

paths Channel - INS or Cue - INS I/P C and leaving the other signal 

unprocessed. Both processed and unprocessed signals can be blended into 

the Stereo Mix bus independently.  

 

 

To enable this function- 

 Select channel Input A on the top of the channel strip via the A/B 

CH IP button. Alternatively, this can be globally selected by pressing 

the A/B CH IP button in the master section of the console. 

 Select Cue Input A for each channel by Pressing and holding the CUE 

PAN and then press the ST CUE controller twice. Alternatively, this 

can be globally selected by selecting ILM from 

Services>MASTER>ILM: [Y] 

The signal for each selected channel fader and CUE is now being fed 

from the same DAW interface output simultaneously. Depending on 

how you wish to process this, hardware inserts can be added to either 

the channel fader by pressing INS, or to the CUE controls by pressing INS 

and I/P C.  

The CUE signals for the selected channels can be blended into the Stereo 

Mix fader signal by pressing the CUE BUS button above the stereo 

master fader.  

Alternatively, the cue signals can be routed to the groups by pressing 

and holding the ST CUE Pan pot and then pressing GRP 3 or GRP 4 

button. Group 3+4 buttons will illuminate Red to indicate Cue to group 

routing.  

Unprocessed Channel and Processed Cue signals can now be blended 

together using both the channel faders and the ST CUE LEVEL controls 

for all 24 DAW returns. Cue to group routing can be used to parallel 

process large groups of DAW return signals by using the Group Insert 

points.   
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 Audio Interface Setup                                                                                     1 

Interface Type & Size Interface I/O Console I/O 

8 x I/O Audio Interface 
(Minimum I/O required) 

8 DAW Outputs 
8 MIX Inputs  

8 Channels - Input A  
2 Stereo MIX, 4 Group, 2 x 1073 

O/Ps 

16 x I/O Audio Interface 
(Capable of using most console 

features) 

16 DAW Outputs  
8 DAW MIX Inputs 

8 DAW Channel Inputs 

16 Channels - Input A 
2 Stereo Mix, 4 Group, 2 1073 

Outputs 
8 Channels - Direct Out 

32 x I/O Audio Interface 
(Recommended I/O to enable full 
console functionality and use of 

all features) 

32 DAW Outputs 
 

8 DAW MIX Inputs 
24 DAW Channel Inputs 

24 Channels - Input A 
8 Channels - Input C 

2 Stereo Mix, 4 Group, 2 1073 
Outputs 

24 Channels - Direct Out 

8x I/O Audio Interface                                                                                                                                                                       1 

An 8 in 8 out AD/DA audio interface will allow for 8 DAW Interface Outputs patched into 8 channel inputs via Input 

A, as well as 8 mix outputs from the console such as main Left and Right Stereo Mix, Group 1-4 outputs and 2x Direct 

Outputs either from the 1073 outputs or D.I channels 19-20 direct outputs. The remaining console channels can be 

used as recording inputs via Input B which can be mixed through the master section along with the DAW returns and 

recorded back into the DAW.  This simple setup will allow mixing of 8 mono or 4x stereo pairs of groups or individual 

DAW signals through the consoles master section and recorded back into the DAW from the Stereo mix bus or group 

outputs, benefiting from any channel inserts, 500 series or master section processing. The outputs from the 1073 

preamps or the DI channels can also be patched directly into the interface to be recorded by the DAW. 

16x I/O Audio Interface                                                                                                                                                                     1 

A 16 in 16 out AD/DA audio interface will allow for 16 DAW returns into 16 channel inputs via Input A, as well as 8 

mix outputs from the console such as main Left and Right Stereo Mix, Group 1-4 outputs and 2x direct outputs either 

from the 1073 outputs or D.I channels 19-20 direct outputs, plus 8x direct outputs from any selected channel. The 

remaining console channels can be used as recording inputs via Input B which can be mixed through the master 

section along with the DAW returns and recorded back into the DAW or sent as pre/post fader stems via the channel 

Direct Outputs.  This setup will allow mixing of up to 16 DAW channels along with any live instruments patched into 

the console via channel Input B through the consoles master section. The overdub inputs can be recorded into the 

DAW from the mix bus or group outputs, benefiting from any channel inserts, 500 series or master section 

processing. 8 stem tracks can also be sent directly from the Input B channels via the channel Direct Outputs. The 

outputs from the 1073 preamps or the D.I channels can also be patched directly into the interface to be recorded by 

the DAW. 

32x I/O Audio Interface                                                                                                                                                                     1 

A 32 in 32 out AD/DA audio interface allows for full functionality of the 8424 console. with this setup, 24 DAW 

returns can be patched into all channel inputs via Input A, and a further 8 can be patched into Input C. This enables 

simultaneous summing of up to 32 individual audio channels through the console using 48 MIX mode. (a 48-output 

interface is required to use all 48 summing inputs). The 8 mix outputs from the console such as main Left and Right 

Stereo Mix, Group 1-4 outputs and 2x direct outputs from the 1073 outputs can be patched into the interface. The 

direct outputs from the consoles full 24 channels can now be patched into the audio interface giving full functionality 

as an In-line mixing and recording console. This flexible setup allows every channel to be used as either Input A DAW 

returns or Input B recording inputs. Users can record, mix and overdub through any of the consoles 24 channels. A 

choice of mixing methods is now available, such as creating individual DAW stems from any of the consoles 24 

channels or using a multitude of mix bus paths to mix audio through the console surface and back into the DAW. 

Input C can be used to return additional DAW signals through the channel ST CUE bus.  
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 Firmware Updater App                                                                                   1  

The Neve Firmware Updater app is used to check your unit’s current 

firmware version and to perform firmware updates if required. The windows 

application is 32-bit software supported by windows 10. The Mac 64-bit 

software supports OSX Mojave & Catalina 10.14/10.15 only.  

Installation instructions                                                                                            1  

The Neve firmware update software can be found at www.neve.com,  8424 

product page, under ‘Support Docs’.  Run the installer package on your 

PC/Mac and follow the on-screen steps. Once installed, the computer is 

ready to be connected to your 8424 Console via ethernet.  

Physical Connection Instructions                                                                            1  

The console can be connected to the computer in one of two ways.  

 Making a direct Mac/PC>Ethernet cable>8424 console connection. 

When connecting this way, manual IP addresses must be assigned 

on both computer and 8424 console.  

 Connecting via a network switch. Mac/PC>Ethernet cable>Network 

Switch (the switch must also be connected to a valid network 

server)>8424 console. This method can use auto assigned DHCP IP 

addresses on both 8424 and computer. 

 

If using DHCP mode on a valid Network, skip the following manual IP 

address setup instructions. 

Manual IP address setup - Windows PC                                                                1   

 Open control panel>Network&Internet>Network and Sharing Centre 

 Click Change Adapter Settings 

 

 

 

 

 

 

 

 Highlight the Ethernet connection and click Properties 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.neve.com/
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 Click Internet Protocol version 4 (TCP/IPv4) 

 Click Properties  

 

 

 

 

 

 

 

 

 

 

 

 

 

 Click use the following IP address 

 Enter a manual IP address - 10.10.251.005 

 Enter Subnet Mask 255.0.0.0 

 Alternative address - 192.168.99.005 

 Alternative Subnet Mask 255.255.255.0 

 

 

 

 

 

 

 

Manual IP address setup Mac                                                                                 1   

 Open System Preferences  

 Click Network  

 

 

 

 

 

 Select the ethernet connection on the left  

 Click the Configure IPv4 dropdown box 

 Select Manually  

 Enter a manual IP address - 10.10.251.005 

 Enter Subnet Mask 255.0.0.0 

 Alternative address – 192.168.99.005 

 Alternative subnet Mask 255.255.255.0 

 

Once a manual IP address has been selected on the computer, the 8424 

manual IP address must be assigned within the same IP range 
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Manual IP address setup 8424 Console                                                                 1                                                                       

On the console services screen, select the SYSTEM> tab and navigate to 

NETWORK>SET IP. Follow the Instructions to enter a manual IP of- 

 10.10.251.004  

 Alternative address – 192.168.99.004 

 

Once the IP Address is entered, select YES and press the enter key. The 

console must now be power cycled to enter the manual IP address.  

 

Firmware Update Software                                                                                     1  

Once connected the software can scan for the connected 8424 and will 

prompt the user to begin firmware update if required.  

Mac OSX Notes                                                                                                           1 

For some Mac user accounts certain applications may be quarantined upon 

installation, this is a security setting on Apple’s operating system and if the 

Neve Updater app is quarantined it may not work correctly.  If when 

updating firmware, the message ‘Update Firmware File Missing’ appears 

please ensure that the Neve updater app is not quarantined and follow the 

steps below-  

 Open Terminal from - Applications/Utilities/Terminal 

 Enter the following command: xattr -d -r -s com.apple.quarantine 

"/Applications/Neve/" 

 Enter your user/admin password when prompted 

 Close Terminal window 

 

Performing a Firmware Update                                                                              1 

 Set the 8424 IP address via the services screen, instructions found 

on page 48 under System 

 If using an automatically assigned DHCP IP address - Connect the 

unit via the COMMS ethernet connection to your Network and 

connect the computer to the same network  

 If using a manually assigned address, connect the unit directly to the 

computer with a CAT5/CAT6 ethernet cable 

 Run the update software program 

 Click ‘scan network’  

 Discovered units will appear in the Neve Products dropdown box. 

 Product type, Name, IP address and Mac address will be displayed 

underneath 

 Select the unit to update from the drop-down menu  
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 Click Auto Update  

 

 

 The panels requiring firmware updates will appear on the app 

screen and the update process will begin. 

 

 

 

 

 

 

 

 

The software will update the firmware in three stages which is indicated on 

the progress bar.  

• 1st grey progress indicator is entering boot mode then another is 
shown to indicate erasing memory status. 

• 2nd blue indicates update progress.  

• 3rd grey indicates exiting program mode. 

• Lower thin grey progress indicator is overall progress. 

The 8424 front panel will enter boot mode when programming, please do not 
press any buttons on the unit during this process.   

 

Units can be renamed by clicking rename (Max 21 characters) 

 

 

To identify your hardware units, select the unit from the dropdown menu 

then click ‘Identify’. The 8424 consoles CTRL button will flash to identify the 

console.   

 

 

Advanced is reserved for the use of AMS Neve engineers when manually 

uploading firmware. 

It is not recommended for end-users to enter this mode.  

 

The About window displays the software system information and the 

available firmware versions.  
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 The 8424 App - Remote OPX Control                                                          1  

Introduction                                                                                                                1  

The 8424 app facilitates a software link between the 8424 console, DAW 

computer, and up to three 1073OPX units.  The app is run on your DAW 

computer which must be connected via ethernet to the same network as 

the 8424 and 1073OPX units. Once links are made, the 8424’s Trim encoders 

(set to FNC mode) can remotely control the Gains of the connected 

1073OPX(‘s). 

Installation instructions                                                                                            1  

The 8424 app is installed as part of the firmware updater package, follow 

steps at Firmware Installation instructions 

When installed, the application - Neve 8424 - will appear in the ‘Neve’ folder 

on your computer.  

Physical Connection Instructions                                                                            1  

There are two ways to connect the 1073OPX, 8424 console, and computer 

together. Both methods require the creation of a local area network (LAN). 

Ethernet connections from the 8424, OPX(‘s) and computer can link 

together by using an unmanaged network switch.  

Connection Diagram                                                                                                  1 
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IP Address Setup                                                                                                        1  

Once the physical connections are made, each connected unit (8424, OPX, 

and Computer) must be set on IP addresses within the same range.  

Automatic IP address setup (DHCP)                                                                       1 

If the LAN network is also connected to a valid DHCP server via the studio 

ethernet connection (red arrow in connection diagram) the 8424 console 

can be set to DHCP. This can be assigned on the 8424 console from the 

services screen under SYSTEM>DHCP: [Y/N] Once set, power cycle the 8424 

console to set the console as DHCP.  

The 1073OPX(’s) must also be set to DHCP, this is achieved by pressing and 

holding OPX gain 1+8 together, then selecting DHCP by pressing channel 1 

+48v.  

More information can be found on page 17 of the Neve 1073OPX user 

manual. 

The DAW computer IP address must also be set to automatic DHCP.  

Mac- open preferences>network settings and select the LAN Ethernet 

connection then choose DHCP.  

PC – Open Control Panel>Network and Internet>Network connections. Then 

right click the LAN ethernet connection, select internet Protocol Version 4 

(TCP/IPc4) and click Properties. In the general tab, select ‘Obtain an IP 

address automatically’.  

Manual IP Address Setup                                                                                         1 

When not connected to a valid DHCP server via the studio ethernet 

connection, manual IP addresses must be assigned on all LAN devices.  

Manual IP address setup - 8424 Console                                                              1                                                                       

On the console services screen, select the SYSTEM tab and navigate to SET 

IP. Follow the steps on page 48 to enter a manual IP of- 

 10.10.251.004  

 Alternative address – 192.168.99.004  

 

Once the IP Address is entered, select YES and press the enter key. The 

console must now be power cycled to enter the manual IP address.  

Manual IP address setup - DAW Computer                                                          1                                                                       

To set a manual IP address for your connected DAW computer See pages 63 

and 64 of this User Manual.  

Follow the steps on Manual IP address setup to enter a manual IP of- 

 10.10.251.005  

 Alternative address – 192.168.99.005  
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Manual IP address setup - 1073OPX(‘s)                                                                1                                                                       

To set a manual IP address for the connected 1073OPX’s see page 17 & 19 

of the 1073OPX User Manual.  

Follow the steps on page 17-19 to enter a manual IP for each OPX of- 

OPX 1 

 10.10.251.001  

 Alternative address – 192.168.99.001  

OPX 2 

 10.10.251.002  

 Alternative address – 192.168.99.002 

OPX 3 

 10.10.251.003  

 Alternative address – 192.168.99.003  

 

1073OPX console channel assignment                                                                  1 

Before assigning the 1073OPX, ensure that the latest firmware version is 

installed on the device using the Neve Updater App version 3 or higher.  

The 1073 OPX can be assigned to the console channels 1-8, 9-16 or 17-24. 

This is assigned from the IP Config menu on each 1073OPX device. To access 

IP Config more on the 1073OPX, press and hold gain pot 1 and 8 together.  

When in IP config mode, channels 1, 2, and 3 high pass filter buttons are 

used to assign the 1073OPX to the 8424 console channel banks  

 

HPF button 1 assigns the 1073OPX to console channels 1-8 

HPF button 2 assigns the 1073OPX to console channels 9-16 

HPF button 3 assigns the 1073OPX to console channels 17-24 

When pressed, the 1073OPX units gain display will show the 8424 channel 

assignments.  

 

 

 

 

 



                                                                                                                                           77 
 

 

8424 App OPX Gain Control                                                                                     1 

 

 

 

 

 

 

 

 

 

 

 

 

 

The 8424 app works by scanning your computer ethernet ports, finding 

connected 8424 and 1073OPX units, and facilitating a software link between 

the hardware devices. The top bar of the 8424 app contains the control 

buttons listed below.  

 

Scan & Link – Scans the LAN network for connected 8424 and 1073OPX 

devices. Once devices are found, they will appear in the dropdown menu. 

 

 

Devices can be renamed by selecting from the dropdown menu and clicking 

‘Rename’ (Max 21 characters) 

 

 

 

To identify your hardware units, select the unit from the dropdown menu 

then click ‘Identify’. A 1073OPX’s MONO button will flash to identify the 

unit. An 8424 consoles CTRL button will flash to identify the console.   
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When a 1073OPX unit is selected from the dropdown menu, the unit 

information will be displayed below.  

Type:  Product Name   

Name: Can be changed by the user via the rename feature  

IP:  Network address set from the front controls of the OPX  

MAC: Unique hard-coded identification of the hardware unit 

The OPX 8424 channel assignment is displayed at the bottom of the 

information box.  

 

 

Once your units are found by the 8424 app, clicking Start Control makes the 

final link between the 8424 and 1073OPX units.  

While OPX control is running, a grey progress bar will appear at the bottom 

of the screen and will remain in continual motion.  

 

 

FNC allows you to switch the selected console OPX control channels over to 

FNC mode automatically, this time saving feature allows instant control of 

the connected 1073OPX unit from the console FNC encoders.  

 

 

Auto Control is another time saving feature that allows for fast connection 

to OPX units. When activated, the next time you open the app, it will 

automatically begin control of the connected 1073OPX units after scan and 

link.  

Set IP allows you to speed up the scan and link process by focusing the scan 

onto only the IP addresses of the connected units. Clicking this window 

opens the below menu. In this menu you can enter the current IP addresses 

of your connected units.  
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If using DHCP, these IP addresses can be found when selecting the units 

from the main dropdown menu as shown below.  

 

Once the IP addresses are entered into this menu, Click the Use Manual IP 

addresses tick box.  

  

Once this process is complete, Scan & Link is achieved in less time.  

 

 

About displays firmware information for the updater app 

 

 

 

 

 

 

The 8424 app ‘Start Control’ feature needs to be activated and the app must 

remain running in the background of your DAW computer in order for the 

OPX(‘s) and 8424 to remain connected.  
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FNC Gain Control Operation                                                                                    1 

Once setup is complete and the 8424 Start Control feature is running, the 

console trim pots can be used to control connected 1073OPX gain levels.  

Each pot must be set to FNC mode. 

 

 

 

 

 

 

 

Moving the trim pot remotely adjusts the 1073 OPX gain level.  

 

Service Screen OPX Gain Display                                                                            1      

For additional accuracy, the service screen display is used to display remote 

1073OPX Gain levels.  

 

The 8424 channel number is displayed on the left of the screen in brackets - 

(01) The OPX parameter name (OPX Mic, Line or DI) is displayed the middle 

of the screen – OPX MIC. The OPX gain settings are displayed on the right of 

the screen - 70dB.  

 

To interrogate the current OPX gain setting without adjusting the level-  

 Press and hold the ST CUE PAN pot then press the Trim encoder.  

 

 

 

 

 

 

8424 console Channels 1-8  

+ 
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The 8424 App – Snapshot Backup                                                                 1  

Introduction                                                                                                                1 

The 8424 app version 3 and above includes the offline snapshot backup and 

restore feature. This feature allows users to save and load an infinite 

number of internal recall stores onto the DAW computer. These stores can 

be archived and renamed from within the 8424 app, stored alongside the 

DAW mix session and backed up onto external USB storage if required.  

Installation instructions                                                                                            1  

The 8424 app is installed as part of the firmware updater package, follow 

Installation instructions to install the software.  

Physical Connection Instructions                                                                            1  

The snapshot backup feature requires LAN or direct ethernet connection 

between the DAW computer and the 8424 console, in the same way as the 

8424>OPX link. Follow the steps on pages 69-71 to setup this connection.  

Scan & Link                                                                                                                  1 

Scan & Link must be performed in order for the 8424 and DAW computer to 

communicate. Once the process is complete, the 8424 Snapshot Backup tab 

window can be accessed.  

8424 Snapshot Backup Tab                                                                                      1  

To begin snapshot backup, first click Stop Control, Snapshot recall will not 

function while OPX control is running.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Snapshot window will be empty if this is the first time using the app.  

Open the Snapshot Backup Tab 

Select the 8424 from the Unit 

Dropdown list  
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Refresh                                                                                                                         1 

The Refresh button at the top of the Snapshot Backup tab searches the DAW 

computer documents folder for saved 8424 recall stores, if stores are found 

in the correct archive, the snapshot window will be repopulated.  

 

Saving an Offline Store                                                                                             1 

The 8424 app Snapshot Backup option works by scanning the console’s 

internal memory of 99 stores, providing an offline storage system to backup 

these stores into the DAW computer.  

Backup                                                                                                                          1 

Backup is non-destructive. This option simply backs up the selected store 

from the 8424 internal store memory onto the DAW computer.  

Choose one of the 99 stores you wish to back up to the DAW computer by 

using the up and down arrows.  

 

 

 

Press Backup to save the selected store onto the DAW computer through 

the 8424 App.  

 

 

 

The Enter Snapshot Name pop out window will appear.  

 

 

 

 The default naming convention is as follows 

8424_Console_MAC_04916229E0B1_StoreNo1_15062021_114959  

• 8424_Console: Name of console 

• MAC_04916229E0B1: MAC address to distinguish stores from 
different desks  

• StoreNo1: The selected 8424 internal store (1 of 99)  

• 15062021: Date snapshot was backed up (15/06/2021)  

• 114959: Time snapshot was backed up (11:49, 50 secs) 
Snapshot names can be changed from the Enter Snapshot Name window 
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Once entered, the snapshot will appear in the 8424 snapshot Backup 

window  

 

Backup All Stores                                                                                                        1 

Backup All Stores scans the consoles internal 99 stores and saves all of them 

into the DAW computer archive in one go. This feature is ideal when using 

the 8424 app for the first time after upgrading your console.  

Press Backup All Stores to save all 99 internal stores into the DAW computer 

through the 8424 app.  

 

 

 

Once the process is complete, the consoles stores will be saved to a 

subdirectory within the 8424 snapshots folder which can be accessed via the 

8424 app 

 

Save & Backup                                                                                                            1 

Save & Backup is destructive. This option saves the consoles current state to 

both an internal 8424 store location (1-99) and to the DAW computer via the 

8424 Snapshot backup app at the same time.  

Press Save & Backup to Save the console’s current state to the chosen store 

location and back up to the DAW computer at the same time  

 

When saving using Save & Backup, the console’s current state will 

overwrite the selected store number (1-99) in the console’s internal 

memory 

 

 

 

 

Pressing Save & Backup triggers the 8424’s internal save system  
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Once pressed, a 5 second countdown will begin while the console panels 

are preparing to save settings.  

 

This store is now saved on the console’s internal memory, and backed up 

to the DAW computer via the 8424 app.  

 

 

 

Restore                                                                                                                         1  

The restore function is destructive. This option copies the currently selected 

8424 Snapshot backup store onto the selected store location (1-99) within 

the console’s internal memory.  

Highlight the offline store you would like to restore from the 8424 snapshot 

window  

 

Choose one of the 99 stores you wish to restore the offline snapshot to 

using the up and down arrows.  

 

 

Press Restore to save the offline snapshot onto the consoles internal 

memory  

 

Restore will overwrite the selected store number (1-99) in the console’s 

internal memory 
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Load OPX Store                                                                                                           1 

The 8424 App version 4.3 and above includes a powerful OPX snapshot 

linking feature. If OPX units are linked to the console via the scan & Link 

feature, their settings are included in the 8424 snapshot store file. When 

loading a store containing OPX snapshot data, a pop out window will open 

to ask the user if they wish to also load the OPX snapshot data. 

 

 

 

 

When the snapshot loads, the OPX(s) settings will be loaded simultaneously.  

 

Restore & Load                                                                                                           1 

Restore & Load is destructive. This option restores the selected offline store 

onto the console’s internal memory and loads the snapshot at the same 

time.   

Highlight the offline store you would like to restore & load from the 8424 

snapshot window  

 

Press Restore & Load to restore the highlighted offline store to the console’s 

internal memory   

 

When saving using Restore & Load, the selected offline store will overwrite 

the selected store number (1-99) in the console’s internal memory 

 

 

 

 

Tick the boxes to include OPX units in 

the loading process 

Click X to continue the 

loading process 
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Pressing Restore & Load triggers the 8424’s internal load system  

Once pressed, a 5 second countdown will begin while the console panels 

are preparing to load settings.  

 

This offline store is now loaded on the console’s internal memory 

 

 

 

Additional Archiving Options                                                                                  1 

Right(ctrl) + click the snapshot to open additional archiving options  

 

 

 

Rename – renames the snapshot 

 

 

 

Delete – Deletes the snapshot from the Snapshot folder 

 

 

 

Open Snapshots Folder – Opens default snapshot storage location  

 

The default folder is located in Documents>Neve>8424>Snapshots 

Stores can be moved or copied to the DAW session folder from the PC/Mac 

menus for further backup.   
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Motorized Faders                                                                                              1  

Introduction                                                                                                                1  

The upgraded motorized faders the 8424 console differ in appearance to the 

faders previously mentioned in this User Manual. This section details the 

mechanical differences between manual and motorized faders. Further 

information on DAW control and fader functionality can be found at DAW 

Control Setup 

Digital Scribble Strip Display                                                                                    1 

Motorized faders have the addition of the digital scribble strip. This display’s 

main function is to show multiple layers of DAW information. In its default 

state the faders are in analogue mode and the scribble strip will show the 

analogue channel number (1-24).   

Additional Keys                                                                                                           1 

The SEL and REC keys are reserved for DAW control, their functionality 

depends on the current DAW in use.  

Further information can be found at - Pro Tools DAW Controller Operation,  

Logic DAW Controller Operation & Cubase/Nuendo DAW Controller 

Operation 

Fader Level Parking                                                                                                    1 

When flipping the faders into DAW MODE, the analogue positions of the 

faders must be ‘parked’ so that the analogue audio level is retained while 

using console faders to mix In-The-Box. This is achieved by using MDAC 

technology. Channel 1-24 MDAC’s are used to read the current fader output 

level and store it the when the fader is in DAW MODE. This output level is 

then restored when exiting DAW MODE by moving the fader accurately to 

its previously stored position.  

Fader & MDAC Calibration                                                                                       1 

Just underneath the SEL and REC keys are two calibration points used to 

calibrate the fader analogue output level when in analogue mode or when in 

DAW mode. These levels are carefully calibrated in the factory by Neve 

engineers and will not need to be altered.  

Warning! Do not attempt to calibrate the 8424 fader & MDAC 

yourself! 

If you suspect that your fader levels require calibration, please 

contact www.AMS-Neve.com/support 

 

 

 

 

 

 

http://www.ams-neve.com/support
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Motorized Master Fader                                                                                           1 

The 8424 Master fader includes a BYPASS LED. This LED is activated when 

the master fader is at the zero position.  

This function bypasses the stereo MDAC when the master fader level is at 

zero, ensuring that the pure analogue signal path is maintained while mixing 

through the stereo mix bus.  

 

Zero Faders                                                                                                                  1 

Motorized channel faders 1-24 can be automatically set to Zero via the 

services screen option MAST>ZERO FADERS This function is useful for 

quickly returning fader levels to their zero position mid-session without 

affecting console routing etc.    

To reset all 24 channel fader positions to zero-  

 Select [ZERO FADERS] from the services screen 

 Press CTRL + ENTER  

All 24 channel faders will immediately move from their current positions to 

the current zero position. 

 

 

 

 

Current ZERO FADER Position 
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Set Zero                                                                                                                        1 

Although each console has its zero-fader position set in the factory by the 

Neve engineers, a services screen option is included should users need to 

alter the stored zero position of the faders themselves.  

This option is included in the services screen under MAST>SET ZERO   

To set the zero position of the faders-  

 Manually move each channel fader to its zero position 

 Select [SET ZERO] in the Services screen  

 Press CTRL + ENTER 

 

This new zero position is the place faders will jump to when ZERO FADERS is 

next pressed. Note that the position can be anywhere in the fader range, not 

just at the zero position.  

 

 

 

 

 

 

New ZERO FADER position 
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DAW Control Setup                                                                                          1  

Introduction                                                                                                                1  

The 8424 Motorised fader option allows the 8424 console to perform as a 

DAW controller for multiple workstations at the push of a button. This 

section of the user manual will detail setup and operational instructions for 

using the 8424 console with multiple DAW’s.  

Physical Connection Instructions                                                                            1  

The DAW control required a physical ethernet connection between the 

consoles ethernet port and the DAW computer.  

There are two ways to connect the 8424 console and computer for DAW 

communication. All connections must be made using CAT5e/CAT6 cables 

(non-crossover)  

Direct Connection                                                                                                      1  

A direct connection can be made from the computer ethernet port to the 

8424’s rear mounted ethernet port.  

 

 

 

 

 

 

 

This method is ideal for small setups that do not require remote comms 

connection to OPX units.  

Connecting Directly requires manual IP assignment on both the 8424 

console and the connected DAW computer.  

Manual IP address setup - 8424 Console                                                              1                                                                       

On the console services screen, select the SYSTEM tab and navigate to SET 

IP. Follow the steps at Manual IP address setup to enter a manual IP of- 

 10.10.251.004  

 Alternative address – 192.168.99.004  

 

Once the IP Address is entered, select YES and press the enter key. The 

console must now be power cycled to enter the manual IP address. 

 

 

DAW  
Computer 

8424   

Ethernet Port   
 

CAT5e/CAT6  
Direct Connection 
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Manual IP address setup - DAW Computer                                                          1                                                                       

To set a manual IP address for your connected DAW computer See Manual 

IP address setup   

Enter a manual IP of- 

 10.10.251.005  

 Alternative address – 192.168.99.005  

 

DHCP Connection                                                                                                       1  

The 8424 can connect to the DAW computer through a network switch using 

the studios wired internet connection.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

By connecting this way, both the DAW computer and the 8424 console can 

be set to automatic DHCP IP assignment - see page 70 for 8424 DHCP 

assignment instructions.  

The connection to optional 1073OPX units can also make use of this LAN 

connection – See Remote OPX Control for more information. 

It is recommended while using a DHCP connection, to set Manual IP 

addresses for all devices on the LAN network to ensure a stable & 

continuous connection. 

 

Studio Ethernet connection 
for DHCP IP assignment 

DAW  
Computer 
Ethernet 

connection 

8424   
Ethernet  

connection 

(  Port) 
 

Network  
Switch  

Optional 1073OPX 
Ethernet 

connection 
(COMMS PORT) 
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IP Midi                                                                                                                          1 

Once the physical connection is made, the third-party software program IP 

MIDI must be installed and run on the DAW computer.  

IP MIDI can be downloaded from www.nerds.de 

The software has a free 60 min trial version is available, after the trial 

expires, the software is $79 for perpetual use.  

ipMIDI Prices may differ on the nerdz.de webpage 

Mac Instructions                                                                                                        1 

ipMIDI is a native Mac driver, once installed it can be accessed and 

configured from Apple’s Audio Midi Setup menu. 

ipMIDI is accessed via Applications>Utilities>Audio MIDI Setup  

Once opened, use the top toolbar to click Window>Show MIDI Studio 

 

 

 

 

 

 

 

 

When the MIDI Studio window appears, click the ipMIDI icon.  

 

 

 

 

 

 

 

 

 

 

 

The ipMIDI Setup window will appear.  

Use the arrows to set Number of Ports to 20  

Ensure that the Loop Back box is Not Ticked  

http://www.nerds.de/
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Mac Script information                                                                                             1  

Mac multicast default network behaviour sends all data to all available 

ports, this behaviour can cause conflict between ipMIDI and regular internet 

traffic.  

To alter this default Mac behaviour a command must be entered in the 

Terminal Utility found at - Applications>Utilities>Terminal  

This section assumes that the IP settings on both Mac and 8424 are set as per 

Manual IP address setup at fixed IP addresses of 10.10.251.004 (8424 

console) and 10.10.251.005 (DAW computer), with the subnet mask set at 

255.255.255.0  

The quick-fix for this issue is to enter the following command into Terminal-  

sudo route -n add -net 225.0.0 -interface 10.10.251.005 
 

This will work for your current session and your computer Wi-Fi can be 

enabled while using HUI data. However, once you shut down your computer, 

depending on your Mac settings, you may have to enter this command once 

again.  

Further information can be found at Appendix A – ipMIDI Information 

Once this step is complete, internet traffic will be directed away from the 

ipMIDI ethernet port, enabling stable communication between the DAW and 

the Console.  

Windows Instructions                                                                                               1 

ipMIDI is installed by default to the PC C: drive and can be accessed from the 

PC’s Start menu>Programs>ipMIDI Monitor  

Open the program to view the ipMIDI monitor application.  

 

 

 

 

 

 

 

 

Use the arrows to select Ports after Reboot: 20  

(you may need administrator privileges to do this) 

Ensure that all of the Mute Ports boxes are Unticked  

Ensure that the Loop Back box is Not Ticked  
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DAW Setup                                                                                                                  1 

The 8424 console uses an embedded system to code the ipMIDI ports to the 

console fader buckets. Each DAW will use three ports across buckets 1-8, 9-

16, and 17-24. The group and maser faders are not currently implemented 

for DAW control.   

 

 

 

 

The Function keys F1, F2, and F3 are hard coded to three different DAWs, 

switching between DAWs is as simple as pushing a button. Each DAW uses 

specific ipMIDI ports.  

F1 - Hard coded for Pro Tools HUI DAW control - ports 1, 2, 3 

F2 – Hard coded for Logic DAW control - ports 4, 5, 6 

F3 – Hard coded for Cubase/Nuendo DAW control -ports 5, 6, 7 

 

DAW Fader Selection                                                                                                1 

By default, the 8424 console DAW MODE function button, flips all 24 

console faders over to DAW controllers. Leaving the analogue layer of the 

console ‘parked’ until DAW MODE is pressed again.  

The 8424 has a unique feature allowing users to select which console faders 

to use as DAW faders in groups of 8. The DAW faders can make up 24, 16, or 

just 8 faders depending on the user requirements.  

Channels 1-24                                                                                                             1  

To enable this feature, firstly ensure that the console is not in DAW MODE, 

then press the SHIFT Key. Once pressed, the F keys will illuminate, showing 

which sections of the console are being used as DAW faders.  

By default, F1, F2, and F3 will be illuminated. When DAW MODE is pressed 

and illuminated, all 24 console channel faders will work as DAW faders.  

 

 

Multiple combinations of DAW fader banks can be active at any time 

depending on your console requirements. One fader bank must always be 

active, it is not possible to deselect all F keys.  

DAW Faders 1-8 DAW Faders 9-16 DAW Faders 17-24 
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Channels 1-8                                                                                                                1  

To configure DAW mode for the first fader bank 1-8, press shift, and 

deselect the F2 and F3 keys until only the F1 key is illuminated.  

In this configuration, when DAW MODE is pressed, only channels 1-8 will 

function as DAW faders. Channels 9-16 and 17-24 will remain in analogue 

fader mode.  

 

Channels 9-16                                                                                                             1  

To configure DAW mode for the second fader bank 9-16, press shift, and 

deselect the F1 and F3 keys until only the F2 key is illuminated 

In this configuration, when DAW MODE is pressed, only channels 9-16 will 

function as DAW faders. Channels 1-8 and 17-24 will remain in analogue 

fader mode. 

 

Channels 17-24                                                                                                           1  

To configure DAW mode for the third fader bank 17-24, press shift, and 

deselect the F1 and F2 keys until only the F3 key is illuminated 

In this configuration, when DAW MODE is pressed, only channels 17-24 will 

function as DAW faders. Channels 1-8 and 9-16 will remain in analogue 

fader mode. 

 

DAW Faders 1-8 

DAW Faders 9-16 

DAW Faders 17-24 
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Pro Tools DAW Control Setup                                                                        1  

Introduction                                                                                                                1  

The 8424 Motorized faders work with Pro Tools as a HUI device, sending and 

receiving MIDI data via ipMIDI over ethernet connection.  

Pro Tools HUI Setup                                                                                                 1  

First ensure that ipMIDI is installed and configured correctly on your Mac/PC 

by following the steps on page 77-78.  

To configure Pro Tools to send and receive HUI navigate to 

Setup>Peripherals>Midi Controllers  

There are four available HUI ports in Pro Tools, each port controls 8 console 

faders. To setup all 24 faders as HUI Setup as follows  

  Type Receive From Send To # Ch’s 

 #1 HUI ipMIDI, Port 1 ipMIDI, Port 1 8 

 #2 HUI ipMIDI, Port 2 ipMIDI, Port 2 8 

 #3 HUI ipMIDI, Port 3 ipMIDI, Port 3 8 

 #4 None    

                    

 

 

 

 

 

 

 

 

 

 

Once the ports are set, press OK to exit the peripherals window.  

If using only one or two 8424 console fader banks for DAW control, the Pro 

Tools peripherals screen must be configured accordingly to match the 8424 

consoles selected DAW fader bank.  The first HUI port in Pro Tools must 

match with the first fader bank selected on the 8424 console.    

 
ipMIDI Port 1 ipMIDI Port 2 ipMIDI Port 3 
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Example 1 - DAW Faders 1-16                                                                                 1 

In this example, only faders 1-16 are set as DAW faders, fader bank 17-24 is 

excluded from DAW MODE.  

The faders have been setup using the SHIFT + F keys (See page 79-80) so 

that faders 1-8 and 9-16 are included in DAW Mode. Faders 17-24 are 

excluded and remain in analogue mode when DAW MODE is active.  

 

 

 

 

Since this setup uses faders 1-8 and 9-16 as the first HUI ports, the 

peripherals screen must be set as below to exclude faders 17-18. 

 Type Receive From Send To # Ch’s 

#1 HUI ipMIDI, Port 1 ipMIDI, Port 1 8 

#2 HUI ipMIDI, Port 2 ipMIDI, Port 2 8 

#3 None    

#4 None    

 

 

 

 

 

 

 

 

 

DAW Faders 1-8 

ipMIDI Port 1 

 

 

DAW Faders 1-8 

ipMIDI Port 2 

 

 

8424 Faders 17-24 

Excluded from DAW Mode 

 

 

F1 & F2 Active  

F3 Excluded  
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Example 2 - DAW Faders 17-24                                                                               1 

In this example, only faders 17-24 are set as DAW faders, fader banks 1-8 

and 9-16 are excluded from DAW MODE.  

The faders have been setup using the SHIFT + F keys (See page 79-80) so 

that faders 17-24 are included in DAW Mode. Fader banks 1-8 and 9-16 are 

excluded and remain in analogue mode when DAW MODE is active. 

 

 

 

Since this setup uses faders 17-24 as the only DAW port, the Pro Tools 

Peripherals screen must be configured to reflect this. The first HUI port (#1) 

Must be set to send/receive from ipMIDI port 3 (DAW Faders 17-24)  

The remaining HUI ports can be left empty, excluding faders 1-8 and 9-16 

from DAW control.     

 Type Receive From Send To # Ch’s 

#1 HUI ipMIDI, Port 3 ipMIDI, Port 3 8 

#2 None    

#3 None    

#4 None    

 

 

 

 

 

 

 

 

 

DAW Faders 17-24 

ipMIDI Port 3 

 

 

8424 Faders 1-16 

Excluded from DAW Mode 

 

 

F3 Active  

F1 & F2 Excluded  
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Pro Tools DAW Controller Operation                                                           1  

Pro Tools DAW Operation                                                                                        1 

When DAW MODE is active, the console faders will flip into DAW mode and 

the faders will move to the DAW fader positions. The channel scribble strips 

will also change to display the DAW track name, abbreviated to four 

characters. 

Channel Strip Functions                                                                                            1 

The 8424 SOLO and CUT buttons now function as Pro Tools Solo and Cut, 

following settings selected within Pro Tools such as solo safe, solo link, and 

group settings.  

 

 

 

SEL - The select button has multiple functions depending on which key 

modifier is pressed in the centre section.  

Its default function is to highlight and select the particular DAW channel 

within Pro Tools.  When highlighted, the SEL button will also illuminate.  

 

 

 

Double tap SEL to quickly open up the Pro Tools Track renaming window.  

 

 

 

 

 

 

 

 

REC - The record button is used to record arm tracks in Pro Tools.  

 

  

 

The 8424 motorised faders are touch sensitive. When a touch is registered, 

the scribble strip display name will brighten.  
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Transport Control Keys                                                                                             1 

The transport control keys located in the centre of the console enable 

control of the Pro Tools transport bar.  

 

 

 

 

Several keys have a dual function activated by pressing and holding the 

SHIFT key before pressing.  

 

 

REW – Rewind 

Rewinds the session from the current playback cursor position  

 

 

RTZ – Return  

to Zero  

Sets the playback cursor to the beginning of the session  

 

 

FFW – Fast 

Forward  

Fast-forwards the session from the current playback cursor position 

 

 

END – Go to 

End  

Sets the playback cursor to the end of the session 

 

 

STOP  

 

Stops playback or recording  

 

+ 

+ 



                                                                                                                                           101 
 

 

 

Session/Setup 

Shortcut  

 

 

 

 

Shortcut to open the Pro Tool Session Setup window 

 

PLAY  

 

Begins playback from the current cursor position 

 

 

Transport  

Window 

Shortcut 

 

Opens the Pro Tools Transport window 

 

 

REC – Record 

Arms Pro Tools for recording  

 

 

QP – Quick 

punch  

 

Toggles Quickpunch recording mode in the Pro Tools Transport window 

 

 

LOOP – Loop 

record  

Toggles loop playback mode in the Pro Tools Transport window 

 

+ 

+ 

+ 
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Marker Keys                                                                                                                1 

The Marker keys located underneath the Transport Control keys in the 

centre section of the console are used to set and navigate to marker points 

on the Pro Tools timeline.  

 

 

The Left marker key (<) navigates to the marker to the left of the current 

playback cursor position on the Pro Tools timeline.  

In the example below, pressing < will move the playback cursor from its 

current position (Marker Location 4) to Marker Location 3 

 

 

 

 

 

 

 

 

The modifier SHIFT key can be pressed at the same time as the < key to 

navigate the playback cursor to the first Marker in the session. In this case 

Location 1.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

+ 
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The Right marker key (>) navigates to the marker to the right of the current 

playback cursor position on the Pro Tools timeline.  

In the example below, pressing > will move the playback cursor from its 

current position (Marker Location 1) to Marker Location 2 

 

 

 

 

 

 

 

 

The modifier SHIFT key can be pressed at the same time as the > key to 

navigate the playback cursor up by ten marker locations. In this case from 

Location 1 to Location 10 

 

 

 

 

 

 

 

When navigating between marker locations, the Services screen will 

momentarily change to display the current selected marker location 

number.  

 

 

 

 

 

 

 

 

 

+ 
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The MARKER MODE key is used to add new markers to the Pro Tools 

timeline.  

Pressing this key once opens the New Memory location window within Pro 

Tools.  

 

 

 

 

 

 

 

 

 

 

 

 

From this window, users can name marker locations and configure their 

properties.  

Pressing MARKER MODE again exits this window and adds the marker 

location to the session.   

 

 

 

Pressing SHIFT + MARKER MODE Opens the Memory Locations window 

within Pro Tools.  

 

 

 

 

 

 

 

Note: Certain Pro Tools 2020 versions contain a bug that has disabled HUI 

Marker Mode, Avid are aware of this and will be issuing a fix. Pro Tools 10 

versions and below do not contain this bug. 

 

+ 
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Functions/Utilities                                                                                                     1 

The Function/Utility keys are used to access multiple DAW functions.  

 

Mix/Edit Window Toggle                                                                                          1  

SHIFT + AUD toggles between the Mix and Edit windows in Pro Tools.  

 

Audition keys                                                                                                              1 

The AUD (Audition) switch is used in conjunction with PRE/IN/OUT/POST 

switches to play sections of the currently selected audio. Playback continues 

until AUD is pressed again, or until another transport button is pressed.  

 

Audition Pre-roll - Plays the audio starting from the pre-roll up to the 

beginning of the edit selection. 

 

Audition Post-roll - Plays the audio starting at the end of the edit selection 

lasting the length of the selected post-roll amount. 

     

Audition In - Plays the audio starting at the beginning of the edit selection 

and lasting the length of the post-roll amount. 

 

Audition Out - Plays the audio starting before the edit selection end point 

for the length set by the pre-roll amount. 

 

Pre/Post Standalone Functions                                                                               1 

Pre-Roll - Toggles pre-roll activation/deactivation in the Pro Tools Transport 

window. 

 

 

 

Post-Roll - Toggles post-roll activation/deactivation in the Pro Tools 

Transport window. 

 

 

+ 

+ 

+ 

+ 

+ 



                                                                                                                                           106 
 

 

IN/OUT Standalone Functions                                                                                 1  

Edit selection IN point - During playback, IN can be pressed to select the 

starting point of an edit selection.  

The playback cursor will continue to move through the session, and the edit 

selection will be set at the last point when the IN button was pressed.  

 

 

 

 

 

 

 

 

 

 

 

Edit Selection OUT point - During playback, the OUT button can be pressed 

to select the end of the edit selection.  

The playback cursor will continue to move through the session and the edit 

selection will be set at the last point when the OUT button was pressed. 

 

 

 

 

 

 

 

 

 

 

By using the IN and OUT buttons, users can quickly make edit selections 

along the timeline, adding edit points during playback without pausing 

session audio.  

 

 

 

Playback Cursor  Edit selection Start 

point (IN Pressed) 

Edit selection Start 

point (IN Pressed) 
Playback Cursor  

Edit selection End 

point (OUT Pressed) 
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Online                                                                                                                           1 

The ONLINE button activates the Pro Tools transport Online button. This is 

used to activate Pro Tools external synchronisation to MTC/LTC. The button 

will flash green when online is active, this is matched by the Pro Tools 

Transport Online button flashing.  

 

 

Suspend                                                                                                                        1 

Pressing SHIFT + ONLINE together activates Automation SUSPEND. This 

globally suspends all active automation in the current session during 

recording and playback. The SUSPEND button will flash red when 

automation is suspended.  

When SUSPEND is active, all Pro Tools track automation buttons will be 

greyed out but will keep their Read, Write, Touch, Latch, Off status intact.  

 

 

To suspend automation, the Pro Tools transport must be stopped.  

Session automation can be activated again by pressing SHIFT + ONLINE 

together. 

Automation                                                                                                                 1 

The AUTOMATION button is used as a modifier key in conjunction with 

channel SEL buttons.  

 

 

When AUTOMATION is pressed and illuminated Green, the DAW channel 

SEL button can be pressed to toggle through the available Pro Tools 

automation modes for that channel.  

 

Each press of SEL toggles one option at a time on the selected channel 

through Pro Tools off, read, touch, latch, and write automation modes.  

 

 

 

 

To globally toggle automation modes for all Pro Tools channels, press and 

hold the keyboard ALT/Option button then follow the steps above.  

 

 

+ 

+ 
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Inactive Function/Utility Keys                                                                                 1 

The 8424 console is setup to work with multiple DAW’s, using both HUI and 

MCU protocol. This setup leaves certain switches redundant for HUI/Pro 

Tools operation. The PUNCH and FLIP buttons are inactive during Pro Tools 

operation.  

 

Active Faders                                                                                                               1 

The ACTIVE FADERS button is used to automate the consoles analogue 

faders from within Pro Tools. See Active Faders for further information.  

 

 

 

Fader Banking                                                                                                             1 

The four buttons labelled BANK </> and CHANNEL </> are used to bank and 

scroll through pro tools channels.  Banking and scrolling behaviour is 

mirrored in Pro Tools.  

 

 

In the image below, Pro Tools 

channels 1-24 are in focus on the 8424 channel faders. Each controller bank 

is represented by a colour around the track name.  

 

 

 

 

Blue – Bank 1  

Channels 1-8 

Yellow – Bank 2               

Channels 9-16 

Purple – Bank 3              

Channels 17-24 
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Fader bank colours are also displayed in the Pro Tools Peripherals window.  

 

 

 

 

 

 

Bank < >                                                                                                                        1 

The fader bank keys (</>) shift focus of the 8424 faders onto the next 

channel ‘Bank’ within the DAW session.  

Each Bank is as large as the controller setup. If the 8424 is set to use all 

three Pro Tools Peripheral HUI banks, pressing BANK > will move the fader 

focus along to the next 24 DAW channels.   

In the image below, the fader focus has shifted by 24 channels to channels 

25-48.  

 

The Pro Tools Mix and Edit windows will follow this bank selection, provided 

that ‘Mix window Follows Bank Selection’ and ‘Edit Window Follows Bank 

Selection’ are ticked in the Pro Tools Preferences window. 

(Setup>Preferences>Mixing>Controllers) 
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Channel < >                                                                                                                  1 

The channel bank keys (</>) keys move the DAW fader focus along by one 

fader at a time either to the left or the right of the session mix/Edit window.  

In the image below, channels 1-24 are in focus.  

 

 

In the image below, CHANNEL > has been pressed once, banking the 8424 

24 faders across by one channel. Now, channels 2-25 are in focus.  

 

Pro Tools Channels 2-25 

Pro Tools Channels 1-24 
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Pressing Channel > will continue to scroll the fader focus onto the next 

channel to the right within the Pro Tools Mix or channel down in the Edit 

window.  

Pressing Channel < will scroll the fader focus onto the previous channel to 

the left within the Pro Tools Mix window or next channel up in the Edit 

window.  
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Assignment Keys                                                                                                        1 

The VPOT assignment keys are used to assign the consoles VPOTs to various 

DAW parameters including DAW pans, Aux sends and Plugins.  

 

Pro Tools Pan Control                                                                                                1 

To control Pro Tools Pans, press the PAN button, this assigns the console 24 

VPOTs to work as rotary pan controllers within Pro Tools.  

When PAN is lit, pan mode is effectively in standby until U1 is pressed  

To assign console VPOTs to control Pro Tools Pan controls – press the U1 

button  

 

 

All 24 consoles VPOTs can be used as PAN controllers for the 24 channels 

within the Pro Tools session. VPOTS follow the fader bank selection. 
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Mono Channel Panning                                                                                            1 

When PAN and U1 are lit and active, the channel TRIM VPOT will now work 

as an encoder for Pro tools Pans.  

The LED indicator on the Trim VPOT matches the current position of DAW 

channel pans.  

 

 

 

 

To Pan left - turn the VPOT Encoder counter-clockwise  

 

 

 

 

 

 

To Pan right - turn the VPOT encoder clockwise 
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Stereo Channel Panning                                                                                           1 

To pan stereo channels the 8424 PAN button is dual function, allowing for 

left pan and right pan to be adjusted independently.  

 

 

When the PAN button is illuminated solid, LEFT VPOT pan is active  

 

 

 

 

 

 

When the PAN button is flashing, RIGHT VPOT Pan is active 

 

 

 

VPOT Fine/Course Adjustment                                                                               1 

By default, Pan VPOT adjustment is set to fine increments, to increase the 

encoder speed to course adjustment (x5 speed) press and hold SHIFT while 

moving the VPOT encoder.  

Note: In firmware versions 7.10+, Shift + VPOT motion functionality has 

flipped.  

When running firmware 7.10 and above, the default Pan VPOT adjustment is 

set to coarse increments (x5 speed) and fine increments are adjusted by 

pressing SHIFT + VPOT 

 

 

+ 

TIP: 

Firmware version 7.10+ flips SHIFT + VPOT functionality.  

The default VPOT motion is set to coarse increments (x5 speed) 

Fine increments are adjusted via SHIFT +VPOT motion  

Visit www.ams-neve.com/consoles/small-format-consoles/neve-

8424/#Moreinfo to download the latest firmware and see 

Firmware Updater app for installation instructions.  

http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo
http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo
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Pro Tools Send Control                                                                                             1 

To control Pro Tools Sends, press the AUX/SEND button, this assigns the 

consoles 24 VPOTs to work as rotary controllers for Pro Tools Sends.  

When AUX/SEND is lit, Aux Send mode is effectively in standby  

To Assign VPOTs to Pro Tools pan control – press the U1 button.  

 

All 24 consoles VPOTs can be used as send controllers for 24 channels within 

the Pro Tools session. VPOTS follow the fader bank selection  
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HOLD 

HOLD 

HOLD 

HOLD 

HOLD 

Configuring Pro Tools Sends.                                                                                   1 

When AUX/SEND and U1 are lit and active, the channel TRIM VPOT will now 

work as an encoder for Pro tools SENDS A to E.  

The selected send is displayed on the channel scribble strip in (brackets) 

next to the Pro Tools channel name.  

Sends (a) through (e) are available to control using the channel VPOTs  

Selecting Sends                                                                                                           1 

To toggle through sends a, b, c, d, and e, press and hold SHIFT, then press 

AUX/SEND  

 

Pressing and holding the AUX/SEND button flips the 8424 scribble strips 

over from displaying the Pro Tools channel name to now display the send 

destination.  

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

+ 

To display the Send 

Level within the Pro 

Tools mix window 

Press and hold 

Control/Command 

then click the send 

icon 

 

Send A 

Send B 

B  

Send C 

Send D 

Send E 
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Adjusting Send Levels                                                                                                1 

Once the selected send is chosen, the VPOTS can be used to make 

adjustments to the Pro Tools Send level 

The LED indicator on the Trim VPOT matches the current position of DAW 

channel sends.  

 

 

 

 

 

 

Turn the encoder clockwise to increase the send level  

 

 

 

 

 

 

 

Turn the encoder counter-clockwise to decrease the send level  

 

 

 

 

 

VPOT Fine/Course Adjustment                                                                               1 

As with Pans, by default, SEND VPOT adjustment is set to fine increments, to 

increase the encoder speed to course adjustment (x5 speed) press and hold 

SHIFT while moving the VPOT encoder.  + 
TIP: 

Firmware version 7.10+ flips SHIFT + VPOT functionality.  

The default VPOT motion is set to coarse increments (x5 speed) 

Fine increments are adjusted via SHIFT +VPOT motion  

Visit www.ams-neve.com/consoles/small-format-consoles/neve-

8424/#Moreinfo to download the latest firmware and see 

Firmware Updater app for installation instructions.  

http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo
http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo
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Send Pre/Post Toggle                                                                                                1 

In addition to controlling send levels using the 8424 VPOTs, each send 

pre/post fader button can be activated or deactivated in two unique ways 

depending on style of workflow.  

 

 

 

To toggle the send Pre/Post fade state press SHIFT + SEL on the selected 

channel.  

 

 

 

 

 

Alternatively press and hold the selected channel ST CUE PAN, then press 

the selected channel VPOT  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

+ 

+ 
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Pro Tools Plugin Control                                                                                           1 

Pro Tools plugin parameters can be controlled from the 8424 console 

VPOTs. Plugin control works differently to send and pan control. Instead of 

using all 24 VPOTs, HUI plugin protocol uses only the first 8. This allows two 

‘layers’ of VPOT control to be available on the console at the same time.  

PAN or AUX/SEND can be active across the whole console, then the PLUG-

IN layer added over the top on channels 1-8.   

When PLUG-IN is lit, plugin mode is effectively in standby until U1 is pressed 

Press U1 to assign the first 8 VPOTs to Plugin control   

Only VPOTS 1-8 or the first DAW bank set in the peripherals window can be 

used as plugin controllers for plugins within the Pro Tools session.  

PLUG-IN VPOTS do not follow the fader bank selection 

In the image below, bank 1-8 is used to control the plugin on screen and 

banks 2 and 3 remain controlling Pans or Sends  
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Plugin Select Mode                                                                                                    1 

When PLUG-IN and U1 are first activated, the scribble strip for channels 1-8 

will display as below.  

 

Plugins must first be selected before they can be controlled from the 

console VPOTS.  

There are two ways to select a plugin to control.  

 If the plugin resides on track 1-8, press the channel SEL button. 

  

This opens the Pro Tools plugin window and focuses the VPOT controls 

onto the plugin.  

 

Or… 

 

 Use the computer mouse to open the plugin window within Pro 

Tools.  

 

Once a plugin window is in focus within Pro Tools, the VPOTs will be able 

to control the plugin. 

 

Selecting Pro Tools Inserts                                                                                       1 

To toggle through Pro Tools Inserts, quickly double tap the channel SEL 

button.  

 

 

 

 

 

 

 

Each double-tap toggles the plugin selection to the next available insert, if 

no insert is applied, the cycle skips to the next active plugin.  
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Scribble Strip Display                                                                                 1 

Once a plugin is selected the Scribble Strip for channels 1-8 will display the 

available plugin parameter names and values. 

  

 

Scribble Strip Flip                                                                                                       1 

There are two layers of information available to display on the scribble 

strips.  

SHIFT + FLIP - flips the Scribble strip to display the second layer of 

information.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

+ 
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Plugin Edit Mode                                                                                                        1 

Once a plugin has been selected, its parameters are available to control on 

the first fader bank's VPOTS and switches using SHIFT + SEL.  

VPOTS 1-4 are used to control four plugin parameters, VPOTs 5-8 are used 

for plugin parameter navigation and global plugin controls.  

Plugin VPOT Control                                                                                                  1 

Parameter 1 (VPOT 1)        – LF Q Bandwidth  

Parameter 2 (VPOT 2)        – LF Frequency selection 

Parameter 3 (VPOT 3)        – LF Gain 

Parameter 4 (VPOT 4)        – Not in use for this plugin  

Parameter 5 (VPOT 5)        – Page - See Plugin Page Navigation 

Parameter 6 (VPOT 6)        – Not in use 

Parameter 7 (SHIFT + SEL) – Compare - See Global plugin Controls 

Parameter 8 (SHIFT + SEL) – Bypass - See Global plugin Controls 
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TIP: 

Firmware version 7.10+ flips SHIFT + VPOT functionality.  

The default VPOT motion is set to coarse increments (x5 speed) 

Fine increments are adjusted via SHIFT +VPOT motion  

Visit www.ams-neve.com/consoles/small-format-consoles/neve-

8424/#Moreinfo to download the latest firmware and see 

Firmware Updater app for installation instructions.  

Adjusting Plugin Parameters                                                                                   1 

Rotating the VPOTs adjusts the three LF parameters in focus. Each plugin 

works differently for VPOT control, for the EQ3 7-Band plugin, sets of three 

rotary parameters at a time can be controlled by VPOTs 1-3, VPOT 4 is not 

used for EQ3 7-Band. 

 

 

 

Plugin parameters with VPOT control are highlighted with blue indicators if 

in Read automation mode.  

 

 

Plugin Parameters with VPOT control are highlighted with Yellow indicators 

if in Write, Touch or Latch automation modes.  

 

 

Turn the VPOT encoder clockwise to increase the plugin parameter value 

 

 

 

 

 

Turn the VPOT encoder counter-clockwise to decrease the plugin parameter 

value  

 

 

 

 

 

VPOT Fine/Course Adjustment                                                                               1 

By default, PLUG-IN VPOT adjustment is set to fine increments, to increase 

the encoder speed to course adjustment (x5 speed) press and hold SHIFT 

while moving the VPOT encoder.  

 

 

 

 

 

+ 

http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo
http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo
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Plugin Switch Control                                                                                                1 

In addition to VPOT rotary control, certain plugin parameters can be 

switched on or off using the 8424 console controls; the parameters vary 

depending on the plugin in use.  

Note: Switches can be pressed at any time no matter which layer of 

information is shown on the scribble strip 

Switch parameters are shown on layer 2 of the scribble strip information.  

 Press SHIFT + FLIP to view layer 2 

 

 

In the current example, the LF curve shape and LF IN are highlighted and are 

available as switch functions.   

Parameter 1 – Switch control not in use for this plugin 

Parameter 2 – LF Shelf/Bell curve   

Parameter 3 – LF band In/Out   

Parameter 4 – Switch control not in use for this plugin 

Parameter 5 – Page - See Plugin Page Navigation 

Parameter 6 – Not in use 

Parameter 7 – Compare - See Global plugin Controls 

Parameter 8 – Bypass - See Global plugin Controls 

 

Plugin switch settings can be adjusted in two ways.  

Press SHIFT + SEL on the selected channel.  

 

Alternatively press and hold the selected channel ST CUE PAN, then press 

the selected channel VPOT  

 

 

 

 

 

 

+ 

+ 

+ 
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Plugin Page Navigation                                                                                             1 

Plugins may have many pages of parameters to edit, navigation between 

plugin parameters is achieved by rotating VPOT 5.    

in the example below, VPOT 5 [Page] has been rotated one click so that the 

LMF band controls are available on VPOTS 1-4.  

Switch controls (SHIFT +SEL) also follow page selection 

 

 

Rotating VPOT 5 further will move VPOTs 1-4 to control to the next available 

plugin band and so forth.  

As VPOT 5 is rotated, page and plugin information are temporarily displayed 

on the scribble strip for VPOTs 1-4.  
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Global plugin Controls                                                                                               1 

VPOTS 5-8 are reserved for global plugin controls, Page is always available 

for plugin navigation via VPOT 5 and plugin Compare and Bypass are 

available via switch control (SHIFT +SEL) 7 and 8.  

  

 

 

 

 

 

 

 

 

 

 

Plugin global controls can be adjusted in two ways.  

Press SHIFT + SEL on the selected channel.  

 

Alternatively press and hold the selected channel ST CUE PAN, then press 

the selected channel VPOT  

 

 

 

+ 

+ 
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Logic DAW Control Setup                                                                                1  

Introduction                                                                                                                1  

The 8424 Motorized faders work with Logic as an MCU device, sending and 

receiving MIDI data via ipMIDI over ethernet connection.  

Logic MCU Setup                                                                                                        1  

First ensure that ipMIDI is installed and configured correctly on your Mac by 

following the steps on page 77-78.  

To configure Logic to send and receive MCU, navigate to  

Logic Preferences>Control Surface>Setup  

In the Control Surface Setup window click the New dropdown menu and 

disable the Automatic Installation option (unticked) 

 

 

 

 

In the event that logic has automatically installed control surfaces, highlight 

the current control surfaces, and press the delete key on your keyboard.  

 

 

 

 

 

 

 

 

 

Quick Setup (24 DAW Faders)                                                                       1 

Once the Control Surface Setup window is empty, click New > Scan All 

Models 

This should automatically assign the 8424 console 24 faders in the correct 

configuration for DAW control. In the event that the setup is incorrect, 

complete the steps on the following pages.  
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Manual Setup (24 DAW Faders)                                                                              1 

Once the Control Surface Setup window is empty, click New v Install… 

 

 

 

 

 

 

Scroll down and select - Mackie Designs > Mackie Control > Logic Control  

 

Click Scan  

Logic should automatically detect and assign channels 1-8 to ipMIDI port4, 

in the event that it does not, In the Device dropdown menu, Select  

 Output – ipMIDI Port 4 

 Input – ipMIDI Port 4 

 

The next step adds channels 9-16 and 17-24 as DAW controllers.  
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Select - Mackie Designs > Mackie Control Extender> Logic Control 

Click Scan 

Logic should automatically detect and assign channels 9-16 to ipMIDI port 5 

and channels 17-24 to ipMIDI port 6, in the event that it does not, In the 

Device dropdown menu, choose Mackie Control Extender 1 and select  

 Output – ipMIDI Port 5 

 Input – ipMIDI Port 5 

 

 

 

 

Next Select Mackie Control Extender 2 and select  

 Output – ipMIDI Port 6 

 Input – ipMIDI Port 6 

 

The setup detailed above will assign all 24 console channels to DAW control, 

as shown below  

 ipMIDI Port 4 ipMIDI Port 5 ipMIDI Port 6 
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If using only one or two 8424 console fader banks for DAW control, the Logic 

Controller Setup  must be configured accordingly to match the 8424 

consoles selected DAW fader bank.  The first Logic MCU device Pro must 

match with the first fader bank selected on the 8424 console.   

 

 

Example 1 - DAW Faders 1-16                                                                                 1 

In this example, only faders 1-16 are set as DAW faders, fader bank 17-24 is 

excluded from DAW MODE.  

The faders have been setup using the SHIFT + F keys (See page 79-80) so 

that faders 1-8 and 9-16 are included in DAW Mode. Faders 17-24 are 

excluded and remain in analogue mode when DAW MODE is active.  

 

 

 

 

Since this setup uses faders 1-8 and 9-16 as the first MCU ports, the Control 

Surface Setup screen must be set as below to exclude faders 17-24. Only 

one Mackie Control device will be added for faders 1-8 (Port 4) and one 

Mackie Control Extender for faders 9-16 (Port 5) 

 

 

 

 

 

 

 

 

DAW Faders 1-8 

ipMIDI Port 4 

Mackie Control 

 

DAW Faders 1-8 

ipMIDI Port 5 

Mackie Control 

Extender 

 

8424 Faders 17-24 

Excluded from DAW Mode 

 

 

F1 & F2 Active  

F3 Excluded  
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Example 2 DAW - Faders 17-24                                                                               1 

In this example, only faders 17-24 are set as DAW faders, fader banks 1-8 

and 9-16 are excluded from DAW MODE.  

The faders have been setup using the SHIFT + F keys (See page 79-80) so 

that faders 17-24 are included in DAW Mode. Fader banks 1-8 and 9-16 are 

excluded and remain in analogue mode when DAW MODE is active. 

 

 

 

Since this setup uses faders 17-24 as the only DAW port, the Logic Control 

Surface Setup screen must be configured to reflect this. The first MCU 

Mackie Logic Controller must be set as port (#6) 

No Mackie Control Extenders are required in this example.  

Clicking Scan automatically assigns the Mackie Logic Controller to Port 4, 

this must be changed manually to -  

 Output – ipMIDI Port 6 

 Input – ipMIDI Port 6 

 

 

 

 

 

 

 

 

DAW Faders 17-24 

ipMIDI Port 6 

 

 

8424 Faders 1-16 

Excluded from DAW Mode 

 

 

F3 Active  

F1 & F2 Excluded  
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Logic DAW Controller Operation                                                                   1  

Logic DAW Operation                                                                                                1 

When DAW MODE is active, the console faders will flip into DAW mode and 

the faders will move to the DAW fader positions. The channel scribble strips 

will also change to display the DAW name, abbreviated to seven characters. 

Channel Strip Functions                                                                                            1 

The SOLO and CUT buttons now function as Logic Mute and Solo,  following 

settings selected within Logic such as solo safe, solo link, and group settings. 

 

SEL - The select button has multiple functions depending on which key 

modifier is pressed in the centre section.  

Its default function is to highlight and select the DAW channel within Logic.   

 

 

 

 

 

 

 

 

 

 

 

 

REC - The record button is used to record arm tracks in Logic.   

 

 

 

The 8424 motorised faders are touch sensitive. When a touch is registered, 

the scribble strip LCD display will brighten.  
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Transport Control Keys                                                                                             1 

The transport control keys located in the centre of the console enable 

control of the Logic transport bar, these keys function outside of DAW 

mode, allowing for session navigation at all times.  

 

 

 

 

Several keys have a dual function activated by pressing and holding  the 

SHIFT key befor  e pressing.  

 

  

REW – Rewind 

Rewinds the session from the current playback cursor position  

Repeated presses accelerate the rewind speed  

 

 

FFW – Fast 

Forward  

Fast-forwards the session from the current playback cursor position 

Repeated presses accelerate the fast forward speed 

 

 

STOP  

 

Stops playback or recording  

 

RTZ – Return  

to Zero  

 

When playback is stopped, the STOP key switches to RTZ mode, pressing 

STOP now returns the timeline cursor to the beginning of the session 

 

PLAY  

 

Begins playback from the current cursor position 
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REC – Record 

Begins recording from the current cursor position  

 

 

LOOP – Loop 

playback/record  

Toggles loop playback/record mode  

 

Marker Keys                                                                                                                1 

The Marker keys located underneath the Transport Control keys in the 

centre section of the console are used to set and navigate to marker points 

on the Logic timeline.  

 

 

The Left marker key (<) navigates to the marker to the left of the current 

playback cursor position on the Logic timeline.  

In the example below, pressing < will move the playback cursor from its 

current position (Marker Location 4) to Marker Location 3 

 

 

 

 

 

 

The Right marker key (>) navigates to the marker to the right of the current 

playback cursor position on the Logic timeline.  

In the example below, pressing > will move the playback cursor from its 

current position (Marker Location 1) to Marker Location 2 
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The MARKER MODE key is used to add new markers to the Logic timeline.  

 

 

MARKER MODE + > adds a new marker to the current Logic timeline cursor 

position.  

 

 

MARKER MODE + < deletes the current selected marker from the Logic 

timeline.  

 

 

Functions/Utilities                                                                                                     1 

The Function/Utility keys are used to access multiple DAW functions.  

 

 

Solo/Click/Replace/Punch Functions                                                                     1  

 

 

SOLO - Toggles Logic’s solo region function, when SOLO is active, regions in 

the session can be selected and will be heard in solo during playback  

 

 

CLICK – Toggles the Logic metronome click track on or off  

 

 

REPLACE – Toggles Logic replace recording mode. When active, newly 

recorded regions will replace the original audio file on disk 

 

Punch – Activates Autopunch record mode 

 

 

+ 

+ 
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Automation                                                                                                                 1 

The AUTOMATION button is used as a modifier key in conjunction with 

channel VPOTs.  

 

 

When AUTOMATION is pressed and illuminated Green, the DAW channel 

VPOT button can be turned to cycle through the available Logic automation 

modes for that channel.  

 

 

 

 

Each stepped turn of the VPOT toggles one automation option at a time 

through off, read, touch, latch, write , T-Touch, T-Latch, R-Touch, R-Latch, 

and R-Write automation modes.  

 

 

 

 

 

 

 

 

Inactive Function/Utility Keys                                                                                 1 

The 8424 console is setup to work with multiple DAW’s, using both HUI and 

MCU protocol. This setup leaves certain switches redundant for MCU/Logic 

operation. The ONLINE/SUSPEND, PRE/RIGHT, and AUD/LEFT buttons are 

inactive during Logic operation.  

 

 

 

 

Active Faders                                                                                                               1 

The ACTIVE FADERS button is used to automate the consoles analogue 

faders from within Logic. See Active Faders for further information.  

 

 

+ 
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Fader banking                                                                                                             1 

The four buttons labelled BANK </> and CHANNEL </> are used to bank and 

scroll through Logic channels.  Banking and scrolling behaviours are mirrored 

in Logic.  

 

 

 

In the image below, Logic channels 1-24 are in focus on the 8424 channel 

faders. Each controller bank is represented by a coloured bar underneath 

the track name.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fader bank colours are also displayed in the Logic Control Surface Setup 

window.  

 

White – Bank 1  

Channels 1-8 

Orange – Bank 2               

Channels 9-16 

Yellow – Bank 3              

Channels 17-24 
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Bank < >                                                                                                                        1 

The fader bank keys (</>) shift focus of the 8424 faders onto the next 

channel ‘Bank’ within the DAW session.  

Each Bank is as large as the controller setup. If the 8424 is set to use all 

three Pro Tools Peripheral HUI banks, pressing BANK > will move the fader 

focus along to the next 24 DAW channels.   

In the image below, the fader focus has shifted by 24 channels to channels 

25-48.  

 

 

 

 

 

 

The Logic Edit window also follows bank selection. Scrolling up or down in 

the edit window to display the currently active tracks.   

 

 

 

 

 

 

 

 

 

White – Bank 1  

Channels 25-32 

Orange – Bank 2               

Channels 33-40 

Yellow – Bank 3              

Channels 41-48 
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Channel < >                                                                                                                  1 

The channel bank keys (</>) keys move the DAW fader focus along by one 

fader at a time either to the left or the right of the session mix/Edit window.  

In the image below, channels 1-24 are in focus.  

 

 

 

 

In the image below, CHANNEL > has been pressed once, banking the 8424 

24 faders across by one channel. Now, channels 2-25 are in focus.  

Pressing Channel > will continue to scroll the fader focus onto the next 

channel to the right within the Mix window or to the next channel down in 

the Edit window.  

 

 

Pressing Channel < will scroll the fader focus onto the previous channel to 

the left within the Mix window or to the next channel up in the Edit window.  

Logic Channels 2-25 

Logic Channels 1-24 
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Assignment Keys                                                                                                        1 

The VPOT assignment keys are used to assign the consoles VPOTs to various 

DAW parameters including DAW pans, Aux sends and Plugins.  

 

Logic Pan Control                                                                                                       1 

To control Logic Pans, press the PAN button, this assigns the console 24 

VPOTs to work as rotary pan controllers within Logic.  

When PAN is lit, pan mode is effectively in standby until U1 is pressed  

To assign console VPOTs to control Logic Pan controls – press the U1 button  

  

 

 

All 24 consoles VPOTs can be used as PAN controllers for the 24 channels 

within the Logic session. VPOTS follow the fader bank selection. 
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Standard Logic Panning                                                                                            1 

When PAN and U1 are lit and active, the channel TRIM VPOT will now work 

as an encoder for Logic Pans.  

The LED indicator on the Trim VPOT matches the current position of DAW 

channel pans.  

 

 

 

 

To Pan left - turn the VPOT Encoder counter-clockwise  

 

 

 

 

 

 

To Pan right - turn the VPOT encoder clockwise 

 

 

 

 

 

 

VPOT fine/course adjustment                                                                                 1 

By default, Pan VPOT adjustment is set to fine increments, to increase the 

encoder speed to course adjustment (x5 speed) press and hold SHIFT while 

moving the VPOT encoder.  

 

 

+ 

TIP: 

Firmware version 7.10+ flips SHIFT + VPOT functionality.  

The default VPOT motion is set to coarse increments (x5 speed) 

Fine increments are adjusted via SHIFT +VPOT motion  

Visit www.ams-neve.com/consoles/small-format-consoles/neve-

8424/#Moreinfo to download the latest firmware and see 

Firmware Updater app for installation instructions.  

http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo
http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo
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Pan Centre                                                                                                                   1  

A quick shortcut is included to reset send pan positions to the centre  

Press SHIFT + Channel SEL 

 

 

Alternatively press and hold the selected channel ST CUE PAN, then press 

the selected channel VPOT  

 

 

 

 

Flip Mode                                                                                                                     1  

Logic supports fader flip mode for VPOT functions, in PAN mode, this allows 

for the Logic pan positions to be controlled by the 8424 console faders.  

When Fader Flip is active, the 8424 faders will move to represent the 

current logic pan positions 

 Moving the fader up will move the Logic pan position to the right  

 Moving the fader down will move the Logic pan position to the left  

 

 

 

 

 

Scribble Strip Display Options                                                                                 1 

There are several modifier shortcuts that ‘flip’ the scribble strip display to 

show various Pan parameters listed below.  

Scribble Strip Flip                                                                                                       1 

SHIFT + FLIP - flips the Scribble strip to display Pan parameters rather than 

Logic track name.  

Toggle Display                                                                                                             1 

When the send parameter is displayed, pressing SHIFT + PAN toggles the 

scribble strip display between pan name and current +/- pan value 

 

 

1 

+ 

+ 

+ 

+ 
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Surround/Binaural Panning                                                                                     1 

When Logic channels are assigned to Surround output, the Surround panner 

becomes available for that channel.  

In Surround Pan mode, there are multiple control options available, the 

VPOT can be used to control each of these parameters.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Scribble Strip Flip                                                                                                       1 

Press SHIFT + FLIP to display the current parameter on the channel Scribble 

strip.  

Toggle Display                                                                                                             1 

When the send parameter is displayed, pressing SHIFT + PAN toggles the 

scribble strip display between pan name and current +/- pan value 

 

 

 

Selecting Surround Parameters                                                                              1 

Available parameters can be cycled through by using SHIFT + CHANNEL <> 

 

Fader Flip for Surround Panning                                                                            1  

Press FLIP to use the faders to control surround parameters instead of the 

VPOTs  

+ 

+ 

+ 
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Surround Parameters                                                                                                1 

SurAng - Assigns the VPOT to the Surround panner angle setting 

Rotating the VPOT in either direction will adjust the surround angle  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SurRad - Assigns the VPOT to the surround radius (Diversity)  

Rotating the VPOT in either direction will adjust the radius (Diversity) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

VPOT Mode FLIP Mode 

FLIP Mode VPOT Mode 



                                                                                                                                           145 
 

 

SurrE - Assigns the VPOT to the surround LFE Level setting   

Rotating the VPOT in either direction will adjust the LFE Level  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The next available parameter is not used and appears blank – 

 

SrndX - Assigns the VPOT to the control the surround X-axis    

Rotating the VPOT in either direction will move the position of the logic 

surround object in the horizontal plane, adjusting both angle and diversity 

together  

 

 

 

 

 

 

 

 

 

 

 

 

VPOT Mode FLIP Mode 

VPOT Mode FLIP Mode 
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SrndY - Assigns the VPOT to the control the surround Y-axis    

Rotating the VPOT in either direction will move the position of the logic 

surround object in the horizontal plane, adjusting both angle and diversity 

together 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SurCen - Assigns the VPOT to the surround Center Level   

Rotating the VPOT in either direction will adjust the Center Level  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

FLIP Mode VPOT Mode 

VPOT Mode FLIP Mode 
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Logic Send Control                                                                                                     1 

To control Logic Sends, press the AUX/SND button, this assigns the console 

24 VPOTs to work as rotary Send controllers within Logic.  

When AUX/SND is lit, send mode is effectively in standby until U1 is pressed.  

To assign the VPOTs to control Logic sends – press the U1 button.  

  

All 24 consoles VPOTs can be used as send controllers for 24 channels within 

the Logic session.  

VPOT Sends follow the fader bank selection  
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Configuring Logic Sends                                                                                            1 

When AUX/SEND and U1 are lit and active, the channel TRIM VPOT will now 

work as an encoder for Logic sends 1 to 8.  

The selected send is displayed on the channel scribble strip in [brackets] 

next to the Logic channel name.  

Sends [1] through [8] are available to control using the channel VPOTs  

Flip Mode                                                                                                                     1  

Logic supports fader flip mode for VPOT functions, in Send mode, this allows 

for the Logic send levels to be controlled by the 8424 console faders.  

When Fader Flip is active, the 8424 faders will move to represent the 

current logic send positions 

 Moving the fader up will increase the selected send level  

 Moving the fader down will decrease the selected send level   

 

 

 

Scribble Strip Display Options                                                                                 1 

There are several modifier shortcuts that flip the scribble strip display to 

show various Send information and parameters listed below.  

Scribble Strip Flip                                                                                                       1 

SHIFT + FLIP - flips the Scribble strip to display Send parameters rather than 

Logic track name.  

Toggle Display                                                                                                             1 

When the send parameter is displayed, pressing SHIFT + AUX/SND toggles 

the scribble strip display between send name and send level.   

  

 

 

Selecting Sends                                                                                                           1 

To toggle through sends 1-8, press and hold SHIFT, then press Bank < or >  

 

 

Selecting Send Parameters                                                                                      1  

To toggle through send parameters, press and hold SHIFT, then press 

CHANNEL < or > 

Parameter controls are detailed on the following pages.  

 

+ 

+ 

+ 

+ 
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Adjusting Send Levels                                                                                                1 

Once the selected send is chosen, the VPOTS can be used to adjust the Logic 

Send level 

The default parameter when first pressing AUX/SEND is the send level.  

The LED indicator on the Trim VPOT matches the current position of DAW 

channel sends.  

 

 

 

 

 

 

Turn the encoder clockwise to increase the send level  

 

 

 

 

 

 

Turn the encoder counter-clockwise to decrease the  

send level  

 

 

 

 

 

VPOT Fine/Course Adjustment                                                                               1 

By default, VPOT adjustment is set to fine increments, to increase the 

encoder speed to course adjustment (x5 speed) press and hold SHIFT while 

moving the VPOT encoder.  + 

FLIP Mode 

FLIP Mode 

TIP: 

Firmware version 7.10+ flips SHIFT + VPOT functionality.  

The default VPOT motion is set to coarse increments (x5 speed) 

Fine increments are adjusted via SHIFT +VPOT motion  

Visit www.ams-neve.com/consoles/small-format-consoles/neve-

8424/#Moreinfo to download the latest firmware and see 

Firmware Updater app for installation instructions.  

http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo
http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo
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Send Default level                                                                                                      1  

A quick shortcut is included to reset send levels to 0dB  

Press SHIFT + Channel SEL 

 

 

Alternatively press and hold the selected channel ST CUE PAN, then press 

the selected channel VPOT  

 

 

 

 

Send Destination.                                                                                                       1 

It is possible to assign send destinations from the console VPOTs.  

 

Send destinations are accessed by pressing SHIFT + CHANNEL <  

 

 

Turn the VPOT encoder to cycle through the available send destinations  

The scribble strip will flash while cycling through send destinations  

 

 

 

 

Once a destination is chosen, press SHIFT + SEL to confirm the send 

destination 

 

 

 

Alternatively press and hold the selected channel ST CUE PAN, then press 

the selected channel VPOT  

 

 

It is not recommended to enter FLIP mode when choosing send 

destinations 

+
 

+ 

+ 

+ 

+ 
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Send Pre/Post Toggle                                                                                                1 

Send pre/post fader option can be activated or deactivated using the VPOTS.   

 

Access pre/post using SHIFT + CHANNEL <> 

 

 

Turn the VPOT to cycle through the available send states - Pre, Post and 

Post-Pan.  

Pre-fade Send 

 

Post-fade Send 

 

Post-Pan Send 

 

 

  

Send Mute                                                                                                                   1 

The next available parameter is send mute, displayed on the scribble strip as 

either active or muted.  

 

Access send mute using SHIFT + CHANNEL <> 

 

 

Turn the VPOT to cycle through the two options active/muted 

Send Active 

 

Send Muted  

 

 

 

Alternatively, press SHIFT +Channel SEL to toggle between active/muted 

 

 

 

 

+ 

+ 

+ 



                                                                                                                                           152 
 

 

Logic Plugin Control                                                                                           1 

Logic plugin parameters can be controlled from the 8424 console VPOTs. 

MCU allows for all 24 VPOTs to be utilized for plugin control.    

When PLUG-IN is lit, plugin mode is effectively in standby until U1 is pressed 

To assign the VPOTs to control Logic plugins – press the U1 button  

PLUG-IN VPOTS do not follow the fader bank selection 

 

Flip Mode                                                                                                                     1  

Logic supports fader flip mode for VPOT functions. In plugin mode, this 

allows for the Logic plugin parameters to be controlled by the 8424 console 

faders.  

Updating Firmware 35When Fader Flip is active, the 8424 faders will move 

to represent the current logic plugin parameters  

 Moving the fader up will increase the selected parameter value  

 Moving the fader down will decrease the selected parameter value   

 

 

 

 

Scribble Strip Display Options                                                                                 1 

There are several modifier shortcuts that flip the scribble strip display to 

show various pages of plugin parameter information listed below.  

Scribble Strip Flip                                                                                                       1 

SHIFT + FLIP - flips the Scribble strip to display plugin parameter values 

rather than Logic track name.  

Toggle Display                                                                                                             1 

When plugin parameter values are displayed, pressing SHIFT + Plugin toggles 

the scribble strip display between parameter name and parameter value.   

 

 

Selecting Logic Inserts                                                                                               1 

To toggle through Inserts 1-8, press and hold SHIFT, then press Bank < or >  

 

Selecting Plugin Parameters                                                                                    1  

To toggle through pages of send parameters (when necessary), press and 

hold SHIFT, then press CHANNEL < or > 

Parameter controls are detailed on the following pages.  

+ 

+ 

+ 

+ 
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Plugin Select Mode                                                                                                    1 

It is possible to add plugins using the console VPOTs.  

Pressing PLUG-IN and U1 fist opens plugin select mode  

 

 

Use SHIFT + BANK < > to select the insert point from 1-8 

 

 

If a plugin is already inserted on the insert slot, the plugin name will appear 

in the scribble strip 

 

If there is no plugin inserted onto the insert slot, the scribble strip will 

appear blank -  

 

Adding a New Plugin                                                                                                 1 

Turn the VPOT encoder to cycle through available plugins 

 

The scribble strip will flash while cycling through possible send destinations  

 

 

 

 

Once a plugin is chosen, press SHIFT + SEL to add the plugin to the selected 

channel insert slot  

 

 

 

Alternatively press and hold the selected channel ST CUE PAN, then press 

the selected channel VPOT  

 

 

It is not recommended to enter FLIP mode in plugin select mode 

 

 

 

+ 

+ 

+ 
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Plugin Edit Mode                                                                                                        1 

Once the plugin has been selected, press SHIFT + Channel SEL to open plugin 

edit mode.  

 

 

In Plugin Edit mode, the scribble strips will change to display available 

parameters or parameter names by using the Toggle Display feature.  

 

The number of parameters varies between plugins. If there are more 

parameters available than console VPOTS/Faders SHIFT +Channel < > can be 

used to scroll through plugin parameter pages  

The VPOTS can be used to adjust the Logic plugin parameters 

In the example below the Logic channel EQ has 24 available parameters 

spread across all 24 VPOTS or faders when in Flip mode.  

 

 

 

 

 

 

 

 

 

 

+

c 

Channel 1-8 VPOTs 

8-band Gain 

Channel 9-16 VPOTs 

8-band Frequency 

Channel 17-24 VPOTs 

8-band Q (Bandwidth) 

+

c 
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Adjusting Plugin Parameters                                                                                   1 

The LED indicator on the Trim VPOT matches the current position of the 

plugin parameter value 

 

 

 

 

 

 

 

Turn the encoder clockwise to increase the parameter 

value  

 

 

 

 

 

 

Turn the encoder counter-clockwise to decrease the  

parameter value 

 

 

 

 

 

VPOT fine/course adjustment                                                                                 1 

By default, VPOT adjustment is set to fine increments, to increase the 

encoder speed to course adjustment (x5 speed) press and hold SHIFT while 

moving the VPOT encoder.  

 

+ 

FLIP Mode 

FLIP Mode 

TIP: 

Firmware version 7.10+ flips SHIFT + VPOT functionality.  

The default VPOT motion is set to coarse increments (x5 speed) 

Fine increments are adjusted via SHIFT +VPOT motion  

Visit www.ams-neve.com/consoles/small-format-consoles/neve-

8424/#Moreinfo to download the latest firmware and see 

Firmware Updater app for installation instructions.  

http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo
http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo
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Cubase/Nuendo DAW Control Setup                                                           1  

Introduction                                                                                                                1  

The 8424 Motorized faders work with Cubase/Nuendo as an MCU device, 

sending and receiving MIDI data via ipMIDI over ethernet connection.  

Cubase/Nuendo MCU Setup                                                                                    1  

First ensure that ipMIDI is installed and configured correctly on your Mac by 

following the steps on page 77-78.  

To configure Cubase/Nuendo to send and receive MCU, navigate to  

Studio>Studio Setup  

 

Manual Setup (24 DAW Faders)                                                                              1 

In the Studio Setup window click the Add Device under the Devices 

dropdown menu dropdown menu and choose Mackie Control  
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In Cubase/Nuendo, Ports must be assigned in reverse order.  

For the first Mackie Control device, choose  

 MIDI Input Port 9  

 MIDI Output Port 9  

 

 

 

 

Configure the options at the bottom of the page to match the image below  

 Smart Switch Delay – Short  

 Enable Auto Select  – Off 

 Relay Click                 – Off 

 

 

 

 

Add a Second Mackie Control device  

 

 

 

 

 

 

 

 

 

For the second Mackie Control device, choose  

 MIDI Input    - Port 8  

 MIDI Output - Port 8 
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Configure the options at the bottom of the page to match the image below  

 Smart Switch Delay – Short  

 Enable Auto Select  – Off 

 Relay Click                 – Off 

 

 

 

 

Add a third Mackie Control device  

 

 

 

 

 

 

 

 

 

For the third Mackie Control device, choose  

 MIDI Input    - Port 7  

 MIDI Output - Port 7 

 

 

 

 

Configure the options at the bottom of the page to match the image below  

 Smart Switch Delay – Short  

 Enable Auto Select  – Off 

 Relay Click                 – Off 
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This process sets up three Mackie devices visible within the Studio Setup 

window.  

 

 

 

 

Once three devices are added and configured, press Device Reset 

 

 

 

 

Device reset must also be pressed when switching to Cubase/Nuendo from 

another active DAW 

 

 

The setup detailed above will assign all 24 console channels to DAW control, 

as shown below  

 

 

If using only one or two 8424 console fader banks for DAW control, the 

Studio Controller Setup must be configured accordingly to match the 8424 

consoles selected DAW fader bank.  The first MCU device Pro must match 

with the first fader bank selected on the 8424 console.   

 

 

 

 

 

 

 

 

ipMIDI Port 7 ipMIDI Port 8 ipMIDI Port 9 
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Example 1 DAW Faders 1-16                                                                                   1 

In this example, only faders 1-16 are set as DAW faders, fader bank 17-24 is 

excluded from DAW MODE.  

The faders have been setup using the SHIFT + F keys (See page 79-80) so 

that faders 1-8 and 9-16 are included in DAW Mode. Faders 17-24 are 

excluded and remain in analogue mode when DAW MODE is active.  

 

 

 

 

Since this setup uses faders 1-8 and 9-16 as the first MCU ports, the Studio 

Setup screen must be set as below to exclude faders 17-24. Two Mackie 

Control devices will be added for faders 1-8 (Port 7) and for faders 9-16 

(Port 8) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

DAW Faders 1-8 

ipMIDI Port 4 

Mackie Control 

 

DAW Faders 1-8 

ipMIDI Port 5 

Mackie Control 

Extender 

 

8424 Faders 17-24 

Excluded from DAW Mode 

 

 

F1 & F2 Active  

F3 Excluded  
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Example 2 DAW Faders 17-24                                                                                 1 

In this example, only faders 17-24 are set as DAW faders, fader banks 1-8 

and 9-16 are excluded from DAW MODE.  

The faders have been setup using the SHIFT + F keys (See page 79-80) so 

that faders 17-24 are included in DAW Mode. Fader banks 1-8 and 9-16 are 

excluded and remain in analogue mode when DAW MODE is active. 

 

 

 

Since this setup uses faders 17-24 as the only DAW port, the Studio Setup 

screen must be configured to reflect this. The first MCU Mackie Controller 

must be added for faders 17-24 (Port 9)  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

DAW Faders 17-24 

ipMIDI Port 6 

 

 

8424 Faders 1-16 

Excluded from DAW Mode 

 

 

F3 Active  

F1 & F2 Excluded  
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Cubase/Nuendo DAW Controller Operation                                              1  

Channel Strip Functions                                                                                            1 

When DAW MODE is active, the console faders will flip into DAW mode and 

the faders will move to the DAW fader positions.  

The channel scribble strips will also change to display the DAW name, 

abbreviated to six characters. 

The SOLO and CUT buttons now function as Cubase/Nuendo Mute and Solo, 

following settings selected within Cubase/Nuendo such as solo safe, solo 

link, and group settings. 

   

 

 

SEL - The select button has multiple functions depending on which key 

modifier is pressed in the centre section.  

Its default function is to highlight and select the particular DAW channel 

within Cubase/Nuendo.   

 

 

 

 

 

 

 

 

 

SHIFT + Channel SEL – toggles channel monitor on/off 

 

 

 

 

REC - The record button is used to record arm tracks in Cubase/Nuendo   

 

 

 

The 8424 motorised faders are touch sensitive. When a touch is registered, 

the scribble strip LCD display will brighten.  

+

c 
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Transport Control Keys                                                                                             1 

The transport control keys located in the centre of the console enable 

control of the Cubase/Nuendo transport bar, these keys function outside of 

DAW mode, allowing for session navigation at all times.  

 

 

 

 

Several keys have a dual function activated by pressing and holding the 

SHIFT key before pressing.  

  

REW – Rewind 

Rewinds the session from the current playback cursor position  

The RWD button is momentary and will stop rewinding when released  

 

FFW – Fast 

Forward  

Fast-forwards the session from the current playback cursor position 

The FFW button is momentary and will stop rewinding when released  

 

STOP  

Stops playback or recording  

 

RTZ – Return  

to Zero  

 Returns the timeline cursor to the beginning of the session  

 

END – Go to 

end  

 

Moves the timeline cursor to the end of the project 

 

PLAY  

 

Begins playback from the current cursor position 

+ 

+ 



                                                                                                                                           164 
 

 

 

REC – Record 

Begins recording from the current cursor position  

 

LOOP – Loop 

Play/Record  

Toggles loop playback/record mode  

 

Marker Keys                                                                                                                1 

The Marker keys located underneath the Transport Control keys in the 

centre section of the console are used to set and navigate to marker points 

on the Cubase/Nuendo timeline.  

 

The Left marker key (<) navigates to the marker to the left of the current 

playback cursor position on the Cubase/Nuendo timeline.  

In the example below, pressing < will move the playback cursor from its 

current position (Marker Location 4) to Marker Location 3 

 

 

 

 

 

 

 

The Right marker key (>) navigates to the marker to the right of the current 

playback cursor position on the Cubase/Nuendo timeline.  

In the example below, pressing > will move the playback cursor from its 

current position (Marker Location 1) to Marker Location 2 
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The MARKER MODE key is used to add new markers to the Cubase/Nuendo 

timeline.  

 

 

MARKER MODE + > adds a new marker to the current Cubase/Nuendo 

timeline cursor position.  

 

Functions/Utilities                                                                                                     1 

The Function/Utility keys are used to access multiple DAW functions.  

 

 

LEFT – moves the cursor to the beginning of a selected Loop  

 

 

 

 

 

Right – Moves the timeline cursor to the end of a selected loop 

 

 

 

 

 

SHIFT + AUD – Opens the channel settings window 

 

 

 

 

 

+ 

+ 
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IN – Sets the beginning loop point from the current timeline cursor position   

 

 

 

 

 

OUT – Sets the end loop point from the current timeline cursor position  

 

 

 

 

 

ONLINE – Toggles MixConsole/Project windows  

 

 

PUNCH – Activates autopunch record mode 

 

 

 

Automation                                                                                                                 1 

The AUTOMATION button is used as a modifier key in conjunction SHIFT and 

Channel SEL keys to toggle between Read and Write automation modes.  

 

First, select a channel using the Channel SEL key  

 

 

 

Once selected, press SHIFT + AUTOMATION to toggle through the tracks 

Read, Write, and Off automation modes.  

           Read                                      Write                                        Off 

 

 

 

+ 
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Inactive Function/Utility buttons                                                                           1 

The 8424 console is setup to work with multiple DAW’s, using both HUI and 

MCU protocol. This setup leaves certain switches redundant for 

Cubase/Nuendo operation. The POST/REPLACE button is inactive during 

Cubase/Nuendo operation.  

 

Active Faders                                                                                                               1 

The ACTIVE FADERS button is used to automate the consoles analogue 

faders from within Cubase. See Active Faders for further information.  

 

Fader banking                                                                                                             1 

The four buttons labelled BANK </> and CHANNEL </> are used to bank and 

scroll through Cubase/Nuendo channels.  Banking and scrolling behaviours 

are mirrored in Cubase/Nuendo.  

 

 

 

In the image below, Cubase/Nuendo channels 1-24 are in focus on the 8424 

channel faders.  

 

 

 

 

Fader control is indicated by a white line above the track name  

 

 

 

Bank 1 

Channels 1-8 

Bank 2 

Channels 9-16 

Bank 3 

Channels 17-24 
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Bank < >.                                                                                                                       1 

The fader bank keys (</>) shift focus of the 8424 faders onto the next 

channel ‘Bank’ within the DAW session.  

Each Bank is 8 channels wide. Pressing BANK > will move the fader focus 

along by 8 DAW channels  

In the image below, the fader focus has shifted by 8 channels to 

Cubase/Nuendo channels 9-32.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Bank 1 

Channels 9-16 

Bank 2 

Channels 17-24 

Bank 3 

Channels 25-32 
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Channel < >                                                                                                                  1 

The channel bank keys (</>) keys move the DAW fader focus along by one 

fader at a time either to the left or the right of the session MixConsole 

window.  

In the image below, channels 1-24 are in focus.  

 

 

 

 

In the image below, CHANNEL > has been pressed once, banking the 8424 

24 faders across by one channel. Now, channels 2-25 are in focus.  

Pressing Channel > will continue to scroll the fader focus onto the next 

channel to the right within the MixConsole window or to the next channel 

down in the Project window.  

 

Pressing Channel < will scroll the fader focus onto the previous channel to 

the left within the MixConsole window or to the next channel up in the 

Project window.  

Cubase/Nuendo Channels 2-25 

Cubase/Nuendo Channels 1-24 
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Assignment Keys                                                                                                        1 

The VPOT assignment keys are used to assign the consoles VPOTs to various 

DAW parameters including DAW pans, Aux sends and Plugins.  

 

Cubase/Nuendo Pan Control                                                                                   1 

To control Cubase/Nuendo Pans, press the PAN button, this assigns the 

console 24 VPOTs to work as rotary pan controllers within Cubase/Nuendo.  

When PAN is lit, pan mode is effectively in standby until U1 is pressed.  

To assign console VPOTs to control Cubase/Nuendo Pan controls – press the 

U1 button.  

  

 

 

All 24 consoles VPOTs can be used as PAN controllers for 24 channels within 

the session. VPOTS follow the fader bank selection. 
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When PAN and U1 are lit and active, the channel VPOT will now work as an 

encoder for Cubase/Nuendo Pans.  

 

 

The LED indicator on the Trim VPOT matches the current position of DAW 

channel pans.  

 

 

To Pan left - turn the VPOT Encoder counter-clockwise  

 

 

 

 

 

 

To Pan right - turn the VPOT encoder clockwise 

 

 

 

 

 

Flip Mode                                                                                                                     1  

Cubase/Nuendo supports fader flip mode for VPOT functions, in PAN mode, 

this allows for the pan positions to be controlled by the 8424 console faders.  

When Fader Flip is active, the 8424 faders will move to represent the 

current Cubase/Nuendo pan positions 

 Moving the fader up will move the Cubase/Nuendo pan position to the 

right  

 Moving the fader down will move the Cubase/Nuendo pan position to 

the left  

 

In Cubase/Nuendo, when in flip mode, the fader function flips to the VPOT 

allowing the VPOT will control the Cubase/Nuendo channel fader 
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Scribble Strip Display Options                                                                                 1 

There are several modifier shortcuts that ‘flip’ the scribble strip display to 

show various Pan parameters listed below.  

Scribble Strip Flip                                                                                                       1 

SHIFT + FLIP - flips the Scribble strip to display Pan positions rather than 

Cubase/Nuendo track name.  

Toggle Display                                                                                                             1 

When the send parameter is displayed, pressing SHIFT + PAN toggles the 

scribble strip display between pan name and current +/- pan value 

  

 

 

 

 

VPOT fine/course adjustment                                                                                 1 

By default, VPOT adjustment is set to fine increments, to increase the 

encoder speed to course adjustment (x5 speed) press and hold SHIFT while 

moving the VPOT encoder.  

 

 

 

 

 

 

 

 

 

 

+ 

+ 

+ 
TIP: 

Firmware version 7.10+ flips SHIFT + VPOT functionality.  

The default VPOT motion is set to coarse increments (x5 speed) 

Fine increments are adjusted via SHIFT +VPOT motion  

Visit www.ams-neve.com/consoles/small-format-consoles/neve-

8424/#Moreinfo to download the latest firmware and see 

Firmware Updater app for installation instructions.  

http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo
http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo
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Cubase/Nuendo Send Control                                                                                 1 

To control Cubase/Nuendo Sends, press the AUX/SND button, this assigns 

the console 24 VPOTs to work as rotary Send controllers for various send 

parameters within Cubase/Nuendo.  

 

When AUX/SND is lit, send mode is effectively in standby until U1 is pressed.  

To assign the VPOTs to control Cubase/Nuendo sends – press the U1 button.  

  

 

 

Flip Mode                                                                                                                     1  

Cubase/Nuendo supports fader flip mode for VPOT functions, in Send mode, 

this allows for the Cubase/Nuendo send levels to be controlled by the 8424 

console faders.  

When Fader Flip is active, the 8424 faders will move to represent the 

current Cubase/Nuendo send positions 

 Moving the fader up will increase the selected send level  

 Moving the fader down will decrease the selected send level   

 

In Cubase/Nuendo, when in flip mode, the fader function flips to the VPOT 

allowing the VPOT will control the Cubase channel fader 
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Configuring Cubase/Nuendo Sends                                                                       1 

When AUX/SEND and U1 are lit and active, all 24 VPOTs work as encoders 

for Cubase/Nuendo sends 1 to 8.  

Cubase/Nuendo send control functions differently from Pro Tools and Logic, 

rather than locking VPOTs to selected channels, each VPOT works as a 

control for up to 8 sends for a selected Cubase/Nuendo channel.  

 

Each Cubase/Nuendo channel has 8 available send slots.  

Sends [1] through [8] are available to control using the channel VPOTs  

Selecting Sends                                                                                                           1 

To configure sends, first select a Cubase/Nuendo channel by using the 8424 

Channel Sel key  

 

Once selected, send parameters for the channels 8 sends are spread across 

the 8424’s available VPOTs.  

If using all 24 faders for DAW control, Cubase/Nuendo will make use of the 

three available banks as shown below.  

Send levels 1-8 are assigned to channel VPOTs 1-8 

Send On/off 1-8 are assigned to channel VPOTs 9-16 

Send Pre/Post 1-8 are assigned to channel VPOTs 17-24 

 

 

 

 

 

 

 

 

 

 

 

VPOT mode  

Send 1-8 Levels 

VPOT Mode 

 Send 1-8 On/Off 

VPOT Mode 

Send 1-8 Pre/Post 

Flip mode 

Send 1-8 Levels 

Flip mode 

Send 1-8 On/Off 

Flip mode 

Send 1-8 Pre/Post 
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Scribble Strip Display Options                                                                                 1 

When first entering AUX/SND mode, the scribble strips will appear blank 

until a Channel Sel button has been pressed, this activates the AUX/SND 

mode, assigning VPOTs to control the channels 8nsend parameters and the  

scribble strips flip to display these parameters.  

The Scribble strip must be flipped to display the send parameters.   

Scribble Strip Flip                                                                                                       1 

SHIFT + FLIP - flips the Scribble strip to display Send parameters or Send 

Page information 

 

Faders 1-8 Display Level  

Faders 9-16 Display On-Off 

Faders 17-24 display Pre-Post 

 

Toggle Display                                                                                                             1 

When the send parameter is displayed, pressing SHIFT + AUX/SND toggles 

the scribble strip display between send name and send level.   

For Faders 1-8 the scribble strip flips to display send level 

  

 

 

For Faders 9-16 the scribble strip flips to display On/Off status 

  

 

 

 

For Faders 17-24 the scribble strip flips to display Pre On or Off (post fader) 

  

 

 

 

 

 

 

 

 

+ 

+ 

+ 

+ 
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Adjusting Send Levels                                                                                                1 

Once the selected send is chosen, the VPOTS for console channels 1-8 can 

be used to adjust the selected channel send 1-8 levels. 

 

 

 

 

 

 

 

 

 

 

The LED indicator on the Trim VPOT matches the current position of DAW 

channel sends.  

 

 

 

 

 

 

 

Turn the encoder clockwise to increase the send level  FLIP Mode 

VPOT mode  

Send 1-8 Levels 

Flip mode 

Send 1-8 Levels 
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Turn the encoder counter-clockwise to decrease the  

send level  

 

 

 

 

 

VPOT fine/course adjustment                                                                                 1 

By default, VPOT adjustment is set to fine increments, to increase the 

encoder speed to course adjustment (x5 speed) press and hold SHIFT while 

moving the VPOT encoder.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

+ 

FLIP Mode 

TIP: 

Firmware version 7.10+ flips SHIFT + VPOT functionality.  

The default VPOT motion is set to coarse increments (x5 speed) 

Fine increments are adjusted via SHIFT +VPOT motion  

Visit www.ams-neve.com/consoles/small-format-consoles/neve-

8424/#Moreinfo to download the latest firmware and see 

Firmware Updater app for installation instructions.  

http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo
http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo
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Send On/Off Toggle                                                                                                   1 

The 8424 console channel 9-16 VPOTS (or faders when in flip mode) control 

sends 1-8 on/off function.  

Send On/Off is located on page 2 of 4 

 

 

 

 

 

 

 

 

 

 

 

 

Turn the VPOT to cycle through the two options  

 

Send On 

 

Send Off  

 

 

 

 

 

 

 

FLIP Mode 

VPOT Mode 

 Send 1-8 On/Off 

Flip mode 

Send 1-8 On/Off 
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Send Pre/Post Toggle                                                                                                1 

The 8424 console channel 17-24 VPOTs (or faders when in flip mode) control 

sends 1-8 Pre/Post function.  

Send Pre/Post is located on page 3 of 4 

 

 

 

 

 

 

 

 

 

 

 

 

Turn the VPOT to cycle through the available send states 

 

Pre-fade Send 

 

Post-fade Send 

 

 

 

 

 

 

 

 

FLIP Mode 

VPOT Mode 

Send 1-8 Pre/Post 

Flip mode 

Send 1-8 Pre/Post 
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Send Destination.                                                                                                       1 

It is possible to assign send destinations from the console VPOTs (or faders 

when in flip mode)  

Send destination is located on page 4 of 4 

 

  

To access send destination, page four must be accessed. Since the three 

pages are used on faders 1-24, the second page is hidden.  

Press and hold SHIFT, then press CHANNEL  > to access page 4 

 

 

 

 

 

 

 

 

 

 

 

 

 

Turn the VPOT encoder to cycle through the 

available send destinations.  

 

 

The scribble strip will update to show send 

destinations 

 

It is not recommended to enter FLIP mode when choosing send 

destinations 

+ 

VPOT mode  

Send 1-8 Levels 

Flip mode 

Send 1-8 Levels 
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Single/Dual Fader Bucket Considerations                                                             1  

Cubase/Nuendo uses four, 8-fader wide pages of parameters to control its 

sends, if using less than the 8424s full 24 faders for DAW mode, send 

parameters will be laid out across multiple pages.  

If using only one fader bucket for DAW control, four pages of send 

information will be available to control with the 8 selected console faders.  

Scroll ages to assign the selected DAW faders to parameter banks by using 

SHIFT + CHANNEL < or > 

 

 

Send level Page 1  

 

Send On/Off Page 2 

 

Send Pre/Post Page 3 

 

Send Destination Page 4 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

+ 
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Cubase/Nuendo Plugin Control                                                                              1 

Cubase/Nuendo plugin parameters can be controlled from the 8424 console 

VPOTs. MCU allows for all 24 VPOTs to be utilized for plugin control.    

When PLUG-IN is lit, plugin mode is effectively in standby until U1 is pressed 

 

To assign the VPOTs to control Cubase/Nuendo plugins – press the U1 

button  

PLUG-IN VPOTS do not follow the fader bank selection 

Flip Mode                                                                                                                     1  

Cubase/Nuendo supports fader flip mode for VPOT functions. In plugin 

mode, this allows for the Cubase/Nuendo plugin parameters to be 

controlled by the 8424 console faders.  

When Fader Flip is active, the 8424 faders will move to represent the 

current plugin parameters  

 Moving the fader up will increase the selected parameter value  

 Moving the fader down will decrease the selected parameter value   

 

 

 

Scribble Strip Display Options                                                                                 1 

When entering plugin mode, fader bank 17-24 scribble strip displays are 

used to show the plugin information of the selected Cubase/Nuendo track.  

 

This is the Plugin Select page 

 

There are several modifier shortcuts that flip the scribble strip display to 

show various pages of plugin parameter information listed below.  

Scribble Strip Flip                                                                                                       1 

SHIFT + FLIP - flips the Scribble strip to display plugin Page number 

information rather than parameter names.  

Toggle Display                                                                                                             1 

When plugin parameter names are displayed, pressing SHIFT + Plugin 

toggles the scribble strip display between parameter name and parameter 

value.   

+ 

+ 
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Plugin Select Mode                                                                                                    1 

To select or add a plugin to a Cubase/Nuendo track, the first three VPOTs of 

fader bank 3 (VPOTs 17, 18 & 19) can be used to navigate through insert 

slots, assign and activate plugins.  

 

Fader bank 3 scribble strip (channels 17-24) shows the available options.  

First select the Cubase/Nuendo track using the Channel SEL button  

 

 

Select an Insert slot using VPOT 17  

Turning the VPOT scrolls through IFX slots 1-8 

 

 

 

 

 

Activate the insert using VPOT 18  

Turn the VPOT to switch the insert On/Off 

 

 

 

                              

 

Select Plugin type using VPOT 19 

Turn the VPOT to scroll through available 

plugins 

 

 

 

 

Insert FX Slot 

Insert FX 

On/Off 

Plugin Name 

(This can spread across multiple scribble strip 

displays) 

On 

Off 
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Plugin Edit Mode.                                                                                                       1 

once a plugin has been selected or added using the steps above, press SHIFT 

+ Channel > to navigate to the plugin edit pages 2-4.  

 

In Plugin Edit mode, the scribble strips will change to display available 

parameter names  

 

Plugin parameter values can be displayed by using the Toggle Display 

feature.  

 

The number of parameters varies between plugins. If there are more 

parameters available than available console VPOTS/Faders, SHIFT +Channel 

< > can be used to scroll through plugin parameter pages  

In the example below the Cubase Studio EQ has 21 available parameters 

spread across 21 VPOTS or faders when in Flip mode.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

+ 

+ 

VPOTs 

4-8 

Band 1 

VPOTs 

9-12 

Band 2 

VPOTs 

13-16 

Band 3 

VPOTs 

17-21 

Band 4 

VPOTs 

1-3 

Master 
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Adjusting Plugin Parameters                                                                                   1 

The LED indicator on the Trim VPOT matches the current position of the 

plugin parameter value 

 

 

 

 

 

 

 

Turn the encoder clockwise to increase the parameter 

value  

 

 

 

 

 

 

Turn the encoder counter-clockwise to decrease the  

parameter value 

 

 

 

 

 

VPOT fine/course adjustment                                                                                 1 

By default, VPOT adjustment is set to fine increments, to increase the 

encoder speed to course adjustment (x5 speed) press and hold SHIFT while 

moving the VPOT encoder.  

 

+ 

FLIP Mode 

FLIP Mode 

TIP: 

Firmware version 7.10+ flips SHIFT + VPOT functionality.  

The default VPOT motion is set to coarse increments (x5 speed) 

Fine increments are adjusted via SHIFT +VPOT motion  

Visit www.ams-neve.com/consoles/small-format-consoles/neve-

8424/#Moreinfo to download the latest firmware and see 

Firmware Updater app for installation instructions.  

http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo
http://www.ams-neve.com/consoles/small-format-consoles/neve-8424/#Moreinfo


                                                                                                                                           186 
 

 

Active Faders                                                                                                     1  

Introduction                                                                                                                1 

Active Faders is an automation system that provides the capability of 

automating the 24 channel analogue fader levels directly from within the 

DAW. This feature functions in the same way as a standalone flying fader 

system such as Neve Encore automation, but has the benefits of direct DAW 

control, meaning that all automation lanes are contained within the 

associated DAW session.  

This feature is activated on console firmware versions 7.9 and above 

Supported DAWs                                                                                                        1 

Active Faders will be functional for all supported DAW’s including pro Tools, 

Logic, Cubase, Nuendo, Ableton, Studio One, and UA Luna.  

For the purposes of this user manual, all examples will use Pro Tools and 

will assume a full 24 DAW channel count.  

Session Setup                                                                                                              1 

Active Faders transposes the fader positions from the DAW onto the 

analogue layer of the console, it is not recommended to enter active fader 

mode before setting up your session correctly.  

In order to preserve correct gain staging between the DAW and 8424 

console, a pre-fade send must be added to each DAW channel, The send 

must be set as an audio interface output rather than a bus. 

 

 

Set the send to pre-fade and the level to 0. The send bypasses the DAW 

fader, carrying the audio through the audio interface output and into the 

8424 channel.   

 

Since audio is routed from the DAW channel via the send, the DAW channel 

output can now be set to ‘no output’ 

 

The DAW fader will appear greyed out as it is no longer controlling DAW 

channel output levels. Instead, it will now be used to control the 8424 fader 

positions for automation.   

 

Any plugin processing applied to the channel will be included in the signal 

chain and sent through the pre-fade send.   
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DAW Channel Setup Diagram                                                                                  1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

DAW channel audio is sent as a 

pre fade send into the 8424 

channel audio path 

Console Fader motions are 

reflected in the DAW and      

vice versa without affecting the 

DAW channel output level 

DAW plugin processing is 

included in the audio signal 

chain 

Pre-fade send set to 0.0 and 

routed to audio interface 

output 

DAW channel output set to ‘no 

output’ as audio is routed from 

pre fade send into the console 
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Entering Active Fader Mode                                                                                    1 

Once the DAW session has been set up following the steps above, Active 

Fader mode can be engaged.  

Upon first pressing Active Faders, all 24 8424 console faders will jump to 

match the positions of the DAW faders.  

Active Faders will flash for 3 seconds, during this time you cannot exit Active 

Fader mode. 

When working on large sessions, it is possible that the DAW fader focus 

has banked to adjacent DAW channels before entering Active Fader mode. 

To ensure that the correct DAW faders are in focus for the 8424 Active 

Fader mode, see Fader Banking  

Fader Snap                                                                                                                   1 

Depending on your workflow, the current DAW fader positions may be a 

where you want to begin your mix, however, you may wish to preserve your 

8424 fader positions and analogue levels.  

The fader snap feature takes a snapshot of the consoles fader positions just 

before entering Active Fader mode. This quick shortcut refreshes the faders 

to their previous positions and the DAW faders will lock to the new position.  

Press SHIFT + ACTIVE FADERS to activate Fader Snap. 

This shortcut can be pressed at any time while Active Faders is engaged, 

providing an ‘undo’ feature to return the faders to previously set levels.  

Automatable features                                                                                               1 

In addition to the linked DAW>Console faders in Active Fader mode console 

cut and DAW Mute are also linked. This allows for fader movements and 

console cuts to follow DAW timeline automation.  

Non-Automatable Features                                                                                     1 

Channel solos are not linked to DAW solos in Active Fader mode. Pressing a 

console solo will activate solo as before, but will not engage the DAW solo, 

DAW solo is not automatable from the console surface.  

It is not recommended to press DAW solos when in Active Fader mode, 

this will cause the console CUTs to activate intermittently. 

Writing automation                                                                                                   1 

When Active Fader mode is engaged, analogue fader automation is achieved 

in the same way as writing DAW fader automation from the console faders.  

The AUTOMATION button is used as a modifier key in conjunction with 

channel SEL buttons.  

When AUTOMATION is pressed and illuminated Green, the DAW channel 

SEL button can be pressed to toggle through the available Pro Tools 

automation modes for that channel.  

Each press of SEL toggles one option at a time on the selected channel 

through Pro Tools off, read, touch, latch, and write automation modes.  

Once selected press Play on the console transport bar to write automation 

moves from the console faders.  

+ 

+ 
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To globally toggle automation modes for all Pro Tools channels, press and 

hold the keyboard ALT/Option button then follow the steps above.  

Once automation modes are engaged, pressing Play on the transport bar will 

allow automation moves to be recorded from the console faders into the 

DAW timeline.  

Editing automation                                                                                                    1 

Automation information will appear within the edit window on the DAW 

channel ‘volume’ timeline.  

Once Automation has been written onto the timeline, edits can be made 

using the DAW’s powerful automation tools. Automation can be manually 

drawn or trimmed using the available edit window tools.  

The DAW is now the host session for the 8424 console analogue fader 

automation. Each time the session is loaded, and Active Faders is engaged, 

automation moves from the DAW timeline will affect analogue fader 

positions.  

For further information on automation controls consult your DAW User 

Manual. 

Fader Grouping                                                                                                           1 

In Active Fader mode, analogue fader positions are linked to the DAW 

positions, this allows for fader grouping of analogue levels by using the DAW 

fader grouping features. Channels can be stereo linked or grouped easily, 

with relative fader positions maintained within each group.  Fader groups 

are setup through the DAW group activation window.  

For further information on fader grouping consult your DAW User Manual  

Note: Fader grouping interferes with the Fader Snap feature, if fader 

groups are active, fader snap may not function correctly. 

Fader Banking                                                                                                             1 

In active Fader mode, fader banking (Bank or Channel) is disabled. This 

prevents accidental fader jumps.  

Fader banking is generally destructive during Active Fader mode, however, if 

fader banking is required to shift fader focus to the correct DAW channels, a 

shortcut is provided to enable the banking feature.  

CTRL + BANK/CHANNEL </> will temporarily override the banking lockout 

and allow for fader banking during Active Fader mode.    + / 



                                                                                                                                           190 
 

 

 Abbreviations & Acronyms                                                                            1  
 

48 MIX  

 

48 Mix Mode 

500 1/2  500 series slots 1/2 

500-1 500 series Slot 1 

500-2 500 series Slot 2 

AD Analogue to Digital Converter 

AFL After Fader Listen 

CH 

CUE 

Channel 

Cue send  

CUE O/P L+R Cue Output Left and Right 

CUE TB Cue Talkback 

DA Digital to Analogue Converter 

DAW Digital Audio Workstation 

DIR Direct output 

DIR PRE Direct output pre fader 

EHP  Engineer Headphones 

EXT External 

FNC Function 

GRP  Group 

I MON Ipod External 3.5mm minijack 

I/P  Input 

MTR 

ILM  

Meter 

In Line Mode 

INS  Insert 

ISO Isolate 

INJ Inject 

L/S Loudspeaker 

M1 Monitor 1 

M2 Monitor 2 

O/P Output 

PFL Pre-Fader Listen 

REV  Reverb  

RTB Return Talkback 

SIP 

ST CUE 

Solo in Place 

Stereo Cue  

TB Talkback 

THR Threshold 
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 Dimensions & Power Requirements                                                            1 

Console Physical / Technical Information 

Height 

To top of LS Shelf (No Stand) 

500mm/19.68 inches 

Height  

To Top of LS Shelf (With Stand) 

990mm/38.98 inches 

Width (24 Channel) 1190mm/46.85 inches 

Depth (24 Channel) 850mm/33.46 inches 

Weight (no stand) 53kg 

Weight (with stand) 64kg 

Console Weight (with packaging) 84kg 

Stand weight (with packaging) 12kg 

Heat Dissipation 225 watts 

Power factor   >0.87 

Voltage Input Voltage Range 

90-240v AC Only 

Current  

Amps RMS 240v 

1.1A 

Current 

Amps RMS 90v 

2.3A 

Current 
Switch-On surge current - 4 amps for 7ms 

(average) 

 

Fuse Ratings 
AC Fuses  

Main IEC input fuse T4.0A H250v 

DC Fuses  

+16V T6.3A 250v 

-16V T6.3A 250v 

+5V T16A 250v 

+48V T500mA 250v 
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 Console Rear Connections                                                                             1 

 

Power Unit 

 

Channel Inputs 

 



                                                                                                                                           193 
 

 

Master Outs 

 

 

Monitor connections 
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 Console Connection Tables                                                                            1 

Main  

Console AC Mains, fused @ 4 amps IEC males 

Channel Line Inputs B ¼" TRS Jack sockets 

Channel DAW Return Input A 25-way D-Type, Tascam convention 

Channel Input C 25-way D-Type, Tascam convention 

Channel Insert Send ¼’’ TRS jack sockets 

Channel Insert Return ¼’’ TRS jack sockets 

Channel Direct Output  25-way D-Type, Tascam convention 

Main Mix A LS Output XLR 3-pin plug male 

Main Mix M1 LS Output XLR 3-pin plug male 

Main Mix M2 LS Output XLR 3-pin plug male 

500 Series Input 1 + 2  XLR 3-pin plug female 

500 Series Output 1 + 2 XLR 3-pin plug male 

External monitor L/R  XLR 3-pin plug female 

Mix Buss INJ L/R XLR 3-pin plug female 

1073 Mic Input 1 + 2 XLR 3-pin plug female 

1073 Line Input 1 + 2 XLR 3-pin plug female 

1073 Output 1 + 2 XLR 3-pin plug male 

Reverb Returns 1+2 L/R XLR 3-pin plug female 

Return Talkback Mic  XLR 3-pin plug female 

DC Remotes 15-way D-type 

2T VU MTR 15-way D-type 

Cue output L/R XLR 3-pin plug male 

Aux 1-3 output  XLR 3-pin plug male 

Return Talkback Output XLR 3-pin plug male 

Mix output L/R  XLR 3-pin plug male 

Mix Insert Send L/R  XLR 3-pin plug male 

Mix Insert Return L/R XLR 3-pin plug female 

Group 1-4 outputs XLR 3-pin plug male 

Group 1-4 Insert Sends ¼’’ TRS jack sockets 

Group 1-4 Insert Returns ¼’’ TRS jack sockets 

Computer Connection 1 Cat 5/6 ethernet Socket 

Computer Connection 2 USB A Socket 
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Channel Input A/DAW Returns 1-24 D-Type 25-Way Pin Outs                                                                                                                       
CH DAW RET I/P A 1-8 (25-way D-type) 

Signal Name 

 Pin  

Hi Lo Screen 

1 I/P A Input 1/DAW Return 1 24 12 25 

2 I/P A Input 2/DAW Return 2 10 23 11 

3 I/P A Input 3/DAW Return 3 21 9 22 

4 I/P A Input 4/DAW Return 4 7 20 8 

5 I/P A Input 5/DAW Return 5 18 6 19 

6 I/P A Input 6/DAW Return 6 4 17 5 

7 I/P A Input 7/DAW Return 7 15 3 16 

8 I/P A Input 8/DAW Return 8 1 14 2 

 

 

CH DAW RET I/P A 9-16 (25-way D-type) 

Signal Name 

 Pin  

Hi Lo Screen 

1 I/P A Input 9/DAW Return 9 24 12 25 

2 I/P A Input 10/DAW Return 10 10 23 11 

3 I/P A Input 11/DAW Return 11 21 9 22 

4 I/P A Input 12/DAW Return 12 7 20 8 

5 I/P A Input 13/DAW Return 13 18 6 19 

6 I/P A Input 14/DAW Return 14 4 17 5 

7 I/P A Input 15/DAW Return 15 15 3 16 

8 I/P A Input 16/DAW Return 16 1 14 2 

 

 

CH DAW RET I/P A 17-24 (25-way D-type) 

Signal Name 

 Pin  

Hi Lo Screen 

1 I/P A Input 17/DAW Return 17 24 12 25 

2 I/P A Input 18/DAW Return 18 10 23 11 

3 I/P A Input 19/DAW Return 19 21 9 22 

4 I/P A Input 20/DAW Return 20 7 20 8 

5 I/P A Input 21/DAW Return 21 18 6 19 

6 I/P A Input 22/DAW Return 22 4 17 5 

7 I/P A Input 23/DAW Return 23 15 3 16 

8 I/P A Input 24/DAW Return 24 1 14 2 
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Channel Input C/DAW Returns 16-48 D-Type 25-Way Pin Outs                                                                                                                        

Input C 1-8 (25-way D-type) 

Signal Name 

 Pin  

Hi Lo Screen 

1  I/P C Input 1/DAW return 25 24 12 25 

2  I/P C Input 2/DAW return 26 10 23 11 

3  I/P C Input 3/DAW return 27 21 9 22 

4  I/P C Input 4/DAW return 28 7 20 8 

5  I/P C Input 5/DAW return 29 18 6 19 

6  I/P C Input 6/DAW return 30 4 17 5 

7  I/P C Input 7/DAW return 31 15 3 16 

8  I/P C Input 8/DAW return 32 1 14 2 

 

Input C 9-16 (25-way D-type) 
 

Signal Name 

 Pin  

Hi Lo Screen 

1  I/P C Input 9/DAW return 33 24 12 25 

2  I/P C Input 10/DAW return 34 10 23 11 

3  I/P C Input 11/DAW return 35 21 9 22 

4  I/P C Input 12/DAW return 36 7 20 8 

5  I/P C Input 13/DAW return 37 18 6 19 

6  I/P C Input 14/DAW return 38 4 17 5 

7  I/P C Input 15/DAW return 39 15 3 16 

8  I/P C Input 16/DAW return 40 1 14 2 

 

 

Input C 17-24 (25-way D-type) 

Signal Name 

 Pin  

Hi Lo Screen 

1  I/P C Input 17/DAW return 41 24 12 25 

2  I/P C Input 18/DAW return 42 10 23 11 

3  I/P C Input 19/DAW return 43 21 9 22 

4  I/P C Input 20/DAW return 44 7 20 8 

5  I/P C Input 21/DAW return 45 18 6 19 

6  I/P C Input 22/DAW return 46 4 17 5 

7  I/P C Input 23/DAW return 47 15 3 16 

8  I/P C Input 24/DAW return 48 1 14 2 
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Channel 1-24 Direct Outputs D-Type 25-way Pin Outs 
Direct outputs 1-8 (25-way D-type) 

Signal Name 

 Pin  

Hi Lo Screen 

1 Direct Out Channel 1 24 12 25 

2 Direct Out Channel 2 10 23 11 

3 Direct Out Channel 3 21 9 22 

4 Direct Out Channel 4 7 20 8 

5 Direct Out Channel 5 18 6 19 

6 Direct Out Channel 6 4 17 5 

7 Direct Out Channel 7 15 3 16 

8 Direct Out Channel 8 1 14 2 

 

 

Direct outputs 9-16 (25-way D-type) 

Signal Name 

 Pin  

Hi Lo Screen 

1 Direct Out Channel 9 24 12 25 

2 Direct Out Channel 10 10 23 11 

3 Direct Out Channel 11 21 9 22 

4 Direct Out Channel 12 7 20 8 

5 Direct Out Channel 13 18 6 19 

6 Direct Out Channel 14 4 17 5 

7 Direct Out Channel 15 15 3 16 

8 Direct Out Channel 16 1 14 2 

 

 

Direct outputs 17-24 (25-way D-type) 

Signal Name 

 Pin  

Hi Lo Screen 

1 Direct Out Channel 17 24 12 25 

2 Direct Out Channel 18 10 23 11 

3 Direct Out Channel 19 21 9 22 

4 Direct Out Channel 20 7 20 8 

5 Direct Out Channel 21 18 6 19 

6 Direct Out Channel 22 4 17 5 

7 Direct Out Channel 23 15 3 16 

8 Direct Out Channel 24 1 14 2 
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Line Inputs & Outputs 

All ¼’’ Line Inputs & Outputs on the Console have the same wiring 

Tip Hot  

Ring Cold 

Sleeve Ground 

XLR Inputs & Outputs 

All XLR Inputs & Outputs on the Console have the same wiring 
 

Pin 2 Hot 

Pin 3 Cold 

Pin 1 Ground 

 

DC remote Pin Out Functions 
 (15-way D-type) 

Pin 1 Producers Sofa Mic Remote Talkback Switch  

Pin 2 Remote Loudspeaker Dim  

Pin 3 Remote Loudspeaker Cut These pins require closure  

Pin 4 Engineers Talkback Footswitch to pin 8 to operate 

Pin 5 External Return Talkback Switch   

Pin 6 5v Supply for Producer talkback switch  

Pin 8 Ground (Digital)  

Pin 7, 9, 10, 11, 12, 13, 14, 15 Not in Use  

 

2T VU MTR Pin Out Functions 
(15-way D-type) 

Signal Name 

 Pin  

Hi Lo Screen 

1 VU Meter 1 7 15 8 

2 VU Meter 2 13 6 14 

3 Not in Use 5 4 12 

4 Talkback Output 1 9 2 

5 +4dB Oscillator Output 10 3 11 
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 8424 Audio Specification                                                                               1       

Line Input B to Direct Output 

Headroom +27.7dBu @ 1kHz (<0.5% THD+N)  

Frequency Response Typically +/- 0.1dBu, 20Hz to 20kHz       

Distortion (THD+N) Typically 0.004% @ 1kHz (measured at +10dBu 10Hz to 80kHz filter) 

Noise  <-88dBu (20Hz to 22kHz filter) 

 Input C to Cue Bus Output 

Headroom +27.6dBu @ 1kHz (<0.5% THD+N)  

Frequency Response Typically +/- 0.1dBu, 20Hz to 20kHz  

Distortion (THD+N) Typically 0.005% @ 1kHz (measured at +20dBu, 10Hz to 80kHz filter) 

Noise <-86dBu (20Hz to 22kHz filter) 

 1073 Input to 1073 Output 

Headroom +28.8dBu @ 1kHz (<0.5% THD+N)  

Frequency Response Typically +/- 0.1dB, 20Hz to 20kHz 

Distortion (THD+N) Typically 0.005% @ 1kHz (measured at +20dBu, 10Hz to 80kHz filter) 

Noise (EIN) <-125.5dBu (20Hz to 22kHz filter, 60dB gain, input terminated 150Ω R) 

 Line B to Mix Output 

Headroom +27.4dBu @ 1kHz (<0.5% THD+N)  

Frequency Response Typically +/- 0.1dBu, 20Hz to 20kHz      

Distortion (THD+N) Typically 0.004% @ 1kHz (measured at +10dBu, 10Hz to 80kHz filter) 

 

Noise 

 

<-85dBu (20Hz to 20kHz filter, no channel routed) 

<-84dBu (20Hz to 22kHz filter, 1 channel routed) 

<-80dBu (20Hz to 22kHz filter, 24 channels routed) 

 Line B to Group Mix Output 

Headroom +27.8dBu @ 1kHz (<0.5% THD+N)  

Frequency Response Typically +/- 0.1dBu, 20Hz to 20kHz  

Distortion (THD+N) Typically 0.005% @ 1kHz (measured at +20dBu, 10Hz to 80kHz filter) 

Noise 
<-90dBu (20Hz to 22kHz filter, no channel routed) 

<-87dBu (20Hz to 22kHz filter, 1 channel routed) 

 Line B to Aux Mix Output 

Headroom +27.8dBu @ 1kHz (<0.5% THD+N)  

Frequency Response Typically +/- 0.1dBu, 20Hz to 20kHz  

Distortion (THD+N) Typically 0.003% @ 1kHz (measured at +20dBu, 10Hz to 80kHz filter) 

Noise 
<-92dBu (20Hz to 22kHz filter, no channel routed) 

<-88dBu (20Hz to 22kHz filter, 1 channel routed) 
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 General Specifications                                                                                    1  
 

                                                                         1073 to Channels 17 & 18 

Headroom +27.7dBu @ 1kHz (<0.5% THD+N) 

Frequency Response Typically +/- 0.1dBu, 20Hz to 20kHz 

Distortion (THD+N) Typically 0.003% @ 1kHz (measured at +20dBu, 10Hz to 80kHz filter) 

Noise <-87dBu (20Hz to 22kHz filter) 

 

               DI to Channels 19 & 20 

Headroom >+27.7dBu @ 1kHz (<0.5% THD+N)  

Frequency Response Typically +/- 0.1dBu, 20Hz to 20kHz  

Distortion (THD+N) Typically 0.004% @ 1kHz (measured at +20dBu, 10Hz to 80kHz filter) 

Noise <-87dBu (20Hz to 22kHz filter) 

 

               Control Room Output feed from Main Mix 

Headroom >+26.5dBu @ 1kHz (<0.5% THD+N)  

Frequency Response Typically +/- 0.1dBu, 20Hz to 20kHz  

Distortion (THD+N) Typically 0.002% @ 1kHz (measured at +20dBu, 10Hz to 80kHz filter) 

Noise <-87dBu (20Hz to 22kHz filter) 

 

Crosstalk 

Inter-channel 

crosstalk 

<100dBu @ 1kHz 

Mix bus Crosstalk <100dBu @ 1kHz 

Group bus Crosstalk <100dBu @ 1kHz 

Aux Mix bus Crosstalk <100dBu @ 1kHz 
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 Dimensions & Exigences Alimentation                                                       1 

Informations Physiques/Techniques de la Console  

Hauteur 

Jusqu’en haut du plateau pour HP (Sans Support) 

500mm/19.68 pouces 

Hauteur 

Jusqu’en haut du plateau pour HP (Avec Support) 

990mm/38.98 pouces 

Largeur (24 Canaux) 1190mm/46.85 pouces 

Profondeur (24 Canaux) 850mm/33.46 pouces 

Poids (Sans Support) 53kg 

Poids (Avec Support) 64kg 

Poids de la Console (avec emballage) 84kg 

Poids du Support (avec emballage) 12kg 

Dissipation de Chaleur 225 watts 

Facteur de Puissance   >0.87 

Voltage Voltage Entrée 

90-240v CA Uniquement 

Intensité 

Ampères RMS 240v 

1.1A 

Intensité 

Ampères RMS 90v 

2.3A 

Intensité 
Pic à l’allumage – 4A pendant 7ms 

(environ) 

 

Fusibles 
Fusibles CA  

Fusible Prise Principale IEC T4.0A H250v 

Fusibles CC  

+16V T6.3A 250v 

-16V T6.3A 250v 

+5V T16A 250v 

+48V T500mA 250v 
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 Console : Connexions Arrières                                                                      1 

 

Alimentation 

 

Canaux d’entrée 
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Sorties Principales 

 

 

Connexions de Contrôle 
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 Console : Table de Connexions                     1 

Principale 

Alimentation Principale Console, fusible @ 

4A 

IEC mâles 

Channel Line Inputs B  

(Canaux Entrées Ligne B) 

Jack TRS 6.35mm 

Channel DAW Return Input A  

(Retour Entrée Canal DAW A) 

Type D 25 broches, convention Tascam  

Channel Input C  

(Canal Entrée C) 

Type D 25 broches, convention Tascam  

Channel Insert Send  

(Canal Emission) 

Jack TRS 6.35mm 

Channel Insert Return  

(Canal Retour) 

Jack TRS 6.35mm 

Channel Direct Output  

(Canal Sortie Directe) 

Type D 25 broches, convention Tascam  

Main Mix A LS Output  

(Sortie Principale Mix A LS) 

XLR fiche 3 broches mâle 

Main Mix M1 LS Output  

(Sortie Principale M1 LS) 

XLR fiche 3 broches mâle 

Main Mix M2 LS Output  

(Sortie Principale M2 LS) 

XLR fiche 3 broches mâle 

500 Series Input 1 + 2  

(Série 500 Entrée 1 + 2) 

XLR fiche 3 broches femelle 

500 Series Output 1 + 2  

(Série 500 Sortie 1 + 2) 

XLR fiche 3 broches mâle 

External monitor L/R  

(Contrôle Externe G/D) 

XLR fiche 3 broches femelle 

Mix Buss INJ L/R  

(Bus Mix INJ G/D) 

XLR fiche 3 broches femelle 

1073 Mic Input 1 + 2  

(1073 Entrée Micro 1 + 2) 

XLR fiche 3 broches femelle 

1073 Line Input 1 + 2  

(1073 Entrée Ligne 1 + 2) 

XLR fiche 3 broches femelle 

1073 Output 1 + 2  

(1073 Sortie 1 + 2) 

XLR fiche 3 broches mâle 

Reverb Returns 1+2 L/R  

(Retours de Réverb 1+2 G/D) 

XLR fiche 3 broches femelle 

Return Talkback Mic  

(Retour de Talkback Micro) 

XLR fiche 3 broches femelle 

DC Remotes  

(Interrupteur Alimentation CC Distante) 

Type D 15 broches 

2T VU MTR  

(2T VUmètre) 

 

Type D 15 broches 
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Cue output L/R  

(Sortie Artiste G/D) 

XLR fiche 3 broches mâle 

Aux 1-3 output  

(Sortie Aux. 1-3) 

XLR fiche 3 broches mâle 

Return Talkback Output  

(Sortie de Retour Talkback) 

XLR fiche 3 broches mâle 

Mix output L/R  

(Sortie Mix G/D) 

XLR fiche 3 broches mâle 

Mix Insert Send L/R  

(Envoi Insertion Mix G/D) 

XLR fiche 3 broches mâle 

Mix Insert Return L/R  

(Retour Insertion Mix G/D) 

XLR fiche 3 broches femelle 

Group 1-4 outputs  

(Sorties Groupe 1-4) 

XLR fiche 3 broches mâle 

Group 1-4 Insert Sends  

(Envois Insertion Groupe 1-4) 

Jack TRS 6.35mm 

Group 1-4 Insert Returns  

(Retours Insertion Groupe 1-4) 

Jack TRS 6.35mm 

Computer Connection 1  

(Connexion Ordinateur 1) 

Port Ethernet Cat 5/6 ethernet 

Computer Connection 2  

(Connexion Ordinateur 2) 

Port USB A 

 

 

 

Canaux d’entrée A/DAW Retours 1-24 (Type D 25 Broches) : Brochages 
CH DAW RET I/P A 1-8 (Type D 25 Broches) 

Signal Nom 

 Broche  

Pointe Bague Corps 

1 I/P A Entrée 1/DAW Retour 1 24 12 25 

2 I/P A Entrée 2/DAW Retour 2 10 23 11 

3 I/P A Entrée 3/DAW Retour 3 21 9 22 

4 I/P A Entrée 4/DAW Retour 4 7 20 8 

5 I/P A Entrée 5/DAW Retour 5 18 6 19 

6 I/P A Entrée 6/DAW Retour 6 4 17 5 

7 I/P A Entrée 7/DAW Retour 7 15 3 16 

8 I/P A Entrée 8/DAW Retour 8 1 14 2 
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CH DAW RET I/P A 9-16 (Type D 25 Broches) 

Signal Nom 

 Broche  

Pointe Bague Corps 

1 I/P A Entrée 9/DAW Retour 9 24 12 25 

2 I/P A Entrée 10/DAW Retour 10 10 23 11 

3 I/P A Entrée 11/DAW Retour 11 21 9 22 

4 I/P A Entrée 12/DAW Retour 12 7 20 8 

5 I/P A Entrée 13/DAW Retour 13 18 6 19 

6 I/P A Entrée 14/DAW Retour 14 4 17 5 

7 I/P A Entrée 15/DAW Retour 15 15 3 16 

8 I/P A Entrée 16/DAW Retour 16 1 14 2 

 

 

CH DAW RET I/P A 17-24 (Type D 25 Broches) 

Signal Nom 

 Broche  

Pointe Bague Corps 

1 I/P A Entrée 17/DAW Retour 17 24 12 25 

2 I/P A Entrée 18/DAW Retour 18 10 23 11 

3 I/P A Entrée 19/DAW Retour 19 21 9 22 

4 I/P A Entrée 20/DAW Retour 20 7 20 8 

5 I/P A Entrée 21/DAW Retour 21 18 6 19 

6 I/P A Entrée 22/DAW Retour 22 4 17 5 

7 I/P A Entrée 23/DAW Retour 23 15 3 16 

8 I/P A Entrée 24/DAW Retour 24 1 14 2 

 

Canaux d’entrée C/DAW Retours 16-48 (Type D 25 Broches) : Brochages  

Input C 1-8 (Type D 25 Broches) 

Signal Nom 

 Broche  

Pointe Bague Corps 

1  I/P C Entrée 1/DAW Retour 25 24 12 25 

2  I/P C Entrée 2/DAW Retour 26 10 23 11 

3  I/P C Entrée 3/DAW Retour 27 21 9 22 

4  I/P C Entrée 4/DAW Retour 28 7 20 8 

5  I/P C Entrée 5/DAW Retour 29 18 6 19 

6  I/P C Entrée 6/DAW Retour 30 4 17 5 

7  I/P C Entrée 7/DAW Retour 31 15 3 16 

8  I/P C Entrée 8/DAW Retour 32 1 14 2 
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Input C 9-16 (Type D 25 Broches) 
 

Signal Nom 

 Broche  

Pointe Bague Corps 

1  I/P C Entrée 9/DAW Retour 33 24 12 25 

2  I/P C Entrée 10/DAW Retour 34 10 23 11 

3  I/P C Entrée 11/DAW Retour 35 21 9 22 

4  I/P C Entrée 12/DAW Retour 36 7 20 8 

5  I/P C Entrée 13/DAW Retour 37 18 6 19 

6  I/P C Entrée 14/DAW Retour 38 4 17 5 

7  I/P C Entrée 15/DAW Retour 39 15 3 16 

8  I/P C Entrée 16/DAW Retour 40 1 14 2 

 

 

Input C 17-24 (Type D 25 Broches) 

Signal Nom 

 Broche  

Pointe Bague Corps 

1  I/P C Entrée 17/DAW Retour 41 24 12 25 

2  I/P C Entrée 18/DAW Retour 42 10 23 11 

3  I/P C Entrée 19/DAW Retour 43 21 9 22 

4  I/P C Entrée 20/DAW Retour 44 7 20 8 

5  I/P C Entrée 21/DAW Retour 45 18 6 19 

6  I/P C Entrée 22/DAW Retour 46 4 17 5 

7  I/P C Entrée 23/DAW Retour 47 15 3 16 

8  I/P C Entrée 24/DAW Retour 48 1 14 2 

Canaux 1-24 Sorties Directes (Direct Outputs) (D Type D 25 Broches) : 

Brochages 
Direct outputs 1-8 (Type D 25 Broches) 

Signal Nom 

 Broche  

Pointe Bague Corps 

1 Sortie Directe Canal 1 24 12 25 

2 Sortie Directe Canal 2 10 23 11 

3 Sortie Directe Canal 3 21 9 22 

4 Sortie Directe Canal 4 7 20 8 

5 Sortie Directe Canal 5 18 6 19 

6 Sortie Directe Canal 6 4 17 5 

7 Sortie Directe Canal 7 15 3 16 

8 Sortie Directe Canal 8 1 14 2 
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Direct outputs 9-16 (Type D 25 Broches) 

Signal Nom 

 Broche  

Pointe Bague Corps 

1 Sortie Directe Canal 9 24 12 25 

2 Sortie Directe Canal 10 10 23 11 

3 Sortie Directe Canal 11 21 9 22 

4 Sortie Directe Canal 12 7 20 8 

5 Sortie Directe Canal 13 18 6 19 

6 Sortie Directe Canal 14 4 17 5 

7 Sortie Directe Canal 15 15 3 16 

8 Sortie Directe Canal 16 1 14 2 

 

 

Direct outputs 17-24 (Type D 25 Broches) 

Signal Nom 

 Broche  

Pointe Bague Corps 

1 Sortie Directe Canal 17 24 12 25 

2 Sortie Directe Canal 18 10 23 11 

3 Sortie Directe Canal 19 21 9 22 

4 Sortie Directe Canal 20 7 20 8 

5 Sortie Directe Canal 21 18 6 19 

6 Sortie Directe Canal 22 4 17 5 

7 Sortie Directe Canal 23 15 3 16 

8 Sortie Directe Canal 24 1 14 2 

 

Entrées et Sortie Ligne 

Toutes les entrées & sorties 6.35mm de l’unité ont le même câblage 

 

Pointe Chaud  

Bague Froid 

Corps Masse 

Entrées & Sorties XLR 

Toutes les entrées & sorties XLR de l’unité ont le même câblage 

Point 2 Chaud 

Point 3 Froid 

Point 1 Masse 
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Commande Alimentation à Distance : Brochages 
 (Type D 15 Broches) 

Broche 1 Interrupteur TalkBack distant pour Micro 

Producteur 

 

Broche 2 Estompage hauts-parleurs distants  

Broche 3 Coupure hauts-parleurs distants Ces broches nécessitent 
une liaison à la broche 8 

pour fonctionner 

Broche 4 Pédale de TalkBack techniciens  

Broche 5 Interrupteur de retour externe TalkBack   

Broche 6 Alimentation 5v pour interrupteur de TalkBack 

Producteur 

 

Broche 8 Masse (Digitale)  

Broches 7, 9, 10, 11, 12, 13, 

14, 15 

Non utilisées  

 

2T Vmètre : Brochages 
(Type D 15 Broches) 

Signal Nom 

 Broche  

Pointe Bague Corps 

1 VUmètre 1 7 15 8 

2 VUmètre 2 13 6 14 

3 Non utilisé 5 4 12 

4 Sortie Talkback 1 9 2 

5 +4dB Sortie Oscillateur 10 3 11 
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 8424 Spécifications Audio                                                                              1       

Entrée Ligne B vers Direct Output (sortie directe) 

Marge de sécurité +27.7dBu @ 1kHz (<0.5% THD+N)  

Réponse de Fréquence Généralement +/- 0.1dBu, 20Hz à 20kHz       

Distortion (THD+N) Généralement 0.004% @ 1kHz (mesuré à +10dBu, filtre 10Hz à 80kHz) 

Bruit de fond  <-88dBu (filtre 20Hz à 22kHz) 

 Entrée C vers Cue Bus Output (Sortie Bus Artiste) 

Marge de sécurité +27.6dBu @ 1kHz (<0.5% THD+N)  

Réponse de Fréquence Généralement +/- 0.1dBu, 20Hz à 20kHz  

Distortion (THD+N) Généralement 0.005% @ 1kHz (mesuré à +20dBu, filtre 10Hz à 80kHz) 

Bruit de fond <-86dBu (filtre 20Hz à 22kHz) 

 Entrée 1073 vers Sortie 1073 

Marge de sécurité +28.8dBu @ 1kHz (<0.5% THD+N)  

Réponse de Fréquence Généralement +/- 0.1dB, 20Hz à 20kHz 

Distortion (THD+N) Généralement 0.005% @ 1kHz (mesuré à +20dBu, filtre 10Hz à 80kHz) 

Bruit de fond (EIN) <-125.5dBu (filtre 20Hz à 22kHz, 60dB gain, entrée terminée 150Ω R) 

 Ligne B vers Mix Output (Sortie Mix) 

Marge de sécurité +27.4dBu @ 1kHz (<0.5% THD+N)  

Réponse de Fréquence Généralement +/- 0.1dBu, 20Hz à 20kHz      

Distortion (THD+N) Généralement 0.004% @ 1kHz (mesuré à +10dBu, filtre 10Hz à 80kHz) 

 

Bruit de fond  

<-85dBu (20Hz à 20kHz filter, aucun canal affecté) 

<-84dBu (20Hz à 22kHz filter, 1 canal affecté) 

<-80dBu (20Hz à 22kHz filter, 24 canaux affectés) 

 Ligne B vers Group Mix Output (Sortie Mix Groupe) 

Marge de sécurité +27.8dBu @ 1kHz (<0.5% THD+N)  

Réponse de Fréquence Généralement +/- 0.1dBu, 20Hz à 20kHz  

Distortion (THD+N) Généralement 0.005% @ 1kHz (mesuré à +20dBu, filtre 10Hz à 80kHz) 

Bruit de fond 
<-90dBu (filtre 20Hz à 22kHz, aucun canal affecté) 

<-87dBu (filtre 20Hz à 22kHz, 1 canal affecté) 

 Ligne B vers Aux Mix Output (Sortie Mix Aux.) 

Marge de sécurité +27.8dBu @ 1kHz (<0.5% THD+N)  

Réponse de Fréquence Généralement +/- 0.1dBu, 20Hz à 20kHz  

Distortion (THD+N) Généralement 0.003% @ 1kHz (mesuré à +20dBu, filtre 10Hz à 80kHz) 

Bruit de fond 
<-92dBu (filtre 20Hz à 22kHz, aucun canal affecté) 

<-88dBu (filtre 20Hz à 22kHz, 1 canal affecté) 
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 Spécifications Générales                                                                                1  
 

                                                                    1073 vers Canaux 17 & 18 

Marge de sécurité +27.7dBu @ 1kHz (<0.5% THD+N) 

Réponse de Fréquence Généralement +/- 0.1dBu, 20Hz à 20kHz 

Distortion (THD+N) Généralement 0.003% @ 1kHz (mesuré à +20dBu, filtre 10Hz à 80kHz) 

Bruit de fond <-87dBu (filtre 20Hz à 22kHz) 

 

          DI (entrée directe) vers Canaux 19 & 20 

Marge de sécurité >+27.7dBu @ 1kHz (<0.5% THD+N)  

Réponse de Fréquence Généralement +/- 0.1dBu, 20Hz à 20kHz  

Distortion (THD+N) Généralement 0.004% @ 1kHz (mesuré à +20dBu, filtre 10Hz à 80kHz) 

Bruit de fond <-87dBu (filtre 20Hz à 22kHz) 

 

 Control Room Output feed from Main Mix 

(Sortie Pièce de Contrôle alimentée via Mix Principal) 

Marge de sécurité >+26.5dBu @ 1kHz (<0.5% THD+N)  

Réponse de Fréquence Généralement +/- 0.1dBu, 20Hz à 20kHz  

 

Diaphonie 

Diaphonie inter-canaux <100dBu @ 1kHz 

Diaphone Mix bus <100dBu @ 1kHz 

Diaphonie Group bus <100dBu @ 1kHz 

Diaphonie Aux Mix bus <100dBu @ 1kHz 
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Appendix A – ipMIDI Information                                                                 1  
Terminal Script Instructions for 8424>MAC Manual Connection 

This page contains detailed instructions for 8424 console users connecting to Mac via a direct ethernet 

connection. This setup will allow Wi-Fi and other wired ethernet connections to work alongside console HUI 

data without creating a conflict.   

This section assumes that the IP settings on both Mac and 8424 computer are set as per Manual IP address 

setup at fixed IP addresses of 10.10.251.004 (8424) and 10.10.251.005 (Mac), both with the subnet mask set 

at 255.255.255.0  

IP MIDI uses the default network route as every other application e.g. web browser, this behaviour can cause 

conflicts when using the console HUI and Wi-Fi at the same time. To change this default behaviour, a routing 

table entry for IP Midi multicast address 225.0.0.37 must be made in the Terminal window.  

The quick-fix for this issue is to enter the following command into Terminal-  

sudo route -n add -net 225.0.0 -interface 10.10.251.005 
 

This will work for your current session and your computer Wi-Fi can be enabled while using HUI data. 

However, once you shut down your computer, you will have to enter this command once again. This is 

because Mac route table entries are flushed once the Mac shuts down.  

The final fix for this is a longer process but only needs to be undertaken once. When completed, Wi-fi and 

HUI traffic will be able to send and receive simultaneously on your studio Mac without conflict, permanently.  

Console users working from a networked computer using multiple accounts logins (Educational Facilities) 

may need to access the ROOT administrator to make permanent route table changes accessible by all student 

accounts to the studio DAW computer.  

 

To access the root account- Mac OS 12 (Monterey) or lower  

Enable or disable the root user 
1. Choose Apple menu ( ) > System Preferences, then click Users & Groups (or Accounts).  
2. Click , then enter an administrator name and password.  
3. Click Login Options.  
4. Click Join (or Edit).  
5. Click Open Directory Utility.  
6. Click  in the Directory Utility window, then enter an administrator name and password.  
7. From the menu bar in Directory Utility:  

o Choose Edit > Enable Root User, then enter the password that you want to use for the root user.  
o Or choose Edit > Disable Root User.  

Log in as the root user 
When the root user is enabled, you have the privileges of the root user only while logged in as the root user. 

1. Choose Apple menu > Log Out to log out of your current user account.  
2. At the login window, log in with the user name ”root” and the password you created for the root user. 

Note: If the login window is a list of users, click Other, then log in.                                                             
Remember to disable the root user after completing your task. 

 

 

 

https://uk-prod.asyncgw.teams.microsoft.com/v1/objects/0-wuk-d2-5e424efe6f686c21d44af97794b982e2/views/imgo
https://uk-prod.asyncgw.teams.microsoft.com/v1/objects/0-suk-d1-943da46a034405f7dc286fc86ac833fc/views/imgo
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To access the root account- Mac OS 13 (Ventura) +   

Enable or disable the root user 
Access Directory Utility 
 Use Spotlight to find and open Directory utility, or follow these steps: 

1. From the menu bar in finder, choose Go>Go to Folder.  
2. Type or paste /System/Library/CoreServices/Applications/ , then press return.  
3. Open Directory Utility from the window that opens. 
4. Click  in the Directory Utility window, then enter an administrator name and password.  
5. From the menu bar in Directory Utility:  

o Choose Edit > Enable Root User, then enter the password that you want to use for the root user.  
o Or choose Edit > Disable Root User.  

Log in as the root user 
When the root user is enabled, you have the privileges of the root user only while logged in as the root user. 

1. Choose Apple menu > Log Out to log out of your current user account.  
2. At the login window, log in with the user name ”root” and the password you created for the root user. 

Note: If the login window is a list of users, click Other, then log in.                                                             
Remember to disable the root user after completing your task 

The following instructions can be implemented from either a user admin account (ideal for studio use) or 
from the Root account (ideal for educational facility use)  

 
First you must discover the name and settings of your direct ethernet connection- 
Open Mac>Terminal 

Enter the command – 

 ~ % networksetup -listallnetworkservices  

You should see something like this – 

 

an asterisk (*) denotes that a network service is disabled. 

STARTECH 

USB 10/100/1000 LAN 

Wi-Fi 

Bluetooth PAN 

Thunderbolt Bridge 

In the example above, the ethernet connection is named ‘STARTECH’  

 

 

You now need to find the information from your interface, this is achieved by typing the following 

command-  

 

networksetup -getinfo <name of your ethernet interface>  

 

Example:- 

neve@MacBook-Pro ~ % networksetup -getinfo STARTECH 

 

 

 

 

 

 

https://uk-prod.asyncgw.teams.microsoft.com/v1/objects/0-suk-d1-943da46a034405f7dc286fc86ac833fc/views/imgo
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You should then see a similar info list to the one below–  

 

Manual Configuration 

IP address: 10.10.251.005 

Subnet mask: 255.255.255.0 

Router: (null) 

IPv6: Automatic 

IPv6 IP address: none 

IPv6 Router: none 

Ethernet Address: (null) 

 

 

 

Now we have this information, we can use it to create a persistent static IP route within the Mac 

routing table.  

 

We use the following command to do this  

Networksetup -setadditionalroutes <name of your ethernet interface> <destination> <subnet mask> 

<gateway> 

The above command can now be executed by filling the information found from the previous step-  

In the above example-  

<name of your ethernet interface> = STARTECH 

<destination> = 225.0.0.0 (this is the IP MIDI multicast address) 

<subnet mask> = 255.255.255.0 

<gateway> = 10.10.251.005 

Therefore, the final command entered must be –  

Networksetup -setadditionalroutes STARTECH 225.0.0.0 255.255.255.0 10.10.251.005  

 

We have now set a new static IP entry to the routing table that will remain in place until reassigned from Terminal. 
This will ensure that the IP Midi data is sent from its own dedicated port and remains that way when your computer 
is shut down and rebooted. This data will not cause conflict with Wi-Fi or other ethernet signals, enabling Wi-Fi to be 
active on the DAW computer during mix sessions.  
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Appendix B – Additional DAW Control                                                        1  
 

Ableton  

 
Setup                                                                                                                                                                                                     1 

8424 Console setup  
• Enter Services Screen > System menu > F3 DAW  
• Scroll to and select [ABLETON]  
• Press F3 then DAW Mode to enter Studio One DAW Control  

Ableton Setup  
• Open Preferences, click MIDI, select “MackieControl” for master port 7 
• MackieControlXT” for 8 
• MackieControlXT” for 9 
• Takeover mode:None  
• Only Track ticked on MIDI Ports list 
• When switching from other DAWs, you must open Prefs, and untick 7/8/9 MIDI Ports Track tickbox, then 

re-tick to refresh desk. Ableton does not auto-send/refresh like PT/Logic.  
• Alternatively, you can re-open the session/project. 

Operation                                                                                                                                                                                             1 

• Transport, Solo/Mute/REC/SEL, Pan/Faders, Banking – function similarly to Logic DAW Controller 
Operation 

• FFW/REW are hold functionality 
• SHIFT + FFW/REW go to start/end of timeline 
• AUD toggles between arrangement/Session View toggle 
• IN/OUT Punch-In/Out switch 
• MARKER left/right moves cursor between session markers 
• MARKER MODE + right adds a marker to the timeline, if there is already a marker, the same command will 

delete current marker at cursor position.  
• U1 functions as per Logic DAW Controller Operation 
• Fader Grouping is inactive 
• Pans: 

o Encoders control level (hold Shift for faster control) 
o SHIFT + SEL zero pan position 
o FLIP - flips faders onto encoders, pan level on to faders. 
o SHIFT + FLIP toggles scribble strip track name/pan value 

• Aux/Snd: 
o Encoders control level (hold Shift for faster control) 
o Per channel, press channel SEL to select send group for that channel 
o Max 12 sends/returns per channel 
o FLIP - flips faders onto encoders, send level onto faders. 
o SHIFT + FLIP toggles scribble strip send name/send value 
o In FLIP mode, display shows “Volume” (built-in), press SHIFT+FLIP to toggle to value 

• Plugins: 
o Per channel, press channel SEL to select plugin group to control for that channel 
o Encoders control parameters (hold Shift for faster control) 
o SHIFT + SEL enters plugin edit mode, press PLUGIN again to return to main menu (selection) 
o SHIFT + FLIP toggles track name/plugin value 
o FLIP only works in plugin edit mode, not plugin selection (non-edit mode) 
o In FLIP, display shows “Volume” (built-in), press SHIFT+FLIP to toggle to value 
o SHIFT + CHANNEL <> selects page for larger plugins with more parameters, page numbers not 

available. 
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 PreSonus Studio One 

 
Setup                                                                                                                                                                                                     1 

8424 Console setup  
• Enter Services Screen > System menu > F3 DAW  
• Scroll to and select [STUDIO ONE]  
• Press F3 then DAW Mode to enter Studio One DAW Control  

Studio One Setup  
• Click Studio One in the top menu and select Preferences. 
• Click External Devices. 
• Select Mackie > Control.  Select Receive From to ipMIDI port 7 and Send To ipMIDI port 7. Click OK. 

o Double click on the control just added. Change Device Name to 'Control 1-8'. Click OK. 
o Click Placement. Drag Control 1-8 to Group 1. Click Close. 

• Select Mackie > Control Extender.  Select Receive From to ipMIDI port 8 and Send To ipMIDI port 8. Click OK. 
o Double click on the control just added. Change Device Name to 'Control Extender 9-16'. Click OK. 
o Click Placement. Drag Control Extender 9-16 to right of Control 1-8 in Group 1. Click Close. 

• Select Mackie > Control Extender.  Select Receive From to ipMIDI port 9 and Send To ipMIDI port 9. Click OK. 
o Double click on the control just added. Change Device Name to 'Control Extender 17-24'. Click OK. 
o Click Placement. Drag Control Extender 17-24 to right of Control Extender 9-16 in Group 1. Click 

Close. 
• Click OK. 

Operation                                                                                                                                                                                             1 

• Transport, Solo/Mute/REC/SEL, Pan/Faders, Banking – function similarly to Logic DAW Controller 
Operation 

• Press and Hold Solo/Mute for momentary control 
• AUD toggles Mix/Timeline views 
• PUNCH toggles Auto Punch record mode 
• CLICK toggles Metronome 
• Select a channel using SEL, hold SHIFT & press AUTOMATION to cycle through automation modes. 
• Marker Mode creates a marker 
• Marker left/right scrolls markers 
• U1 functions as per Logic DAW Controller Operation 
• Pans: 

o Encoders control level (hold Shift for faster control) 
o SHIFT + SEL zero pan position 
o FLIP - flips faders onto encoders, pan position onto faders. 

• Aux/Snd: 
o Encoders control level (hold Shift for faster control) 
o SHIFT + SEL resets level. 
o FLIP - flips faders onto encoders, level on to faders. 
o Fader display shows Send name and control layer i.e. "Bus 1 [C]" 
o Pressing Aux/Snd steps through the Send layers [C], [1] to [8]. 
o Layer [C] controls all sends per track/ch, i.e. encoders 1-8 control sends for the selected track. Press 

SEL to select different track. 
o Layers [1] to [8] sends are per track basis, i.e. encoder ch 1 controls send [1] on track 1, encoder 2 

controls send [1] on track 2, or if send layer is [5] then encoder ch 1 controls send [5] on track 1, 
encoder 2 controls send [5] on track 2 and so on. 
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• Plugins: 
o Encoders control parameters (hold Shift for faster control) 
o SHIFT + SEL resets parameter level. 
o FLIP - flips pan position onto encoders, parameter level on to faders. 
o Hold SHIFT + press Plugin to show/hide plugin window. 
o By default, no parameters are assigned to the VPots. These have to be assigned manually via the 

Studio One Control Link setup. To do this: 
▪ In the bottom-right corner of the screen there is a list of items; Input, Output, External, Instr. 

Click on External. 
▪ A side-panel will show, double-click on Control 1-8. The External Devices windows will pop-

up. 
▪ There are 3 tabs, one for each DAW controller assigned earlier. 
▪ With the plugin window pop-up shown and on the Control 1-8 tab, click on the first display 

block (blue) in the External Devices window. 
▪ In the plugin window, right-click on a knob/switch and select the 'Assign "Parameter" to V-

Pot 1 on Control 1-8'. 
▪ Now that parameter is controllable via the assigned VPot from the desk. 
▪ The same setup is applicable to assigning all other/any VPots to parameters on any of the 

controller tabs. 
▪ Pre-assigned parameters can be reassigned via the above method at any time. 

o SHIFT + Bank < > - Cycles through the plugins for the currently selected track (if more than plugin is 
assigned in a single track). 

o SHIFT + Channel < > - Selects previous and next preset in an open plugin editor. 
▪ If the above does not work, close the External Devices window, and using SHIFT + Plugin to 

close, then re-open the plugin window. 

• If switching between DAWs or starting a new DAW session, then DAW control needs to be manually re-
established, unlike PT or Logic Pro where DAW control is auto-established. 

o Open the External Devices window as stated above. 
o For each controller tab in this window there is a drop-down box, click the first one and select Reset. 
o Do the same for 9-16 and 17-24. 
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Universal Audio LUNA  

 
Setup                                                                                                                                                                                                     1 

8424 Console setup  
• Enter Services screen> System menu > F3 DAW 
• Scroll to and select [UA LUNA]  
• Press F3 then DAW Mode to enter LUNA DAW Control  

Studio One Setup  
• Click LUNA menu > Preferences from the app menu 
• Click Controllers 
• Make sure the following is set: 

o Surface shows tracks from: Main Window 
o Bank to selected track: On 
o Scroll Luna when banking: On 
o Show Main track: Off 
o Use surface fader taper: On 

• In the first MIDI Control Surface rows, click under Input Device and select ipMIDI Port 7, in Output Device 
select ipMIDI Port 7 

o Click ON if it's not selected. Make sure Focus Module is Off and Extender is Off 
• Next row, click under Input Device and select ipMIDI Port 8, in Output Device select ipMIDI Port 8 

o Click ON if it's not selected. Make sure Focus Module is Off and Extender is On 
• Next row, click under Input Device and select ipMIDI Port 9, in Output Device select ipMIDI Port 9 

o Click ON if it's not selected. Make sure Focus Module is Off and Extender is On 
• Click LUNA > Preferences from the app menu to exit 

Operation                                                                                                                                                                                             1 

• Transport, Solo/Mute/REC/SEL, Pan/Faders, Banking - Function similarly to Logic DAW Controller 
Operation 

• REW/FFW function as return to zero and go to end of LUNA timeline 
• Select a channel using SEL, hold SHIFT & press Automation to cycle through auto modes 
• AUD toggles mixer/timeline views 
• CLICK toggles Click Enable 
• Marker Mode opens marker browser to name a marker 
• SHIFT + Marker Mode creates the marker 
• Marker left/right scrolls markers 
• U1 function as per Logic DAW Controller Operation 
• Pans: 

o Encoders control level (hold Shift for faster control) 
o SHIFT + SEL resets level. 

• LUNA does not currently support Sends/Plugins control 

• If switching between DAWs or starting a new DAW session, then DAW control needs to be manually re-
established, unlike PT or Logic Pro where DAW control is auto-established. 

o Click LUNA menu > Preferences from the app menu. 
o Click Controllers. 
o For each midi port click the ON button to turn off then click to turn ON again. 

Luna is a developing DAW, additional DAW control functionality will be added as the software progresses 

 


